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Serviciul de asistență tehnică Bio-Rad
Departamentul de asistență tehnică Bio-Rad din SUA este deschis de luni până vineri, între orele 5:00
și 17:00, ora Pacificului.

Telefon: 1-800-424-6723, opțiunea 2

E-mail: Support@bio-rad.com (Numai SUA/Canada)

Pentru asistență tehnică în afara SUA și Canadei, contactați biroul de asistență tehnică local sau faceți
clic pe linkul Contactați-ne de la adresa www.bio-rad.com.

Notificare
Nicio parte a acestei publicații nu poate fi reprodusă sau transmisă sub nicio formă și prin niciun fel de
mijloace, electronice sau mecanice, incluzând fotocopierea, înregistrarea sau orice sistem de stocare
sau recuperare de informații, fără permisiunea scrisă din partea Bio-Rad.

Bio-Rad își rezervă dreptul de a modifica produsele și serviciile sale în orice moment. Acest ghid poate
suferi modificări fără înștiințare prealabilă. Deși a fost întocmit astfel încât să asigure acuratețea, Bio-
Rad nu își asumă nicio răspundere pentru erori sau omisiuni sau pentru orice daune care apar din
aplicarea sau utilizarea acestor informații.

BIO-RAD este marcă comercială a Bio-Rad Laboratories, Inc.

BIO-RAD, HARD-SHELL și MICROSEAL sunt mărci comerciale aleBio-Rad Laboratories, Inc. în
anumite jurisdicții.

SYBR este marcă comercială a Thermo Fisher Scientific Inc.Bio-Rad Laboratories, Inc. deține licența
pentru a comercializa reactivi care conțin SYBR Green I pentru utilizare în PCR în timp real, numai în
scopuri de cercetare.

EvaGreen este marcă comercială a Biotium, Inc.Bio-Rad Laboratories, Inc. deține licența din partea
Biotium, Inc. pentru a comercializa reactivi care conțin colorant EvaGreen pentru utilizare în PCR în
timp real, numai în scopuri de cercetare.

Toate mărcile comerciale utilizate în prezentul document sunt proprietatea deținătorilor lor de drept.

Copyright © 2022 Bio-Rad Laboratories, Inc. Toate drepturile rezervate.

http://www.bio-rad.com/


Domeniu de utilizare

Domeniu de utilizare
Sistemele CFX96 Dx și CFX96 DeepWell Dx cu CFX Manager Dx software sunt concepute pentru a
efectua PCR bazată pe fluorescență pentru detectarea și cuantificarea secvențelor de acid nucleic.
Sistemele și software-ul sunt concepute pentru utilizarea în scop de diagnostic in vitro de către
tehnicieni de laborator instruiți. Sistemele sunt concepute pentru a fi utilizate cu teste de diagnostic
pentru acizi nucleici furnizate de alți producători care au fost produse și etichetate in scopuri de
diagnostic.

Lexicon de simboluri
Important: Sunt evidențiate schimbări semnificative!

Producător Numărul lotului

Utilizare de către
Pentru utilizare de
diagnosticare in vitro

Limita de temperatură Număr de catalog

Consultați instrucțiunile de utilizare Numărul de teste

Pentru utilizare cu Număr de serie
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Numai cu utilizare pe bază de prescripție Conține latex

Marcaj CE – Regulamentul (UE) nr.
2017/746 privind dispozitivele medicale

pentru diagnostic in vitro

Traduceri
Documentele de produs pot fi furnizate în limbi suplimentare pe suport electronic.
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Siguranța și conformitatea cu reglementările
Pentru utilizarea sigură a sistemului CFX96 Dx sau a sistemului CFX96 DeepWell Dx cu CFX Manager
Dx software, denumit CFX Dx system în acest document, Bio-Rad vă recomandă insistent să respectați
specificațiile de siguranță prezentate în această secțiune și pe parcursul acestui manual.

Important: Sistemele CFX96 Dx și CFX96 DeepWell Dx sunt aprobate pentru utilizarea ca
dispozitive medicale de diagnoză in vitro (IVD).

Etichete cu avertizări de siguranță
Etichetele de atenționare aplicate pe instrument și prezentate în acest manual vă avertizează despre
sursele de rănire sau vătămare. Tabelul 1 definește fiecare etichetă cu avertizări de siguranță.

Pictogramă Semnificație

Avertizare privind riscul de vătămare corporală sau de deteriorare a
echipamentului
Operarea CFX Dx system înainte de a citi acest manual poate constitui un risc de
vătămare personală. În vederea unei utilizări în siguranță, nu operați acest
instrument în nicio manieră nespecificată în acest manual. Instrumentul trebuie
operat exclusiv de personal de laborator calificat, instruit să utilizeze în siguranță
echipamentele electrice. Manevrați întotdeauna toate componentele sistemului cu
atenție și cu mâinile curate și uscate.

Avertizare privind manipularea materialelor periculoase din punct de
vedere biologic
Atunci când manevrați probe periculoase din punct de vedere biologic, respectați
măsurile de precauție recomandate și instrucțiunile și conformați-vă tuturor
recomandărilor locale specifice pentru laboratorul dumneavoastră și locul în care
vă aflați.

Tabelul 1. Semnificația etichetelor cu avertizări de siguranță
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Siguranța și conformitatea cu reglementările

Pictogramă Semnificație

Avertizare privind riscul de arsuri
Un ciclu termic generează suficientă căldură pentru a provoca arsuri grave. În
timpul operării, purtați întotdeauna ochelari de protecție sau alte echipamente de
protejare a ochilor. Lăsați întotdeauna blocul probei să revină la temperatura de
inactivitate înainte de a deschide capacul și scoate probele. Asigurați întotdeauna
distanța maximă pentru a evita arsurile cutanate accidentale.

Avertizare privind riscul de explozie
În cursul operării normale, blocurile probei pot deveni suficient de fierbinți pentru a
provoca fierberea și explozia lichidelor.

Tabelul 1. Semnificația etichetelor cu avertizări de siguranță, continuare

Specificații pentru utilizare sigură și conformitate
Tabelul 2 prezintă specificațiile de utilizare sigură pentru sistemele de detecție PCR în timp real ale
Bio-Rad CFX Dx. Cablurile ecranate furnizate trebuie utilizate împreună cu aceste instrumente pentru
a asigura conformitatea cu limitele FCC Clasa A.

Aspect de utilizare Condiții de utilizare sigură

Putere de intrare nominală 100-240 Vca, 50-60 Hz, 850 Wmax

Categorie de supratensiune II

Siguranțe 10 A, 250 V, 5 x 20 mm, fuzibile cu acțiune rapidă (cant. 2)

Mediu Numai pentru utilizare în spații interioare

Temperatura de utilizare 15-31 °C

Temperatura de depozitare -20 până la 60 °C

Umiditate relativă Până la 80 % (fără condens)

Altitudine Până la 2.000 de metri deasupra nivelului mării

Grad de poluare 2

Tabelul 2. Condiții de utilizare sigură
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Specificații pentru utilizare sigură și conformitate

Conformitatea cu reglementările
Sistemul de detecție PCR în timp real CFX Dx a fost testat și s-a dovedit că respectă toate cerințele
aplicabile ale următoarelor standarde de siguranță și electromagnetice:

n IEC 61010-1:2010 (ed. a III-a), EN61010-1:2010 (ed. a III-a). Echipamente electrice de măsurare,
control și utilizare în laborator – Partea 1: Cerințe generale

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Cerințe de siguranță pentru echipamente
electrice de măsurare, control și utilizare în laborator. Partea 2-010: Cerințe speciale pentru
echipamente de laborator pentru încălzirea materialelor

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Cerințe de siguranță pentru echipamente
electrice de măsurare, control și utilizare în laborator. Partea 2-081: Cerințe speciale pentru
echipamente de laborator automate și semiautomate pentru analiză și alte scopuri (include
Amendamentul 1)

n IEC 61010-2-101:2015 (ed. a II-a). Cerințe de siguranță pentru echipamente electrice de
măsurare, control și utilizare în laborator. Cerințe speciale pentru echipamente medicale pentru
diagnostic in vitro (IVD)

n IEC 61326-1:2012 (Clasa A), EN 61326-1:2013 (Clasa A). Echipamente electrice de măsurare,
control și utilizare în laborator. Cerințe CEM, Partea 1: Cerințe generale

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (Clasa A). Echipamente electrice de măsurare, control
și utilizare în laborator. Cerințe CEM. Cerințe speciale pentru echipamente medicale pentru
diagnostic in vitro (IVD)

Important: Acest echipament generează, utilizează și poate emite energie de radiofrecvență, iar
dacă nu este instalat și utilizat conform documentelor de instruire furnizate, poate provoca
interferențe perturbatoare pentru comunicațiile radio. Operarea sistemelor într-o zonă
rezidențială poate provoca interferențe prejudiciabile, caz în care utilizatorii vor trebui să
corecteze interferențele pe propria cheltuială.
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Siguranța și conformitatea cu reglementările

Pericole
Sistemul de detecție PCR în timp real CFX Dx este proiectat pentru a funcționa sigur și eficient când
este utilizat în modul recomandat de producător. Dacă sistemul de detecție PCR în timp real CFX Dx
sau oricare dintre componentele asociate acestuia este utilizat(ă) într-un mod care nu a fost menționat
de către producător, nivelul de protecție inerentă asigurat de instrument poate fi afectat. Bio-Rad
Laboratories, Inc. nu este răspunzătoare pentru nicio vătămare corporală sau distrugere de bunuri
cauzată de utilizarea acestui echipament în orice mod nespecificat sau de modificări ale
instrumentului care nu au fost efectuate de Bio-Rad sau de către un agent autorizat. Asistența tehnică
a sistemului de detecție PCR în timp real CFX Dx trebuie să fie efectuată numai de către personal Bio-
Rad instruit.

Pericole biologice
Sistemul CFX Dx de detecție PCR în timp real este un instrument de laborator. Dacă există totuși
materiale periculoase din punct de vedere biologic, respectați următoarele instrucțiuni și conformați-vă
tuturor recomandărilor locale specifice pentru laboratorul dumneavoastră și locul în care vă aflați.

Observație: Nicio substanță periculoasă din punct de vedere biologic nu este eliminată în timpul
operațiunilor normale ale acestui instrument.

Măsuri de precauție generale

n Purtați întotdeauna mănuși și îmbrăcăminte de laborator, precum și ochelari de protecție sau
ochelari de siguranță cu apărători laterale.

n Țineți mâinile la distanță de gură, nas și ochi.

n Protejați în mod complet orice tăietură sau urmă de frecare de pe piele înainte de a lucra cu
materiale potențial infecțioase.

n Spălați-vă pe mâini foarte bine, cu apă și săpun, după ce ați lucrat cu orice materiale potențial
infecțioase, înainte de a părăsi laboratorul.

n Scoateți ceasurile de mână și bijuteriile înainte de a lucra în laborator.

n Depozitați toate materialele infecțioase sau potențial infecțioase în recipiente incasabile și
impermeabile.

n Înainte de a părăsi laboratorul, scoateți îmbrăcămintea de protecție.

n Nu folosiți mănuși pentru a scrie, a răspunde la telefon, a aprinde lumina sau pentru a atinge
lucruri pe care alte persoane le pot atinge fără mănuși.

n Schimbați mănușile frecvent. Scoateți mănușile imediat ce au fost contaminate în mod vizibil.
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Pericole

n Nu expuneți materialele care nu pot fi decontaminate în mod corespunzător la materiale potențial
infecțioase.

n După terminarea unei operațiuni care implică materiale periculoase din punct de vedere biologic,
decontaminați zona de lucru cu un dezinfectant corespunzător (de exemplu, înălbitor de uz
casnic, diluat în proporție de 1:10).

Măsuri de precauție IVD specifice

n Toate probele de pacient reprezintă potențiale riscuri biologice și trebuie manipulate în mod
corespunzător, utilizând măsurile de precauție universale.

n Nicio substanță periculoasă din punct de vedere biologic nu este eliminată în timpul operării
normale a acestui instrument.

Decontaminarea suprafețelor

AVERTISMENT! Pentru a preveni electrocutarea, opriți și deconectați de la priză
instrumentul de fiecare dată înainte de a efectua procedurile de decontaminare.

Următoarele zone pot fi curățate cu orice dezinfectant bactericid, virucid sau fungicid de uz spitalicesc:

n Capacul exterior și șasiul

n Suprafața interioară a blocului de reacție și alveolele blocului de reacție

n Panoul de control și afișajul

Pentru a pregăti și aplica dezinfectantul, consultați instrucțiunile furnizate de fabricantul produsului.
Clătiți întotdeauna blocul de reacție și alveolele blocului de reacție de mai multe ori cu apă după
aplicarea unui dezinfectant. Uscați complet blocul de reacție și alveolele blocului de reacție după ce
clătiți cu apă.

Important: Nu utilizați detergenți abrazivi sau corozivi sau soluții alcaline puternice. Acești agenți
pot zgâria suprafețele și deteriora blocul de reacție, rezultând în pierderea controlului termic
precis.

Eliminarea materialelor periculoase din punct de vedere biologic

Eliminați următoarele materiale posibil contaminate în conformitate cu regulamentele locale, regionale
și naționale privind laboratoarele:

n Probe clinice

n Reactivi

n Recipientele de reacție sau alte consumabile folosite care ar putea fi contaminate
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Siguranța și conformitatea cu reglementările

Pericole chimice
Sistemul CFX Dx de detecție PCR în timp real nu conține materiale care pot prezenta pericol chimic.

Pericole de explozie sau aprindere
Sistemul de detecție PCR în timp real CFX Dx nu prezintă pericole deosebite de aprindere sau
explozie când este utilizat corect, conform specificațiilor Bio-Rad Laboratories.

Pericole electrice
Sistemul de detecție PCR în timp real CFX Dx nu prezintă pericole electrice neobișnuite pentru
operatori, dacă este instalat și utilizat corect, fără modificări fizice, și dacă este conectat la o sursă de
alimentare cu specificații adecvate.

Transport
Înainte de mutarea sau expedierea sistemului de detecție PCR în timp real CFX Dx sau a modului
optic de reacție sau a bazei ciclorului termic, trebuie realizate proceduri de decontaminare.
Întotdeauna mutați sau expediați sistemul de detecție PCR în timp real CFX Dx și modulele optice de
reacție în containere separate, cu materialele de ambalare furnizate, care vor proteja instrumentul
împotriva deteriorării. Dacă nu se pot găsi containere corespunzătoare, contactați reprezentantul Bio-
Radlocal.

Baterie
Ciclorul termic CFX Dx system utilizează o baterie litiu-metal tip pastilă de 3 V și o baterie
reîncărcabilă nichel-hidrură metalică de 4,8 V pentru a menține setările de timp și datele de rulare în
cazul penelor de curent. Dacă datele de timp și/sau datele rulării nu rămân setate după oprirea unității,
acest lucru poate fi un semnal că bateriile încep să se consume. În acest caz, contactați serviciul de
asistență tehnică Bio-Rad.

Nu încercați să înlocuiți bateriile. Contactați serviciul de asistență tehnică Bio-Rad.

Eliminare
Sistemul de detecție PCR în timp real CFX Dx conține materiale electrice; acestea nu trebuie eliminate
ca deșeuri nediferențiate și trebuie să fie colectate separat, în conformitate cu Directiva Uniunii
Europene 2012/19/UE privind deșeurile de echipamente electrice și electronice – Directiva DEEE.
Înainte de eliminare, contactați reprezentanța locală Bio-Rad pentru instrucțiuni specifice țării dvs.
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Pericole

Garanție
Sistemul de detecție PCR în timp real CFX Dx și accesoriile sale asociate sunt acoperite de o garanție
Bio-Rad standard. Pentru detalii privind garanția, contactați reprezentanța Bio-Rad locală.
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Siguranța și conformitatea cu reglementările
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Capitolul 1 Introducere
Sistemele de amplificare PCR în timp real ale Bio-Rad CFX Dx pentru diagnostic in vitro (IVD) sunt
prevăzute cu ultimele tehnologii avansate, permițând cuantificarea PCR cu curbă standard, analiza
expresiei genice, evidențierea alelică și analiza în punctul final.

CFX Dx systems sunt alcătuite din două module hardware și software:

n Modulul optic de reacție (ORM) CFX96 Dx sau CFX96 DeepWell Dx

n ciclorului termic C1000 Dx

n CFXManager Dx software

Atunci când sunt folosite cu CFX Manager Dx software, puteți

n Genera rezultate imediate cu Startup Wizard (Expert pornire)

n Introduce sau edita informații despre alveole înainte, în timpul sau după finalizarea unei rulări

n Interpreta date complexe și înțelege studiul expresiei genice cu ajutorul unor instrumente precum
analiza de control PrimePCR și instrumentul de selectare a genei de referință

n Pregăti rapoarte cuprinzătoare ale datelor PCR în timp real

Sisteme de detecție PCR CFX Dx
Tabelul 3 prezintă produsele Bio-Rad IVD PCR care sunt livrate împreună cu CFX Dx system.

Observație: Un CFX Dx system se livrează împreună cu CFX Manager Dx software, ciclorul
termic C1000 Dx și cu modulul optic de reacție CFX96 Dx sau CFX96 DeepWell Dx.

Nr. catalog Descriere

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD ciclorului termic C1000 Dx

12007917 CFX Manager Dx software v3.1

Tabelul 3. Sisteme de detecție CFX IVD PCR

* Optical Reaction Module (Modul de reacție optică)
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Capitolul 1 Introducere

Aflați mai multe
Acest document explică modul în care puteți configura și utiliza în condiții de siguranță sistemele de
detecție PCR în timp real CFX96 Dx și CFX96 DeepWell Dx, care poartă marcajul CE-IVD. În acest
document, aceste sisteme sunt denumite CFX Dx system. De asemenea, acest document explică
modul de utilizare a CFX Manager Dx software în asociere cu CFX Dx system.

Sfat: Faceți clic pe logoul Bio-Rad din colțul din dreapta sus al oricărei ferestre CFX Manager Dx
software pentru a accesa site-ul web al Bio-Rad. Acest site include linkuri către note tehnice,
manuale, informații despre produse și asistență tehnică. De asemenea, acest site pune la
dispoziție multe resurse tehnice despre o mare varietate de metode și aplicații legate de PCR,
PCR în timp real și expresia genică.
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Capitolul 2 Configurarea ciclorului termic
C1000 Dx

Acest capitol vă explică cum să configurați ciclorul termic C1000 Dx al CFX Dx system în unitatea
dumneavoastră

Sfat: Înainte de a configura ciclorul termic, familiarizați-vă cu ciclorul termic și cu modulul său de
reacție optică, porturile și accesoriile sale.

Cerințe pentru unitate
Tabelele din această secțiune cuprind cerințele pentru încăpere, mediu și energie necesare pentru
instalarea și utilizarea cu succes a ciclorului termic CFX Dx system.

Observație: Instalați ciclorul termic CFX Dx system pe o suprafață plană și uscată, unde circulă
suficient aer rece pentru o funcționare corectă.

Cerințe de spațiu pe masa de lucru

Element Specificație

Putere de intrare Până la 850W, maximum

Frecvență 50-60 Hz, o singură fază

Porturi USB 5 A, 1 B

Dimensiuni L: 13 in; 33 cm

A: 18 in; 46 cm

Î: 14 in; 36 cm

Greutate 47 livre; 21 kg

Tabelul 4. Cerințe de spațiu pe masa de lucru pentru ciclorul termic al CFX Dx system
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Capitolul 2 Configurarea ciclorului termic C1000 Dx

Cerințe de mediu

Parametru Interval Interval de umiditate

Condiții de operare 15-31 °C

59-87,8 °F

0-80% UR, fără condensare

Condiții de depozitare 15-31 °C

59-87,8 °F

0-80% UR, fără condensare

Tabelul 5. Cerințe de mediu pentru ciclorul termic al CFX Dx system

Cerințe de alimentare
Pentru a asigura operarea corectă, alimentarea electrică a ciclorului termic CFX Dx system trebuie să
fie stabilă și să se încadreze în specificații. Cablul de alimentare conectat la portul de intrare a
curentului trebuie să fie adecvat pentru 7 amperi sau mai mult.

Element Specificație

Tensiune de intrare rețea 100-240 Vca; 50-60 Hz, o singură fază

Consummaxim de energie < 850 wați

Număr de prize Maximum 2 prize:

n 1 priză pentru ciclorul termic

n 1 priză pentru computerul pe care rulează CFX Manager Dx
software

Tabelul 6. Cerințe de alimentare pentru CFX Dx system
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Prezentare generală a sistemului

Prezentare generală a sistemului
Ilustrațiile din această secțiune prezintă componentele principale ale bazei ciclorului termic C1000 Dx.

Vedere frontală

1. Modul optic de reacție – include un sistem optic pentru colectarea datelor fluorescente și
un bloc al ciclorului termic. Sistemele de detecție PCR în timp real CFX Dx acceptă fie un
modul CFX96 Dx, fie un modul CFX96 DeepWell Dx.

2. LED de stare – indică momentele în care blocul este utilizat.

3. Butonul capacului – deschide sau închide capacul modulului optic de reacție și etanșează
camera de reacție.

4. Baza ciclorului termic C1000 Dx – asigură alimentarea și comunicarea sistemului și
găzduiește modulele optice de reacție CFX96 Dx și CFX96 DeepWell.

5. Afișaj și butoane panou frontal – permit controlul sistemului în modul de sine stătător.
Important: Pentru a asigura integritatea datelor studiului genic IVD, CFX Manager Dx
software nu acceptă date generate de ciclorul termic în modul de sine stătător.

6. Capac interior încălzit – menține temperatura capacului, pentru a preveni condensarea și
evaporarea.

7. Bloc probă/reacție – găzduiește vasul de reacție, inclusiv eprubetele și microplăcile.

LEGENDĂ
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Capitolul 2 Configurarea ciclorului termic C1000 Dx

Vedere spate

1. Port Ethernet – conectează ciclorul termic C1000 Dx la rețeaua dumneavoastră

2. Port USB tip B – conectează ciclorul termic C1000 Dx la un computer pe care rulează CFX
Manager Dx software.

3. Porturi USB tip A – pentru transferarea datelor pe și de pe o unitate flash USB.

Important: Pentru a asigura integritatea datelor studiului genic IVD, CFX Manager Dx
software nu acceptă date generate de ciclorul termic în modul de sine stătător.

4. Port serial de testare – doar pentru testarea de service.

5. Orificii de ventilare – răcesc ciclorul termic.
Important: Nu blocați orificiile de ventilare. Pentru operarea optimă, asigurați-vă că
aerul poate circula în spatele bazei ciclorului termic.

6. Priză de alimentare – sursă de alimentare de la rețeaua c.a.; utilizați cablul de alimentare
furnizat.

7. Întrerupător de alimentare – întrerupător electric de formă rectangulară, cu basculare,
pentru pornirea și oprirea ciclorului termic.

8. Siguranțe – pentru specificațiile siguranțelor, consultați Specificații pentru utilizare sigură și
conformitate de la pagina 14.

LEGENDĂ
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Module Reacție optică

Module Reacție optică
Ciclorul termic C1000 Dx este compatibil cu următoarele module de reacție optică Bio-Rad pentru
PCR în timp real.

n Modul optic de reacție CFX96 Dx

n Modul optic de reacție CFX96 DeepWell Dx

Modulul optic de reacție CFX Dx ales și ciclorul termic sunt livrate în cutii separate. CFX Manager Dx
software este livrat împreună cu modulul optic de reacție.

Important: Modulul optic de reacție este calibrat cu baza ciclorului termic împreună cu care este
livrat. Așadar, nu folosiți modulul optic de reacție cu nicio altă bază de ciclor termic sau baza
ciclorului termic cu niciun alt modul optic de reacție.

Ambele module de reacție optică includ un capac încălzit complet reglabil, care poate să funcționeze
în mod fiabil cu o gamă largă de recipiente de reacție. Fiecare modul optic de reacție conține
ventilatoare de răcire pentru încălzirea și răcirea rapidă.

Fiecare modul optic de reacție CFX Dx constă în următoarele componente:

n Capac interior încălzit – menține temperatura capacului, pentru a preveni condensarea și
evaporarea.

n Bloc probă/reacție – găzduiește recipientele de reacție, inclusiv eprubete și microplăci.

n Butonul capacului – deschide și închide capacul și etanșează reacția.

n LED de stare – când este pornit, indică faptul că blocul este utilizat.

Volume recomandate pentru probe
În timpul utilizării ciclorului termic C1000 Dx, volumul maxim al probei este determinat de tipul de
modul de reacție folosit. Tabelul 7 indică volumele recomandate pentru folosire la fiecare modul de
reacție.

Număr de alveole Număr de blocuri
Volum recomandat pentru probe, µl

(limita superioară)

96 alveole 1 10-50

96 alveole adânci 1 10-125

Tabelul 7. Dimensiune și limită de volum pentru modulele de reacție
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Capitolul 2 Configurarea ciclorului termic C1000 Dx

Instalarea Ciclorului termic C1000 Dx
Baza ciclorului termic C1000 Dx se livrează într-o cutie separată față de modulul de reacție optică.
Pachetul include:

n Baza ciclorului termic C1000 Dx

n Cablu de alimentare

n 1 cablu USB

Pentru a instala ciclorul termic C1000 Dx:

1. Despachetați și instalați baza ciclorului termic C1000 Dx.

2. Atașați modulul de reacție la bază.

3. Înlăturați șurubul de expediere.

Această secțiune explică aceste sarcini în detaliu.

Despachetarea și instalarea bazei ciclorului termic C1000 Dx
Important: Înainte de a opera ciclorul termic, citiți informațiile din Siguranța și conformitatea cu
reglementările de la pagina 13 și Etichete cu avertizări de siguranță de la pagina 13.

Sfat: În timpul instalării, asigurați-vă că aveți suficient spațiu lângă ciclorul termic pentru un
computer pe care să ruleze CFX Manager Dx software.

Pentru a despacheta și instala baza ciclorului termic

1. Localizați pachetul care conține baza ciclorului termic.

2. Scoateți baza din ambalaj.

Sfat: Păstrați ambalajul pentru utilizarea ulterioară. Dacă un element lipsește sau este
deteriorat, contactați reprezentantul Bio-Rad local.

3. Așezați baza ciclorului termic pe o suprafață plană și uscată, unde circulă suficient aer rece
pentru o funcționare corectă.

4. Localizați cablul de alimentare în pachet și introduceți un capăt în portul de intrare de pe partea
din spate a ciclorului termic.

Important: Nu porniți încă instrumentul.

5. Atașați modulul de reacție IVD la bază. Continuați cu Atașarea modulului optic de reacție de la
pagina 29.
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Instalarea Ciclorului termic C1000 Dx

Atașarea modulului optic de reacție
Bio-Rad livrează modulul optic de reacție CFX96 Dx sau CFX96 DeepWell împreună cu baza
ciclorului termic C1000 Dx (dar într-o cutie separată). Dezambalați cu atenție modulul optic de reacție
și verificați dacă pachetul conține cablurile de alimentare și USB.

Important: Fiecare modul optic de reacție este calibrat cu baza ciclorului termic cu care a fost
livrat. Așadar, nu folosiți modulul optic de reacție cu nicio altă bază de ciclor termic.

Așezați baza ciclorului termic C1000 Dx pe o suprafață plană și uscată, unde circulă suficient aer rece
pentru o funcționare corectă.

Pentru a atașa modulul de reacție la baza ciclorului termic

1. Amplasați ciclorul termic C1000 Dx într-un loc adecvat, cu bara de blocare în jos.

2. Ridicând modulul optic de reacție cu ajutorul indentațiilor cu rol de mâner de deasupra orificiilor
de aerisire laterale, poziționați modulul în compartimentul pentru modulul de reacție C1000 Dx,
lăsând un spațiu de aproximativ 2 cm în față. Când se află în compartiment, modulul optic trebuie
să acopere logoul Bio-Rad din fața compartimentului.

3. Trageți în sus bara de blocare, până când ajunge la același nivel cu laturile compartimentului
modulului. Această acțiune deplasează modulul în față, fixându-l la locul său.
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Capitolul 2 Configurarea ciclorului termic C1000 Dx

4. Asigurați-vă că modulul este așezat complet și uniform în baza ciclorului termic C1000 Dx. Nu
trebuie să existe spațiu suplimentar între modul și bază.

5. Introduceți cablul de alimentare în spatele bazei ciclorului termic C1000 Dx și într-o priză
electrică adecvată, apoi apăsați întrerupătorul de alimentare de pe panoul din spate al ciclorului
termic C1000 Dx pentru a porni sistemul.

Înlăturarea șurubului de expediere
Important: Modulele optice de reacție ale Bio-Rad se livrează împreună cu un Șurub de
expediere roșu introdus în capacul interior pentru a stabiliza modulul optic de reacție în timpul
transportului. Trebuie să înlăturați șurubul de expediere înainte de a putea opera modulul optic de
reacție.

Pentru a înlătura șurubul de expediere

1. Ciclorul termic C1000 Dx recunoaște că șurubul de expediere este introdus în modulul optic de
reacție și afișează un mesaj care vă instruiește să înlăturați șurubul.
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Instalarea Ciclorului termic C1000 Dx

2. Urmați instrucțiunile pentru a înlătura șurubul de expediere. Următoarea diagramă indică locația
șurubului de expediere.

Observație: Trebuie să reintroduceți șurubul de expediere dacă este nevoie să returnați
modulul de reacție din orice motiv. Păstrați șurubul într-un loc sigur și accesibil.

Încărcarea plăcilor cu probe
Pentru asigurarea încălzirii și răcirii uniforme a probelor, plăcile trebuie să fie în contact total cu blocul
de reacție. Pentru asigurarea unui contact adecvat, urmați următoarele proceduri:

n Confirmați că blocul este curat înainte de încărca probele.

n Apăsați bine eprubetele, baretele de eprubete sau microplăcile individuale în alveolele blocului.

n Atunci când folosiți una sau puține eprubete, folosiți cadrul eprubetei (catalog nr. 1849000 sau nr.
1849001) sau încărcați cel puțin o eprubetă goală în fiecare colț al blocului pentru a vă asigura că
capacul exercită presiune egală asupra eprubetelor individuale.
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Încărcarea plăcilor în modulul optic de reacție

Important: La utilizarea CFX Dx system, echilibrați întotdeauna baretele de eprubete sau
adăugați capacele de eprubete la alveolele din colțuri, pentru a vă asigura de aplicarea presiunii
uniforme asupra întregului bloc a capacului încălzit

Pentru a încărca plăci într-modulul optic de reacție

1. Pentru a deschide capacul motorizat, efectuați una dintre următoarele:

n În panoul Detected Instruments (Instrumente detectate) din CFX Manager Dx software, faceți
clic pe Open Lid (Deschidere capac).

n Pe fila Start Run (Începere rulare) din software, faceți clic pe Open Lid (Deschidere capac).

n Apăsați butonul pentru capac de pe partea frontală a instrumentului.

2. Poziționați microplaca, eprubetele individuale sau baretele de eprubete cu capace etanșe în bloc.

Important: Verificați că eprubetele sunt complet etanșate pentru a preveni scurgeri.

Sfat: Pentru rezultate optime, încărcați volume de probe de 10-25 µl pentru CFX Dx system.

3. Pentru analize de date precise, verificați că orientarea reacțiilor din bloc este exact aceeași cu
orientarea conținutului alveolelor din fila Plate (Placă) în CFX Manager Dx software.

Sfat: Puteți edita conținutul alveolelor folosind CFX Manager Dx software înainte, în timpul
sau după rulare.

4. Pentru a închide capacul motorizat, efectuați una dintre următoarele:

n Apăsați butonul pentru capac de pe instrument.

n Din panoul Detected Instruments (Instrumente detectate) din software, faceți clic pe Close
Lid (Închidere capac).

n Pe fila Start Run (Începere rulare) din software, faceți clic pe Close Lid (Închidere capac).

Important: Asigurați-vă că nimic nu blochează capacul atunci când se închide. Deși există
un mecanism de siguranță pentru a preveni închiderea capacului dacă se detectează o
obstrucție, nu puneți nimic în calea capacului înainte de închidere.
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Consumabile din plastic PCR și consumabile reactivi PCR

Pentru a găsi și comanda consumabile din plastic recomandate pentru CFX Dx system accesați site-ul
web Bio-Rad. Puteți accesa acest site din elementul de meniu Help > PCR Plastic Consumables
Web Site (Ajutor > Site web consumabile plastic PCR) din CFX Manager Dx software. Suplimentar,
consultați resursele selector de plastic și selector de reactivi, care vă vor ajuta să găsiți și să
comandați cu ușurință consumabile din plastic și reactivi pentru nevoile dvs. specifice de componente
hardware și PCR.

Detectarea instrumentelor conectate
În timpul instalării, programul de instalare a CFX Manager Dx software instalează automat driverele
instrumentelor pe computerul care rulează CFX Manager Dx software. CFX Manager Dx detectează
instrumentele conectate în momentul în care porniți software-ul.

Important: Trebuie să deconectați ciclorul termic C1000 Dx de la computerul CFX Manager Dx
înainte de a instala software-ul. Nu trebuie să opriți ciclorul termic în timpul instalării software-ului.

Pentru a detecta instrumentele conectate

1. Dacă nu ați făcut încă acest lucru, introduceți capătul pătrat (tată) al cablului USB de tip B furnizat
în portul USB de tip B situat în partea din spate a bazei .

2. Introduceți celălalt capăt (port) într-un port USB al computerului cu CFX Manager Dx.

3. Dacă ciclorul termic nu este deja în funcțiune, apăsați întrerupătorul de pe partea din spate a
instrumentului pentru a-l porni.

4. Porniți CFX Manager Dx software.

Software-ul detectează automat instrumentul conectat și afișează denumirea sa în panoul Detected
Instruments (Instrumente detectate) din fereastra Home (Fereastră de pornire).

Observație: Dacă instrumentul nu apare în panoul Detected Instruments (Instrumente
detectate), asigurați-vă că este instalat corect cablul USB. Pentru a reinstala driverele, selectați
Tools (Instrumente) > Reinstall Instrument Drivers (Reinstalare drivere instrumente) din fereastra
Home (Fereastră de pornire) a CFX Manager Dx software.
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Detașarea
Important: Opriți ciclorul termic C1000 Dx înainte de a detașa un modul de reacție (consultați
Oprirea ciclorului termic C1000 Dx de la pagina 34). Nervurile de răcire din modulul de reacție se pot
încălzi excesiv imediat după rularea unui protocol sau unei incubări. Înainte de a detașa modulul
de reacție, asigurați-vă că nervurile s-au răcit.

Pentru a detașa modulul optic de reacție de pe baza ciclorului termic

1. Pe spatele bazei ciclorului termic, împingeți în jos bara de blocare pentru a debloca și elibera
modulul optic de reacție .

2. Ridicați cu atenție modulul optic de reacție din compartiment, folosind indentațiile cu rol de mâner
de pe fiecare latură.

3. Așezați modulul de reacție optică pe o suprafață curată și plană, unde nu poate fi lovit, zgâriat sau
scăpat pe jos.

Oprirea ciclorului termic C1000 Dx
Pentru a opri ciclorul termic

1. După o rulare, apăsați butonul de deschidere a capacului de pe partea frontală a modului de
reacție optică CFX pentru a accesa probele încărcate în bloc.

2. Scoateți probele din bloc și apăsați butonul de închidere a capacului pentru a închide capacul.

3. Apăsați întrerupătorul de alimentare de pe panoul din spate al ciclorului termic C1000 Dx pentru a
opri sistemul.
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Acest capitol explică modul de instalare a CFX Manager Dx software.

CFX Manager Dx software este necesar pentru a analiza datele PCR în timp real de la sistemele
CFX96 Dx și CFX96 DeepWell Dx. De asemenea, puteți utiliza acest software pentru a controla
aceste sisteme în modul controlat prin software.

Pentru informații privind instalarea ciclorului termic și modulului de reacție CFX Dx system, consultați
Configurarea ciclorului termic C1000 Dx de la pagina 23.
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Cerințe de sistem
Tabelul 8 listează cerințele de sistem minime și recomandate pentru computerul pe care rulează CFX
Manager Dx software (cunoscut și sub denumirea de computer cu CFX Manager Dx).

Sistem Minime Recomandate

Sistem de
operare

Microsoft Windows 7 SP1
Pro

Oricare dintre următoarele:

n Microsoft Windows 7 SP2 Pro (pe 32 și 64 biți)

n Microsoft Windows 10 Pro (doar pe 64 biți)

n Microsoft Windows 10 Enterprise (doar pe
64 biți)

Important: Secure Boot (Pornire sigură sistem) trebuie dezactivată atât pe Microsoft Windows 10
Pro, cât și pe Microsoft Windows 10 Enterprise.

Porturi 2 porturi USB 2.0 de mare
viteză

2 porturi USB 2.0 de mare viteză

Spațiu hard disk 128 GB 128 GB

Viteza
procesorului

2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Rezoluția
ecranului

1024 x 768 cu mod de culori
realiste

1280 x 1024 cu mod de culori realiste

Cititor PDF Adobe PDF Reader sau Windows PDF Reader
de la unul dintre seturile Microsoft Office
acceptate:

n 2007

n 2010

n 2013

Tabelul 8. Cerințe de sistem pentru CFX Manager Dx software

36 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Instalarea CFX Manager Dx software

Instalarea CFX Manager Dx software
Important: Trebuie să deconectați orice instrumente conectate de la computerul cu CFX
Manager Dx înainte de a instala software-ul sau de a efectua un upgrade al acestuia. Nu trebuie
să opriți ciclorul termic în timpul instalării software-ului. Asigurați-vă că ați salvat toate rulările și că
nu este în desfășurare niciun experiment.

Observație: Dacă instalați CFX Manager Dx software peWindows 10, verificați că Secure Boot
(Pornire sigură sistem) este dezactivată înainte de a începe procedura de instalare.

Pentru a instala CFX Manager Dx software

1. Dacă este necesar, deconectați orice instrumente conectate de la computer.

Localizați și deconectați cablul USB al instrumentului de la computerul CFX Manager Dx. Capătul
introdus în instrument poate să rămână în poziție.

2. Autentificați-vă pe computerul cu CFX Manager Dx cu drepturi de administrator.

3. Puneți CD-ul cu CFX Manager Dx software în unitatea de CD a computerului.

4. Pagina de lansare a software-ului trebuie să apară automat. Faceți dublu clic pe Install Software
(Instalare software) de pe pagina de lansare a software-ului.

Observație: Dacă pagina de lansare nu apare automat, navigați la unitatea de CD și
deschideți folderul CFX_Manager, apoi faceți dublu clic pe setup.exe pentru a inițializa
expertul de instalare a software-ului.

Sfat: În expertul de instalare, faceți clic pe butonul Documentation (Documentație) pentru a
găsi copii care pot fi căutate ale notelor privind versiunea, manualelor pentru instrumente și
ale altor documente.

5. Urmați instrucțiunile de pe ecran pentru a finaliza instalarea. La finalizare, pictograma pentru
software-ul CFX Manager va apărea pe desktopul computerului.

6. După ce se finalizează instalarea, puteți îndepărta în siguranță CD-ul.

Detectarea instrumentelor conectate
În timpul instalării, programul de instalare a CFX Manager Dx software instalează automat driverele
instrumentelor pe computerul CFX Manager Dx. CFX Manager Dx detectează instrumentele
conectate în momentul în care porniți software-ul.

Pentru a detecta instrumentele conectate

1. Dacă nu ați făcut încă acest lucru, introduceți capătul pătrat (tată) al cablului USB de tip B furnizat
în portul USB de tip B situat în partea din spate a bazei instrumentului.
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2. Introduceți celălalt capăt (port) într-un port USB al computerului cu CFX Manager Dx.

3. Dacă instrumentul nu este deja în funcțiune, apăsați întrerupătorul de pe partea din spate a
instrumentului pentru a-l porni.

4. Porniți CFX Manager Dx.

Software-ul detectează automat instrumentul conectat și afișează denumirea lui în panoul Detected
Instruments (Instrumente detectate) din fereastra Home (Fereastră de pornire).

Observație: Dacă instrumentul nu apare în panoul Detected Instruments (Instrumente
detectate), asigurați-vă că este instalat corect cablul USB. Pentru a reinstala driverele, din
fereastra Home (Fereastră de pornire) a CFX Manager Dx, selectați Tools (Instrumente) >
Reinstall Instrument Drivers (Reinstalare drivere instrumente).

Fișierele software-ului
Tabelul 9 listează tipurile de fișiere CFX Manager Dx software.

Tipul de fișier Extensia Detalii

Protocol .prcl Conține detaliile configurării protocolului pentru
efectuarea unei rulări PCR.

Placă .pltd Conține detaliile configurării plăcii pentru efectuarea unei
rulări PCR.

Data (Date) .pcrd Conține rezultatele unei rulări de experiment și unei
analize PCR.

Rulare PrimePCR .csv Conține structura protocolului și plăcii pentru plăcile
PrimePCR.

Studiu genic .mgxd Conține rezultatele mai multor rulări PCR și analizele
expresiei genice.

LIMS .plrn Conține informații de configurare a plăcii și informații
despre protocol necesare pentru efectuarea unei rulări
compatibile LIMS.

Tabelul 9. Tipuri de fișiere CFX Manager Dx software
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Măsuri de siguranță cibernetică recomandate
Bio-Rad vă recomandă să colaborați cu departamentul dumneavoastră IT pentru a implementa măsuri
de siguranță cibernetică pentru computerul utilizat împreună cu sistemul CFX96 Dx. De exemplu:

n Instalați și configurați programe corespunzătoare de protecție împotriva virușilor și paravane de
protecție.

Important: Configurați scanarea de viruși să aibă loc în afara orelor de program sau când
instrumentul nu funcționează în mod activ. Dacă se inițiază o scanare de viruși în timp ce
CFX Manager Dx rulează un experiment, rularea poate fi anulată, iar datele pierdute.

n CFXManager Dx software nu are nicio funcție de expirare a sesiunii utilizatorului pentru
inactivitate. Implementați măsuri de securitate a accesului utilizatorilor create de Windows sau de
terți (de exemplu, implementați un economizor de ecran cu autentificare obligatorie).

n Securitatea suporturilor amovibile:

o Folosiți parole și criptare pe dispozitivele dumneavoastră USB, pentru a proteja datele.

o Dezactivați funcțiile de executare automată și redare automată pentru toate dispozitivele
amovibile.

o Activați scanarea automată a unităților USB de fiecare dată când sunt conectate.

n Folosiți un instrument de backup (copiere de rezervă) pentru a facilita recuperarea datelor.
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Capitolul 4 Spațiul de lucru
CFXManager Dx software furnizează o interfață pentru configurarea plăcilor, dezvoltarea
protocoalelor PCR, rularea acestora în instrumentele CFX Dx și analizarea datelor din rulările PCR.

CFX Manager Dx software prezintă cinci spații de lucru principale:

n Fereastra Home (Fereastră de pornire)

n Startup Wizard (Expert pornire)

n Fereastra Protocol Editor (Editor Protocol)

n Fereastra Plate Editor (Editor placă)

n Fereastra Data Analysis (Analiză date)

Fiecare spațiu de lucru este prezentat și descris pe scurt în acest capitol.
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Fereastra Home (Fereastră de pornire)
CFXManager Dx software deschide fereastra Home (Fereastră de pornire) și afișează Startup Wizard
(Expert pornire), din care puteți configura un experiment, realiza sau repeta o rulare sau analiza o
rulare existentă. Din fereastra Home (Fereastră de pornire) puteți, de asemenea, vizualiza jurnalele
aplicației și instrumentului, crea și gestiona utilizatori și accesa multiple instrumente utile. Pentru mai
multe informații, consultați Capitolul 5, Fereastra Home (Fereastră de pornire).
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Startup Wizard (Expert pornire)
Folosiți Startup Wizard (Expert pornire) pentru a configura și rula rapid experimente definite de
utilizator sau pentru a selecta și rula rapid un experiment PrimePCR. Puteți folosi acest expert și
pentru a repeta o rulare sau analiza datele rulării.
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Fereastra Protocol Editor (Editor Protocol)
În Protocol Editor (Editor Protocol) puteți crea, deschide, revizui și edita un protocol. De asemenea,
puteți modifica temperatura capacului pentru protocolul deschis. Funcționalitatea Protocol Editor
(Editor Protocol) este detaliată în Capitolul 6, Crearea de protocoale.
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Fereastra Plate Editor (Editor placă)
În Plate Editor (Editor placă) puteți crea, deschide, revizui și edita o placă. Funcționalitatea Plate
Editor (Editor placă) este detaliată în Capitolul 7, Pregătirea plăcilor.
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Fereastra Data Analysis (Analiză date)
În fereastra Data Analysis (Analiză date) puteți vizualiza și compara date de rulare, efectua analize
statistice, exporta date și crea rapoarte pregătite pentru publicare. Funcționalitatea Data Analysis
(Analiză date) este detaliată în Capitolul 9, Prezentare generală a Data Analysis (Analiză date).
Consultați și Capitolul 10, Detalii despre fereastra Data Analysis (Analiză date).
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pornire)

CFXManager Dx software oferă o interfață pentru dezvoltarea de protocoale PCR, rulând acestea pe
CFX Dx systems și analizând date de rulare PCR.

Acest capitol introduce CFX Manager Dx software și descrie funcțiile accesibile din fereastra Home
(Fereastră de pornire).
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Fereastra Home (Fereastră de pornire)
CFXManager Dx deschide fereastra Home (Fereastră de pornire) și afișează Startup Wizard (Expert
pornire), din care puteți configura o rulare, efectua sau repeta o rulare sau analiza o rulare existentă.
Din fereastra Home (Fereastră de pornire) puteți, de asemenea, vizualiza jurnalele aplicației și
instrumentului, crea și gestiona utilizatori și accesa multiple instrumente utile.

1. Bara de titlu a software-ului afișează numele software-ului și utilizatorul conectat.

2. Bara de meniu oferă acces rapid la comenzile meniurilor File (Fișier), View (Vizualizare),
Users (Utilizatori), Run (Rulare), Tools (Instrumente), Window (Fereastră) și Help (Ajutor).

3. Comenzile barei de instrumente oferă acces rapid la opțiunile meniului.

4. Panoul din stânga afișează instrumentele conectate la computerul CFX Manager Dx și
furnizează butoanele prin care puteți opera capacul și vizualiza starea instrumentelor.

5. Panoul principal afișează fereastra de lucru. Fereastra de lucru implicită de pe ecranul
Home (Fereastră de pornire) este Startup Wizard (Expert pornire).

6. Bara de stare afișează numele instrumentelor conectate și utilizatorul conectat.

LEGENDĂ

48 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Fereastra Home (Fereastră de pornire)

Comenzile meniului File (Fișier)
New (Nou) – deschide o casetă de dialog pe care o puteți folosi pentru a crea un protocol nou, o placă
nouă sau un studiu genic nou.

Open (Deschidere) – deschide o casetă de dialog din care puteți alege să navigați la și să deschideți
un protocol, o placă, un fișier de date, un studiu genic, un fișier LIMS existente, sau un fișier de rulare
PrimePCR.

Recent Data Files (Fișiere de date recente) – afișează o listă a fișierelor PCR deschise recent.

Repeat a Run (Repetare rulare) – deschide Windows Explorer în locul în care sunt salvate fișierele
PCR, unde puteți localiza o rulare de repetat.

Exit (Ieșire) – închide CFX Manager Dx.

Comenzile meniului View (Vizualizare)
Application Log (Jurnalul aplicației) – afișează un jurnal de utilizare a software-ului de la instalarea
inițială și până în ziua actuală.

Run Reports (Rapoarte rulare) – afișează o listă de rapoarte de rulare.

Startup Wizard (Expert pornire) – afișează Startup Wizard (Expert pornire) în panoul principal.

Run Setup (Configurare rulare) – afișează fereastra Run Setup (Configurare rulare) în panoul
principal.

Instrument Summary (Rezumat instrument) – afișează fereastra Instrument Summary (Rezumat
instrument) în panoul principal.

Detected Instruments (Instrumente detectate) – comută între afișarea și neafișarea instrumentelor
conectate în panoul stâng. Implicit, software-ul afișează instrumentele conectate în panoul din stânga.

Toolbar (Bară de instrumente) – comută între afișarea și neafișarea barei de instrumente în partea
de sus a ecranului. Implicit, software-ul afișează bara de instrumente.

Status Bar (Bară de stare) – comută între afișarea și neafișarea barei de stare în partea de jos a
ecranului. Implicit, software-ul afișează bara de stare.

Show (Afișare) – deschide o casetă de dialog din care puteți

n Vizualiza sau bloca jurnalul Status (Stare).

n Deschide și vizualiza folderul de date CFX Manager Dx.

n Deschide și vizualiza folderul de date al utilizatorului.

n Deschide și vizualiza folderul de fișiere LIMS.
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n Deschide și vizualiza folderul PrimePCR.

n Vizualiza istoricul rulărilor.

n Vizualiza proprietățile tuturor instrumentelor conectate.

Comenzile meniului User (Utilizator)
Select User (Selectare utilizator) – deschide ecranul Login (Autentificare) în care puteți selecta un
utilizator din lista verticală User Name (Nume utilizator) și vă puteți autentifica în aplicație.

Change Password (Schimbare parolă) – deschide caseta de dialog Change Password (Schimbare
parolă), în care utilizatorii își pot schimba parola pentru CFX Manager Dx software.

User Preferences (Preferințe utilizator) – deschide caseta de dialog User Preferences (Preferințe
utilizator), în care utilizatorii pot schimba setările implicite pentru

n Trimiterea și primirea notificării prin e-mail la finalizarea rulării

n Salvarea fișierelor de date

n Crearea de protocoale prin Protocol Editor (Editor Protocol) sau Protocol AutoWriter (Utilitar
de scriere automată Protocol)

n Crearea de plăci

n Analizarea datelor

n Realizarea analizei expresiei genice

n Determinarea calității datelor

n Exportarea datelor instrumentului CFX Dx

User Administration (Administrare utilizatori) – deschide caseta de dialog User Administration
(Administrare utilizatori), în care administratorii pot crea utilizatori, modifica permisiunile rolurilor și
atribui roluri utilizatorilor.

Bio-Rad Service Login (Autentificare service Bio-Rad) – pentru utilizarea exclusivă de către
personalul de asistență tehnică Bio-Rad. Nu selectați această comandă.
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Comenzile meniului Run (Rulare)
User-defined Run (Rulare definită de utilizator) – deschide fereastra Run Setup (Configurare
rulare), în care puteți configura un protocol și o placă definite de utilizator, apoi puteți rula un
experiment PCR pe instrumentele selectate.

PrimePCR Run (Rulare PrimePCR) – deschide fila Start Run (Începere rulare) în fereastra Run
Setup (Configurare rulare) cu protocolul PrimePCR și structura de placă implicite încărcate în funcție
de instrumentul selectat.

End-Point Only Run (Rulare numai punct final) – deschide fila Start Run (Începere rulare) în
fereastra Run Setup (Configurare rulare) cu protocolul de punct final și structura de placă implicite
încărcate în funcție de instrumentul selectat.

Qualification Run (Rulare de calificare) – deschide fila Start Run (Începere rulare) în fereastra Run
Setup (Configurare rulare) cu protocolul de calificare Bio-Rad și structura de placă implicite încărcate
pentru instrumentul selectat.

Comenzile meniului Tools (Instrumente)
Master Mix Calculator (Calculator Amestec principal) – deschide Master Mix Calculator
(Calculator Amestec principal), în care puteți crea un amestec de reacție și imprima calculele.

Protocol AutoWriter (Utilitar de scriere automată Protocol) – deschide caseta de dialog Protocol
AutoWriter (Utilitar de scriere automată Protocol), în care puteți crea cu ușurință un protocol nou.

Ta Calculator (Calculator Ta) – deschide Ta Calculator (Calculator Ta), în care puteți calcula cu
ușurință temperatura de atașare a primerilor.

Dye Calibration Wizard (Expert calibrare coloranți) – deschide expertul Dye Calibration (Calibrare
coloranți), în care puteți calibra un instrument pentru un nou fluorofor.

Reinstall Instrument Drivers (Reinstalare drivere instrument) – reinstalează driverele care
controlează comunicarea cu sistemele PCR în timp real ale Bio-Rad.

Zip Data and Log Files (Fișiere ZIP jurnal și de date) – deschide o casetă de dialog în care puteți
selecta fișiere pentru a le condensa și salva într-un fișier ZIP comprimat pentru stocare sau trimitere
prin e-mail.

Batch Analysis (Analiza loturilor) – deschide caseta de dialog Batch Analysis (Analiza loturilor), în
care puteți seta parametrii pentru analizarea mai multor fișiere de date în același timp.

Options (Opțiuni) – deschide o casetă de dialog în care puteți

n Configura setările serverului dumneavoastră de e-mail.

n Configura setările de exportare pentru fișierele LIMS și alte fișiere de date.
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Comenzile meniului Help (Ajutor)
Sfat: Meniul Help (Ajutor) este disponibil în bara de meniu a tuturor ferestrelor CFX Manager Dx
software.

Open Operation Manual (Deschidere manual de utilizare) – deschide un fișier PDF al acestui de
utilizare.

Gene Expression Gateway Web Site (Site-ul web gateway pentru expresie genică) – deschide
pagina de pornire Bio-Rad pentru CFX Dx system.

PCR Reagents Web Site (Site-ul web al reactivilor PCR) – deschide site-ul web Bio-Rad cu
reactivii PCR, de unde puteți comanda reactivi, amestecuri de reacție, coloranți și kituri PCR.

PCR Plastic Consumables Web Site (Site web consumabile plastic PCR) – deschide site-ul web
Bio-Rad cu articole din plastic și consumabile PCR, de unde puteți comanda plăci, folii de sigilare
placă, eprubete și capace și alte accesorii PCR din plastic.

Software Web Site (Site-ul web al software-ului) – deschide site-ul web al software-ului de analiză
PCR al Bio-Rad, de unde puteți comanda versiuni actualizate ale software-ului Bio-Rad CFX Manager
Dx software.

About (Despre) – afișează informații despre copyright și versiune pentru CFX Manager Dx.

Comenzi bară de instrumente

– deschide Windows Explorer, în care puteți naviga la și deschide un fișier de date sau un fișier
de studiu genic.

– deschide Master Mix Calculator (Calculator Amestec principal).

– deschide fereastra Run Setup (Configurare rulare).

– deschide fereastra Run Setup (Configurare rulare) cu protocolul PrimePCR și structura de
placă implicite încărcate în funcție de instrumentul selectat.

– deschide Startup Wizard (Expert pornire).
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Startup Wizard (Expert pornire)
Când se inițializează CFX Manager Dx, panoul de lucru afișează Startup Wizard (Expert pornire). Din
Startup Wizard (Expert pornire) puteți

n Selecta un instrument dintre instrumentele detectate și configura o rulare definită de utilizator sau
PrimePCR.

n Deschide și repeta o rulare.

n Deschide un fișier de date pentru a analiza rezultatele dintr-o singură rulare sau dintr-un fișier de
studiu genic pentru rezultate din mai multe rulări de expresie genică.

Aceste activități sunt explicate în mod detaliat în capitolele care urmează.

Bara de stare
Partea stângă a barei de stare din partea de jos a ferestrei principale a software-ului afișează starea
actuală a instrumentelor detectate. Partea dreaptă a barei de stare afișează numele utilizatorului
actual și data și ora.
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Panoul Detected Instruments (Instrumente detectate)
Panoul Detected Instruments (Instrumente detectate) afișează fiecare instrument care este conectat la
computerul CFX Manager Dx. Implicit, fiecare instrument apare sub formă de pictogramă, iar numărul său
de serie apare ca denumirea sa.

De exemplu, următoarea imagine afișează patru instrumente detectate:

n Două cicloare termice C1000 cu module de reacție CFX96 DeepWell (CFX96DW1 și
CFX96DW2)

n Două cicloare termice C1000 cu module de reacție CFX96 (CFX96l01 și CFX96l02)

Din acest panou, puteți face următoarele lucruri:

n Vizualiza proprietățile și coloranții calibrați pentru un instrument selectat.

Pentru informații despre proprietățile instrumentului, consultați Vizualizarea proprietăților unui
instrument de la pagina 58.

n Vizualiza starea unui instrument conectat.

n Deschide capacul motorizat al instrumentului selectat.

n Închide capacul motorizat al instrumentului selectat.

n Vizualiza starea tuturor instrumentelor conectate.
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Pentru a vizualiza starea unui instrument conectat

u În panoul Detected Instruments (Instrumente detectate), selectați instrumentul țintă și faceți una
dintre următoarele:

n Faceți clic pe View Status (Vizualizare stare) în secțiunea Selected Instrument (Instrument
selectat).

n Faceți clic dreapta și selectați View Status (Vizualizare stare) în meniul care apare.

Va apărea caseta de dialog Run Details (Detalii rulare), care afișează fila Run Status (Stare
rulare). Starea instrumentului selectat apare sub panoul de stare a rulării, de exemplu:

Pentru a deschide sau închide capacul unui instrument

u În panoul Detected Instruments (Instrumente detectate), selectați instrumentul țintă și faceți una
dintre următoarele:

n Faceți clic pe Open Lid (Deschidere capac) sau Close Lid (Închidere capac) în secțiunea
Selected Instrument (Instrument selectat).

n Faceți clic dreapta și selectați acțiunea corespunzătoare în meniul care apare.

n Deschideți caseta de dialog Run Details (Detalii rulare), selectați fila Run Status (Stare
rulare) și faceți clic pe Open Lid (Deschidere capac) sau Close Lid (Închidere capac).

Pentru a vizualiza starea tuturor instrumentelor detectate

u Urmați una dintre procedurile următoare:

n În secțiunea All Instruments (Toate instrumentele) din panoul Detected Instruments
(Instrumente detectate), faceți clic pe View Summary (Vizualizare rezumat).

n În bara de meniu, selectați View > Instrument Summary (Vizualizare > Rezumat instrument).
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Va apărea caseta de dialog Instrument Summary (Rezumat instrument):

Sfat: Dacă sistemul detectează doar un singur instrument conectat, secțiunea All
Instruments (Toate instrumentele) nu apare în panoul Detected Instruments (Instrumente
detectate). Pentru a vizualiza rezumatul instrumentului pentru un singur instrument, selectați
View > Instrument Summary (Vizualizare > Rezumat instrument).
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Comenzile barei de instrumente Instrument Summary (Rezumat instrument)

Tabelul 10 listează comenzile și funcțiile de pe bara de instrumente Instrument Summary (Rezumat
instrument).

Buton Nume buton Funcție

Creați o nouă rulare Creează o rulare pe blocul selectat
deschizând fereastra Run Setup
(Configurare rulare).

Oprire Oprește rularea curentă pe blocurile
selectate.

Pauză Realizează o pauză în rularea curentă
pe blocurile selectate.

Reluare Reia rularea pe blocurile selectate.

Indicator lumină
intermitentă bloc

Face să lumineze intermitent
indicatorul LED de pe capacul
blocurilor selectate.

Deschidere capac Deschide capacul motorizat al blocului
selectat.

Închidere capac Închide capacul motorizat al blocului
selectat.

Ascundere blocuri
selectate

Ascunde blocurile selectate din lista
Instrument Summary (Rezumat
instrument)

Afișare toate blocurile Afișează blocurile selectate din lista
Instrument Summary (Rezumat
instrument)

Show (Afișare) Selectați ce blocuri vor fi afișate în listă.
Selectați una dintre opțiuni pentru a
afișa toate blocurile detectate, toate
blocurile inactive, toate blocurile care
rulează cu utilizatorul curent sau toate
blocurile care rulează

Tabelul 10. Comenzile barei de instrumente Instrument Summary (Rezumat instrument)
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Vizualizarea proprietăților unui instrument
Din panoul Detected Instruments (Instrumente detectate) puteți vedea detalii despre un instrument
selectat, inclusiv proprietățile acestuia, starea șurubului de expediere aferent și o listă a coloranților
săi calibrați (fluorofori).

Pentru vizualizarea proprietăților instrumentului

u În panoul Detected Instruments (Instrumente detectate), faceți clic dreapta pe instrumentul țintă și
selectați Properties (Proprietăți) în meniul care apare.

Fila Properties (Proprietăți)

Fila Properties (Proprietăți) prezintă detaliile tehnice privind instrumentul selectat, inclusiv modelul,
seriile componentelor și versiunile de firmware. Denumirea implicită a instrumentului (seria acestuia)
apare în multe locuri, inclusiv în panoul Detected Instruments (Instrumente detectate) și pe bara de
antet a casetei de dialog Instrument Properties (Proprietăți instrument). Puteți redenumi instrumentul
pentru a-l identifica mai simplu.

Pentru a redenumi un instrument

u În fila Instrument Properties (Proprietăți instrument), introduceți un nume în caseta Rename
(Redenumire) în partea de sus a filei Properties (Proprietăți) și faceți clic pe Rename
(Redenumire).
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Denumirea nouă apare pe rândul Nickname (Alias) în fila Properties (Proprietăți), precum și pe
bara de antet Instrument Properties (Proprietăți instrument) și în panoul Detected Instruments
(Instrumente detectate).

Fila Shipping Screw (Șurub de expediere)

Fila Shipping Screw (Șurub de expediere) afișează starea actuală a șurubului de expediere pentru
instrumentul selectat (Removed (Înlăturat) sau (Installed) (Instalat)). Fila include de asemenea
instrucțiuni pentru instalarea sau înlăturarea șurubului roșu de transport.

Sfat: Dacă software-ul detectează șurubul de expediere, caseta de dialog Instrument Properties
(Proprietăți instrument) afișează automat fila Shipping Screw (Șurub de expediere). Urmați
instrucțiunile pentru a înlătura șurubul.

Observație: Trebuie să înlăturați șurubul de expediere înainte de a putea utiliza instrumentul.
Pentru mai multe informații, consultați Înlăturarea șurubului de expediere de la pagina 30.

Fila Calibrated Dyes (Coloranți calibrați)

Fila Calibrated Dyes (Coloranți calibrați) afișează fluoroforii și plăcile calibrate pentru instrumentul
selectat.

Pentru a vedea informații detaliate despre o calibrare, faceți clic pe butonul Info (Informații) din
coloana Detail (Detalii).
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Setarea preferințelor utilizatorului
Sfat: Nu este obligatoriu să realizați aceste acțiuni pentru a utiliza CFX Manager Dx software.
Puteți omite fără probleme această secțiune sau puteți realiza aceste acțiuni în orice moment.

În CFX Manager Dx, vă puteți personaliza mediul de lucru. Dacă administratorul dumneavoastră a
creat utilizatori pentru software, fiecare utilizator își poate personaliza propriul mediu de lucru. Dacă
administratorul dumneavoastră nu a creat utilizatori, modificările preferințelor se aplică tuturor
utilizatorilor autentificați în CFX Manager Dx. (Pentru informații privind crearea de utilizatori CFX
Manager Dx, consultați Anexa B, Gestionarea utilizatorilor și rolurilor CFX Manager Dx.)

De exemplu, în meniul Users > User Preferences (Utilizatori > Preferințe utilizator), puteți face
următoarele:

n Configura notificarea prin e-mail pentru finalizarea rulării.

n Modifica setările implicite pentru

o Locul în care se salvează fișierele

o Fișierele de configurare a rulării

o Prefixul de denumire a fișierelor

n Seta parametrii impliciți pe care să-i utilizați când creați un nou protocol și o placă nouă.

n Seta parametrii impliciți pentru analiza datelor și expresia genică.

n Personaliza parametrii impliciți de control al calității.

n Personaliza parametrii de exportare a datelor.

În meniul Tools (Instrumente), puteți face următoarele lucruri:

n Crea un amestec principal de reacție.

n Calibra coloranți pentru un anumit instrument.

Observație: Amestecul de reacție PCR și calibrarea coloranților sunt disponibile oricărui utilizator
care se autentifică în CFX Manager Dx.

Această secțiune vă explică în detaliu cum să realizați aceste acțiuni.
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Configurarea notificării prin e-mail

Puteți conecta CFX Manager Dx la serverul dumneavoastră de e-mail de ieșire pentru a trimite o
notificare prin e-mail privind finalizarea unei rulări unei liste de utilizatori. Puteți, de asemenea, alege
să atașați un fișier de date și un raport de analiză listei de utilizatori. Pentru a stabili conexiunea dintre
CFX Manager Dx și serverul dumneavoastră SMTP, consultați Conectarea CFX Manager Dx la un
server SMTP de la pagina 62.

Observație: Capacitatea unui utilizator de a accesa funcțiile de configurare a e-mailului depinde
de grupul utilizatorului și permisiunile atribuite de administrator. Pentru detalii privind gestionarea
utilizatorilor și a rolurilor acestora, consultați Gestionarea utilizatorilor de la pagina 257.

Pentru a configura notificările prin e-mail

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Email (E-mail).

Observație: Veți fi informat dacă sistemul detectează că nu ați configurat un server SMTP
valid pentru CFX Manager Dx. Faceți clic pe Configure Outgoing Email (Configurare e-mail
de ieșire) pentru a deschide caseta de dialog Options (Opțiuni) și a configura serverul SMTP
de e-mail. Pentru mai multe informații, consultați Conectarea CFX Manager Dx la un server
SMTP de la pagina 62.

2. În caseta de text To (Destinatar), tastați adresa de e-mail a fiecărei persoane pe care intenționați
să o informați despre finalizarea rulării. Toți destinatarii vor primi un e-mail după finalizarea rulării.

Observație: Trebuie să introduceți fiecare adresă de e-mail pe un rând separat. Apăsați
Enter sau Return după fiecare adresă.

3. (Opțional) În caseta de text cc, tastați adresa de e-mail a fiecărui destinatar căruia intenționați să-i
trimiteți o copie a fiecărei notificări prin e-mail.
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4. (Opțional) Implicit, toți destinatarii primesc o copie a fișierului de date sub formă de atașare.
Debifați caseta de selectare dacă nu doriți să atașați o copie a fișierului de date.

5. (Opțional) Selectați Attach Analysis Report (Atașare raport analiză) pentru a atașa un PDF al
raportului de analiză la e-mail.

6. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Pentru a edita adresa de e-mail a unui destinatar

u Modificați adresa de e-mail după cum este necesar și faceți clic pe OK.

Pentru a șterge un destinatar de e-mail

1. Selectați destinatarul e-mailului și apăsați tasta Delete (Ștergere).

2. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Conectarea CFX Manager Dx la un server SMTP

Important: Unii furnizori de servicii comerciale de e-mail (precum Yahoo! și Gmail) și-au crescut
nivelul de securitate a e-mailului. Dacă utilizați aceste conturi, trebuie să activați setarea Allow
less secure apps (Permiteți aplicațiile mai puțin sigure) în setările contului respectiv, pentru
a permite CFX Manager Dx să trimită e-mailuri. Consultați informațiile de securitate ale
furnizorului dumneavoastră de servicii e-mail pentru informații suplimentare.

Trebuie să stabiliți o conexiune de la CFX Manager Dx la serverul dumneavoastră de e-mail înainte ca
software-ul să poată trimite notificări prin e-mail.

Pentru a conecta CFX Manager Dx la un server de e-mail

1. Urmați una dintre procedurile următoare:

n Selectați User > User Preferences (Utilizator > Preferințe utilizator) și faceți clic pe Configure
Outgoing Email (Configurare e-mail de ieșire) în fila Email (E-mail).

n Selectați Tools > Options (Instrumente > Opțiuni).

Apare caseta de dialog Options (Opțiuni), care afișează fila Email (E-mail).
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2. Introduceți următoarele informații pentru compania dumneavoastră:

n SMTP Server Name (Denumire server SMTP) – numele serverului pentru e-mailuri de
ieșire al companiei dumneavoastră.

n Port – numărul portului aferent serverului dumneavoastră SMTP. De obicei, acesta este 25.

n Use SSL (Utilizare SSL) – opțiunea Secure Sockets Layer (SSL). Unele servere SMTP
necesită această setare. Dacă nu este necesară în cadrul companiei dumneavoastră,
debifați respectiva casetă de selectare.

n Use Default “From” Address (Utilizare adresă „De la” implicită) – numele serverului de
e-mail al companiei dumneavoastră. Unele servere SMTP impun ca toate e-mailurile trimise
să aibă o adresă „de la” dintr-un anumit domeniu, de exemplu,
nume@CompaniaDumneavoastrăcom. În acest caz, debifați această casetă de selectare și
introduceți o adresă de e-mail validă.

n Authentication Required (Autentificare necesară) – dacă instituția dumneavoastră
impune autentificarea cu un cont, asigurați-vă că această casetă de selectare este bifată.

n User Name (Nume utilizator) – numele contului autentificat. Este necesar numai dacă se
selectează Authentication Required (Autentificare necesară).

n Password (Parolă) – parola pentru contul autentificat. Este necesară numai dacă se
selectează Authentication Required (Autentificare necesară).

3. Pentru a vă asigura că setările serverului SMTP sunt corecte, introduceți o adresă de e-mail
validă în caseta de text Test Email Address (Testare adresă de e-mail) și faceți clic pe Test Email
(Testare e-mail).

Observație: Unele servere SMTP nu permit utilizarea de atașări, iar altele permit numai
utilizarea de atașări până la o dimensiune maximă specifică. Dacă intenționați să trimiteți prin
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e-mail fișiere de date și/sau rapoarte utilizând CFX Manager Dx, selectați Test Attachment
(Testare atașament) și setați Attachment Size in MB (Dimensiune atașament în MB) la
minimum 5 megabytes (MB).

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Schimbarea setărilor implicite ale fișierelor

În fila Files (Fișiere) din caseta de dialog User Preferences (Preferințe utilizator), puteți schimba
următoarele:

n Locația implicită în care se salvează fișierele CFX Manager Dx

n Fișierele implicite pentru configurarea rulării

n Parametrii impliciți de denumire a fișierelor

Pentru a schimba setările implicite ale fișierelor

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Files (Fișiere).

3. În secțiunea Default Folder for File Creation (Folder implicit pentru crearea fișierelor), navigați la
și selectați un folder implicit în care doriți să salvați noile fișiere. Puteți selecta un loc diferit pentru
fiecare tip de fișier:

64 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Înainte de a începe

n Protocol

n Placă

n Fișier de date

n Studiu genic

4. În secțiunea File Selection for Run Setup (Selectare fișier pentru configurarea rulării), navigați la
și selectați protocolul țintă și fișierele de placă ce vor apărea când deschideți fereastra
Experiment Setup (Configurare experiment).

5. În secțiunea Data File (Fișier de date), definiți prefixul și/sau sufixul pentru fișierele de date.
Pentru orice parte, selectați o nouă valoare din lista sa verticală. Puteți, de asemenea, furniza
valori personalizate pentru prefix și sufix în casetele de text Prefix și Suffix.

CFX Manager Dx afișează o previzualizare a numelui fișierului sub casetele de selectare.

6. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.
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Setarea parametrilor de protocol impliciți

Pentru a seta parametri de protocol impliciți pentru Protocol Editor (Editor Protocol) și
Protocol AutoWriter (Utilitar de scriere automată Protocol)

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Protocol.

3. În secțiunea Protocol Editor (Editor Protocol), specificați valori pentru următoarele setări care
apar în Protocol Editor (Editor Protocol):

n Sample volume (Volumul probei) – volumul fiecărei probe din alveole (în µl).

n Lid Shutoff temperature (Temperatură oprire capac) – temperatura în ºC la care
încălzitorul capacului se oprește în timpul unei rulări.

4. În secțiunea Protocol AutoWriter (Utilitar de scriere automată Protocol), specificați valori pentru
următoarele setări care apar înProtocol AutoWriter (Utilitar de scriere automată Protocol):

n Annealing temperature (Temperatură de atașare) – temperatura în ºC pentru
experimente care utilizează polimerază ADN iProof, polimerază ADN iTaq sau alte
polimeraze.

n Amplicon length (Lungime amplicon) – lungimea ampliconului în bp.

5. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.
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Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Setarea parametrilor de placă impliciți

Schimbările pe care le faceți în fila Plate (Placă) sunt disponibile tuturor utilizatorilor software-ului.
Schimbările pe care le faceți în timpul configurării plăcii sunt disponibile utilizatorilor după ce salvați și
închideți fișierul de placă.

În caseta de dialog User Preferences (Preferințe utilizator) puteți efectua următoarele:

n Setați parametrii de placă impliciți.

n Adăugați noi denumiri pentru țintă și probă la bibliotecile lor respective.

n Ștergeți denumiri pentru țintă și probă din bibliotecile lor respective.

Pentru a seta parametrii de placă impliciți

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Plate (Placă).
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3. Specificați valori pentru următoarele setări pentru un fișier de placă nou. Aceste valori apare în
fereastra Plate Editor (Editor placă):

n Plate type (Tip de placă)

n Dimensiune placă

n Units (Unități) – concentrația matriței de pornire pentru alveolele care conțin standarde.

CFX Manager Dx utilizează aceste unități pentru a crea o curbă standard în fila Data Analysis
Quantification (Cuantificare analiză date).

n Scientific notation (Notație științifică) – când este selectată, CFX Manager Dx afișează
unitățile de concentrație în notația științifică.

n Scan mode (Mod scanare) – numărul sau tipul de canale de scanat în timpul unei rulări.

n Fluorophores (Fluorofori) – fluoroforii impliciți care apar în soluțiile de control Plate Editor
(Editor placă) pentru încărcarea godeului.

n Libraries (Biblioteci) – denumirile pentru țintă și probă pe care le utilizați de obicei în
experimentele dumneavoastră:

o Target Names (Denumiri ținte) – denumirile genelor și secvențelor țintă.

o Sample Names (Denumiri probe) – denumirile pentru probele experimentului sau o
caracteristică identificatoare pentru mostre (de exemplu, Mouse1, Mouse2, Mouse3 –
Șoarece1, Șoarece2, Șoarece3).

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Pentru a adăuga o nouă denumire de țintă sau probă

u În caseta de bibliotecă corespunzătoare, introduceți numele pentru țintă sau probă și faceți clic pe
OK.

Pentru a șterge o denumire de țintă sau probă

u În caseta de bibliotecă corespunzătoare, selectați numele și apăsați tasta Delete (Ștergere), apoi
faceți clic pe OK.

Important: Numele pe care le înlăturați din bibliotecă sunt eliminate automat din software și nu
mai sunt disponibile utilizatorilor. Pentru a restaura denumirile implicite CFX Manager Dx, faceți
clic pe Restore Defaults (Restabilire valori implicite). Făcând clic pe Restore Defaults (Restabilire
valori implicite) în caseta de dialog User Preferences (Preferințe utilizator), resetați toate
preferințele din toate filele la setările de fabrică inițiale. Procedați cu atenție la ștergerea
denumirilor CFX Manager Dx implicite și când faceți clic pe acest buton.
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Setarea parametrilor impliciți pentru analiza de date

Pentru a configura parametrii impliciți ai analizei datelor

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Data Analysis (Analiză
date).

3. În secțiunea Analysis Mode (Mod Analiză), selectați modul în care să analizați datele (fie
Fluorophore (Fluorofor), fie Target (Țintă)).

4. În secțiunea PCR Quantitation (Cuantificare PCR), configurați parametrii impliciți pentru
următoarele opțiuni:

n Baseline Setting (Setarea Nivel inițial) – metoda de referință pentru modul de analiză.

n Cq Determination Mode (Mod Determinare Cq) – modul în care sunt calculate valorile Cq
pentru fiecare urmă de fluorescență (fiecare regresie sau prag unic).
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n Threshold Calc. (Calculare Prag) Mode (Mod calc. prag) – cantitatea țintei la momentul
final.

Opțiunea implicită este Auto. Adică software-ul calculează automat ținta la momentul final.
Pentru a configura un anumit prag, debifați caseta de selectare Auto și introduceți valoarea
de la momentul final, calculată în unități de fluorescență relativă (sau RFU). Valoarea
maximă este de 65.000,00 RFU. Fișierele de date pentru rulările ulterioare vor folosi această
setare de prag.

n Baseline Calc. Mode (Mod calc. nivel inițial) – nivelul inițial pentru toate urmele.

Opțiunea implicită este Auto. Adică software-ul calculează automat nivelul inițial pentru toate
urmele. Pentru a configura un anumit nivel inițial, debifați caseta de dialog Auto și introduceți
valorile minime și maxime pentru intervalul de cicluri (de la 1 la 9999). Fișierele de date
pentru rulările ulterioare vor folosi acest interval de cicluri.

n Log View (Vizualizare log) – determină modul în care software-ul afișează datele de
amplificare:

o On (Activat) – datele amplificării sunt afișate într-un grafic semilogaritmic.

o Off (Dezactivat) – (implicit) datele amplificării sunt afișate într-un grafic liniar.

5. În secțiunea End Point (Momentul final), selectați numărul de cicluri finale pentru care veți calcula
media atunci când faceți calculele pentru momentul final.

n PCR – numărul de cicluri finale pentru care veți calcula media datelor de cuantificare
(valoarea implicită este 5).

n End Point Only run (Rulare doar momentul final) – numărul de cicluri finale pentru care
veți calcula media datelor de la momentul final (valoarea implicită este 2).

6. În secțiunea Melt Curve (Curbă de topire), selectați tipul vârfului de detectat (pozitiv sau negativ).

7. În secțiunea Well Selector (Selector alveole), selectați modul de afișare a etichetelor alveolelor
(după tipul probei, denumirea țintei sau denumirea probei).

8. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.
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Setarea parametrilor impliciți pentru fișierul de date de expresie genică

Pentru a seta parametrii impliciți pentru un nou fișier de date de expresie genică

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Gene Expression
(Expresie genică).

3. Specificați valorile pentru următoarele setări:

n Relative to (Relativ la) – generează un grafic pentru datele expresiei genice relativ la o
proba control (începând de la 1) sau relativ la zero:

o Zero – software-ul ignoră proba control. Aceasta este valoarea implicită atunci când nu
este alocată nicio probă de control în fereastra Experiment Settings (Setări experiment).

o Control – software-ul calculează datele relativ la proba de control alocată în fereastra
Experiment Setup (Configurare experiment).

n X-axis (Axa x) – reprezintă grafic proba sau ținta pe axa x.

n Y-axis (Axa y) – reprezintă grafic scara liniară, log2 sau log10 pe axa y.
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n Scaling (Scalare) – opțiunea de scalare pentru grafic (opțiunea implicită este Unscaled
(Nescalat)):

o Highest (Cel mai ridicat) – software-ul scalează graficul la punctul de date cel mai
ridicat.

o Lowest (Cel mai scăzut) – software-ul scalează graficul către punctul de date cel mai
scăzut.

o Unscaled (Nescalat) – software-ul prezintă datele nescalate (fără scalare) în grafic.

n Mode (Mod) – modul de analiză, fie cantitate relativă (∆Cq) fie expresie normalizată (∆∆Cq).

n Error Bar (Bară de eroare) – variabilitatea datelor s-a prezentat fie ca deviația standard
(Std. Dev.), fie ca eroarea standard a mediei (Std. Error Mean).

n Error Bar Multiplier (Multiplicator bară de eroare) – multiplicatorul deviației standard
utilizat pentru a desena barele de eroare (valoarea implicită este 1).

Puteți mări multiplicatorul la 2 sau 3.

n Sample Types to Exclude (Tipuri de probe de exclus) – aceleași tipuri de probe de
exclus din analiză.

Puteți selecta una sau mai multe probe pentru excludere din analiză. Pentru a exclude toate
tipurile de probe, debifați casetele de selectare pentru orice tipuri de probe selectate.

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Personalizarea regulilor de control al calității

În CFX Manager Dx, puteți seta reguli pentru controlul calității, care sunt aplicate datelor din fereastra
Data Analysis (Analiză date). Software-ul validează datele față de regulile setate de dumneavoastră

Observație: Implicit, toate regulile de control al calității sunt activate.

Sfat: Puteți exclude cu ușurință alveolele care nu îndeplinesc un parametru CC în modulul CC al
ferestrei Data Analysis (Analiză date).

Pentru a personaliza regulile de control al calității

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila QC (CC).
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unde:

n NTC – control fără țintă de amplificare

n NRT – control fără transcriptaza inversă

n Efficiency (Eficiență) – eficiența reacțiilor

n Std Curve R^2 (R^2 curbă standard) – valoarea R pătrat pentru curba standard

n Replicate group Cq Std Dev (Deviație standard Cq pentru grup de replicate) – deviația
standard calculată pentru fiecare grup de replicate

3. Pentru fiecare regulă QC (CC), urmați una dintre procedurile următoare:

n Pentru a utiliza valoarea implicită, nu faceți nimic.

n Pentru a modifica valoarea, faceți clic pe caseta de text Value (Valoare) aferentă, introduceți
o nouă valoare și apăsați tasta Enter.

n Pentru a dezactiva regula, debifați caseta de selectare Use (Utilizare) aferentă.

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.
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Personalizarea parametrilor de exportare a datelor

Puteți exporta datele CFX Manager Dx în următoarele formate:

n Text (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Puteți specifica tipul de date de exportat și personaliza ieșirea datelor exportate.

Pentru a personaliza parametrii de exportare a datelor

1. Selectați Users > User Preferences (Utilizatori > Preferințe utilizator) pentru a deschide caseta de
dialog User Preferences (Preferințe utilizator).

2. În caseta de dialog User Preferences (Preferințe utilizator), selectați fila Custom Export
(Exportare particularizată).
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3. În lista verticală Export Format (Format de exportare), selectați un format în care să exportați
datele.

4. În secțiunea Data to Export (Date de exportat), bifați sau debifați casetele de selectare pentru
tipul de date de exportat. Elementele selectate apar în caseta listă Exported Columns (Coloane
exportate).

Observație: Implicit, informațiile rulării sunt incluse în antet. Debifați această casetă de
selectare dacă nu doriți să fie incluse informațiile de rulare.

5. Puteți modifica ordinea de pe afișajul de ieșire a elementelor selectate.

În caseta listă Exported Columns (Coloane exportate), evidențiați elementul, apoi faceți clic pe
butoanele săgeată din stânga listei pentru a-l deplasa în sus sau în jos.

6. Opțional, puteți modifica numele coloanelor de ieșire ale elementelor selectate:

a. Faceți clic pe Customize Column Names (Personalizare nume coloană).

Va apărea caseta de dialog Column Name Customizer (Instrument de particularizare nume
coloană).

b. Pentru fiecare nume implicit de coloană pe care doriți să-l schimbați, tastați un nume nou în
câmpul Custom Name (Nume personalizat) corespunzător.

c. Urmați una dintre procedurile următoare:

n Faceți clic pe OK pentru a salva modificările și a reveni la fila Custom Export (Exportare
particularizată). Noul nume apare în paranteze, lângă coloana implicită din caseta listă
Exported Columns (Coloane exportate).

n Faceți clic pe Cancel (Anulare) pentru a anula modificările și a reveni la fila Custom
Export (Exportare particularizată).

7. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog.

Important: Făcând clic pe Restore Defaults (Restabilire valori implicite) în caseta de dialog User
Preferences (Preferințe utilizator), resetați toate preferințele din toate filele la setările de fabrică
inițiale. Procedați cu atenție când faceți clic pe acest buton.

Crearea unui amestec principal de reacție
Folosind Master Mix Calculator (Calculator Amestec principal) din CFX Manager Dx, puteți calcula cu
ușurință volumul necesar al fiecărei componente a amestecului principal. Puteți imprima tabelul de
calcul al amestecului principal la imprimanta dumneavoastră implicită și puteți salva calculele pentru
fiecare țintă în vederea utilizării ulterioare.
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Pentru a crea un amestec principal de reacție cu ajutorul Master Mix Calculator
(Calculator Amestec principal)

1. Pentru a deschide Master Mix Calculator (Calculator Amestec principal), urmați una dintre
procedurile următoare:

n Selectați Tools > Master Mix Calculator (Instrumente > Calculator Amestec principal).

n Faceți clic pe Master Mix Calculator (Calculator Amestec principal) de pe bara de
instrumente.

Va apărea Master Mix Calculator (Calculator Amestec principal).

2. În secțiunea Reaction (Reacție), selectați o metodă de detecție:

n SYBR®Green/EvaGreen

n Probes (Sonde)
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3. Pentru a crea o țintă nouă, în secțiunea Target (Țintă) faceți clic pe Create New (Creare nou). În
lista verticală de ținte va apărea o nouă denumire de țintă.

4. (Opțional) Pentru a schimba denumirea țintei implicite:

a. Evidențiați denumirea țintei în lista verticală a țintei.

b. Tastați o nouă denumire a țintei în caseta Target (Țintă).

c. Apăsați tasta Enter.

5. Ajustați concentrațiile inițiale și finale pentru primerii de redirecționare și inversare și orice sonde.

6. În secțiunea Master Mix Setup (Configurare Amestec principal), ajustați valorile pentru

n Numărul de reacții de rulat

n Volumul reacției per alveolă

n Volumul șablonului per alveolă

n Concentrație amestec de reacție per alveolă

n Volumul reacției în exces per alveolă

7. (Opțional) Urmați pașii 2-6 pentru câte ținte este necesar.

8. În secțiunea Choose Target to Calculate (Alegere țintă de calculat), selectați ținta de calculat.

Sfat: Puteți calcula doar una sau mai multe sau toate țintele în același timp.

Volumele calculate ale componentelor necesare pentru fiecare țintă selectată apar în tabelul
amestecului principal.

9. Faceți clic pe Set as Default (Stabilire ca implicit) pentru a seta cantitățile în secțiunile Target
(Țintă) și Master Mix Setup (Configurare Amestec principal) drept noi valori implicite.

10. Faceți clic pe OK pentru a salva conținutul casetei de dialog Master Mix Calculator (Calculator
Amestec principal).

Pentru a imprima tabelul de calcul al amestecului principal

u Pentru a imprima tabelul de calcul al amestecului principal, faceți clic pe Print (Imprimare).

Tabelul de calcul se imprimă la imprimanta dumneavoastră implicită.

Pentru a salva tabelul de calcul al amestecului principal ca fișier PDF

u Schimbați imprimanta implicită cu un driver PDF și faceți clic pe Print (Imprimare) în Master Mix
Calculator (Calculator Amestec principal).
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Pentru a șterge țintele

u Selectați ținta utilizând lista verticală de ținte și făcând clic pe Remove (Eliminare).

Important: Ștergerea unei ținte din lista de ținte o șterge și din toate calculele amestecului
principal în care este folosită. Procedați cu atenție când ștergeți o țintă.
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Calibrarea de coloranți noi
Sistemele CFX96 Dx sunt calibrate din fabrică pentru fluoroforii utilizați în mod obișnuit pe plăcile cu
alveole albe și transparente. Tabelul 11 afișează fluoroforii și canalul pentru care este calibrat fiecare
instrument.

Observație: Sistemele CFX96 includ, de asemenea, un canal dedicat experimentelor chimice
FRET. Acest canal nu necesită calibrare pentru coloranți specifici.

Fluorofori Canal Excitație, nm Detecție, nm

FAM, SYBR® Green I 1 450-490 515-530

VIC, HEX, CAL Fluor Gold 540, Cal Fluor
Orange 560

2 515-535 560-580

ROX, Texas Red, CAL Fluor Red 610,
TEX 615

3 560-590 610-650

CY5, Quasar 670 4 620-650 675-690

Quasar 705, Cy5.5 5 672-684 705-730

Tabelul 11. Fluorofori și canale calibrate din fabrică

Pentru a calibra coloranți noi pentru sistemele CFX

1. In fereastra Home (Fereastră de pornire), selectați un instrument țintă în panoul Detected
Instruments (Instrumente detectate).

2. Selectați Tools > Calibration Wizard (Instrumente > Expert calibrare) pentru a deschide expertul
Dye Calibration (Calibrare coloranți).
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Fluoroforii calibrați deja pentru instrumentul țintă apar în tabelul Calibrated Fluorophores
(Fluorofori calibrați).

3. În secțiunea Calibrate New or Existing Fluorophores (Calibrare fluorofori noi sau existenți),
selectați fluoroforul de calibrat din lista verticală.

Dacă denumirea fluoroforului nu este inclusă în listă, introduceți denumirea în caseta de text
pentru a o adăuga în listă.

4. Selectați tipul de placă pentru fluorofor.

Dacă tipul de placă nu este inclus în listă, introduceți denumirea în caseta de text pentru a o
adăuga în listă.

5. Selectați un canal pentru fluorofor.

6. Selectați o coloană de placă pentru fluorofor.

7. (Opțional) Scrieți o culoare care doriți să fie asociată cu fluoroforul.

8. Faceți clic pe Add to Plate (Adăugare la placă) pentru a adăuga fluoroforul.

9. (Opțional) Repetați pașii 3-8 pentru a adăuga fiecare fluorofor pe care doriți să îl calibrați pentru
placă.

10. Când finalizați adăugarea fluoroforilor, faceți clic pe View Plate (Vizualizare placă) pentru a
deschide fereastra Pure Dye Plate Display (Afișare placă coloranți puri).

Utilizați această fereastră ca ghid pentru încărcarea coloranților pe placă.

11. Pregătiți o placă cu 96 alveole pentru calibrarea coloranților:

a. Pipetați soluție de colorant în fiecare alveolă, respectând tiparul din Pure Dye Plate Display
(Afișare placă coloranți puri).

b. Pentru fiecare fluorofor, umpleți patru alveole cu 50 µl (placă cu 96 de alveole) de soluție de
colorant 300 nM. Veți observa că cel puțin jumătate din placă conține alveole goale.

c. Sigilați placa folosind metoda de sigilare pe care o veți utiliza în cadrul experimentului.

12. Poziționați placa de calibrare în bloc și închideți capacul.

13. În expertul Dye Calibration (Calibrare coloranți), faceți clic pe Calibrate (Calibrare) și pe OK
pentru a confirma că placa se află în bloc.

14. Când CFX Manager Dx software finalizează rularea de calibrare, apare o casetă de dialog. Faceți
clic pe Yes (Da) pentru a finaliza calibrarea și a deschide Dye Calibration Viewer (Vizualizator de
calibrare coloranți).

15. Faceți clic pe OK pentru a închide fereastra.

80 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Capitolul 6 Crearea de protocoale
Un protocol este un set de pași care sunt executați într-o secvență specifică. În CFX Manager Dx
software, toți pașii sunt asociați cu opțiunile de pe instrument. De exemplu, pașii dau instrucțiuni
instrumentului să controleze temperatura blocului și a capacului, să aplice o diferență de temperatură
pe bloc, să efectueze o citire de placă sau să efectueze o analiză pentru curba de topire. Fiecare
opțiune este specificată pentru diferite tipuri de placă și rulare.

CFX Manager Dx furnizează două opțiuni pentru crearea de protocoale: Protocol Editor (Editor
Protocol) și Protocol AutoWriter (Utilitar de scriere automată Protocol).

Caracteristica Protocol Editor (Editor Protocol) include următoarele:

n Soluții de control standard pentru protocol, pentru a crea rapid protocoale

n Capacitatea de a calcula rapid un gradient pentru numărul selectat de rânduri

n Capacitatea de a calcula rapid timpul de rulare pentru tipul de placă selectat

n Capacitatea de a edita pași de protocol

n Capacitatea de a salva protocoale pentru reutilizare

n Capacitatea de a imprima protocolul la o imprimantă implicită

Protocol AutoWriter (Utilitar de scriere automată Protocol) generează automat un protocol PCR
personalizat cu etapa de activare pentru polimeraza hot-start, denaturare inițială, atașare și pași de
elongare, folosind parametrii pe care îi furnizați dumneavoastră Puteți apoi să vizualizați o
reprezentare grafică a protocolului sugerat și să editați, rulați sau salvați protocolul.
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Fereastra Protocol Editor (Editor Protocol)
Folosiți fereastra Protocol Editor (Editor Protocol) pentru a crea, deschide, verifica și edita un protocol.
Implicit, Protocol Editor (Editor Protocol) deschide un protocol generic în 2 pași în timp real pentru o
placă de 96 de alveole.

1. Bara de meniu oferă acces rapid la comenzile de meniu File (Fișier), Settings (Setări) și
Tools (Instrumente).

2. Bara de instrumente oferă acces rapid pentru salvarea și imprimarea protocolului, stabilirea
punctului de inserare a unui pas, setarea volumului probei și vizualizarea timpului de rulare
estimat al protocolului.

3. Panoul principal afișează o reprezentare grafică a protocolului.

4. Panoul de jos afișează schița protocolului.

5. Panoul din stânga afișează comenzile protocolului pe care le puteți adăuga pentru a
personaliza protocolul.

LEGENDĂ
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Comenzile meniului File (Fișier)
Save (Salvare) – salvează protocolul curent.

Save As (Salvare ca) – salvează protocolul curent cu o denumire nouă sau într-un loc nou.

Close (Închidere) – închide Protocol Editor (Editor Protocol)

Comandă meniu Settings (Setări)
Lid Settings (Setări capac) – deschide caseta de dialog Lid Setting (Setări capac) în care puteți
schimba sau seta temperatura capacului.

Comenzile meniului Tools (Instrumente)
Gradient Calculator (Calculator Gradient) – deschide o casetă de dialog din care puteți selecta tipul
de bloc pentru un pas de gradient. Opțiunea implicită este 96 de alveole.

Run time Calculator (Calculator timp rulare) – deschide o casetă de dialog din care puteți selecta
tipul de placă și modul de scanare pentru a calcula timpul de rulare estimat în fereastra Run Setup
(Configurare rulare). Opțiunea implicită este 96 alveole, toate canalele.

Comenzi bară de instrumente

– salvează fișierul de protocol actual.

– imprimă fereastra selectată.

– utilizați această comandă pentru a selecta unde să introduceți pași relativ la
pasul selectat în prezent.

– utilizați această comandă pentru a introduce un volum de probă în µl.
Volumele probelor diferă în funcție de tipul de bloc:

n Pentru un bloc de 96 de alveole adânci intervalul este 0-125 µl.

n Pentru un bloc de 96 de alveole intervalul este de 0-50 µl.
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– afișează timpul de rulare estimat bazat pe pașii de protocol, viteza de
creștere și tipul de bloc selectat.

– afișează informații de Ajutor despre protocoale.

Soluții de control pentru editarea protocolului
Panoul stâng din fereastra Protocol Editor (Editor Protocol) include soluții de control pe care le puteți
utiliza pentru a crea protocoale.

Fiecare soluție de control constă într-un set de parametri care reprezintă un pas din protocol. Puteți
modifica fiecare parametru și îi puteți adăuga sau elimina pentru a vă personaliza protocolul. Această
secțiune descrie opțiunile din fiecare soluție de control.

n Insert Step (Inserare pas) – inserează un pas înainte sau după
pasul selectat. Puteți edita valorile pentru temperatură și timpul de
menținere în afișajul grafic al protocolului sau în schița protocolului.

n Insert Gradient (Inserare gradient) – inserează un pas de gradient
bazat pe tipul de bloc cu alveole selectat în calculatorul de gradient.
Puteți edita intervalul de gradient în panoul Gradient care apare
atunci când un pas de gradient este inserat.

n Insert GOTO (Inserare SaltLa) – inserează un pas de ciclu (circuit)
step, care informează software-ul să repete pași specifici în secvență
pentru un număr specificat de cicluri. Repetițiile încep după ce primul
ciclu este finalizat. De exemplu, puteți informa software-ul să

efectueze 39 de repetiții pentru pașii 2-4. După repetiția finală, software-ul va fi efectuat pașii 2-4
de 40 de ori în total. Puteți edita pasul de return-to (revenire-la) (GOTO (SaltLa)) și numărul de
cicluri fie din afișajul grafic, fie din schița de protocol.

n Insert Melt Curve (Inserare curbă de topire) – inserează un pas de citire de curbă de topire.

n Insert Plate Read to Step (Inserare citire placă la pas) – adăugați o comandă de citire placă la
pasul selectat. O citire de placă măsoară cantitatea de fluorescență de la sfârșitul unui ciclu.
Pasul pentru citire placă este în general ultimul pas dintr-o buclă GOTO (SaltLa).

Sfat: După ce adăugați o comandă de citire placă unui pas, butonul se schimbă în Remove
Plate Read (Eliminare citire placă) atunci când selectați pasul.
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n Remove Plate Read (Eliminare citire placă) – elimină o comandă de citire placă din pasul
selectat.

Sfat: După ce eliminați o comandă de citire placă dintr-un pas, butonul de schimbă în Add
Plate Read to Step (Adăugare citire placă la pas) atunci când selectați pasul.

n Step Options (Opțiuni pas) – deschide caseta de dialog Step Options (Opțiuni pas) și afișează
opțiunile disponibile pentru pasul selectat. Consultați Opțiuni pas de la pagina 85 pentru informații
detaliate privind opțiunile pentru pas.

Sfat: De asemenea, puteți accesa Step Options (Opțiuni pas) făcând clic dreapta pe pas în
afișajul grafic.

n Delete Step (Ștergere pas) – șterge pasul selectat din protocol.

Opțiuni pas

Deschideți caseta de dialog Step Options (Opțiuni pas) pentru a vizualiza opțiunile pe care le puteți
adăuga, schimba sau elimina dintr-un pas.

n Plate Read (Citire placă) – când este selectată, adaugă o citire de placă la pas.

n Temperature (Temperatură) – setează temperatura țintă pentru pasul selectat.

n Gradient – setează intervalul de gradient pentru pas; intervalul este 1-24°C.

Observație: Un gradient rulează cu cea mai joasă temperatură în partea din fata a blocului
(în această imagine, rândul H) și cea mai ridicată temperatură în partea din spatele blocului
(în această imagine, rândul A).
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n Increment – suma cu care să crească (sau scadă) temperatura pasului selectat; această valoare
este adăugată la temperatura țintă cu fiecare ciclu. Intervalul este de ±0,1-10°C.

Observație: Pentru a reduce temperatura, introduceți un semn de minus (–) înainte de
valoarea numerică (de exemplu, –5°C).

n Ramp Rate (Viteză de creștere) – viteza de creștere pentru pasul selectat; intervalul depinde de
dimensiunea blocului.

n Time (Timp) – timpul de menținere pentru pasul selectat.

n Extend (Extindere) – timpul (în sec.) pentru extinderea sau reducerea pasului selectat; această
opțiune este adăugată la timpul de menținere din fiecare ciclu; intervalul este de 1-60 sec.

n Beep (Bip) – când este selectată, se aude un bip la sfârșitul pasului.

Sfat: Când introduceți un număr care este în afara intervalului de opțiuni, software-ul
schimbă numărul la cea mai apropiată intrare din interval.
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Crearea unui protocol în Protocol Editor (Editor Protocol)
Utilizând Protocol Editor (Editor Protocol), puteți crea fișiere protocol personalizate. Puteți, de
asemenea, edita și salva fișiere protocol salvate anterior sau șabloane de fișiere protocol livrate
împreună cu CFX Manager Dx software.

Pentru a crea un nou fișier protocol, procedați în felul următor:

n Deschideți un fișier protocol în Protocol Editor (Editor Protocol).

Sfat: Puteți deschide un protocol nou sau existent în Protocol Editor (Editor Protocol).

n Configurați noul protocol.

n Adăugați pași la protocol din panoul de control al protocolului.

n Editați proprietățile pașilor.

n Salvați protocolul.

Sfat: Pentru a crea un nou protocol dintr-un fișier protocol salvat anterior sau dintr-un șablon de
fișier protocol, consultați Deschiderea unui protocol existent în Protocol Editor (Editor Protocol) de
la pagina 88.

Deschiderea unui nou fișier de protocol în Protocol Editor
(Editor Protocol)
CFXManager Dx oferă mai multe opțiuni de deschidere a unui nou fișier de protocol:

n Din fereastra Home (Fereastră de pornire)

n Din caseta de dialog Startup Wizard (Expert pornire)

n Din caseta de dialog Run Setup (Configurare rulare)

Pentru a deschide un nou fișier de protocol din Fereastra de pornire

u Selectați File > New > Protocol (Fișier > Nou > Protocol).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează fișierul de protocol
implicit.

Sfat: Pentru informații despre configurarea protocolului implicit, consultați Schimbarea
setărilor implicite ale fișierelor de la pagina 64.
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Pentru a deschide un nou fișier de protocol din Startup Wizard (Expert pornire)

1. În fereastra Home (Fereastră de pornire), urmați una dintre procedurile următoare pentru a
deschide Startup Wizard (Expert pornire) dacă nu apare în vizualizare:

n Selectați View > Startup Wizard (Vizualizare > Expert pornire).

n Faceți clic pe Startup Wizard (Expert pornire) de pe bara de instrumente.

Implicit, Startup Wizard (Expert pornire) afișează fila Run Setup (Configurare rulare) cu tipul de
instrument CFX96 selectat.

2. Dacă este necesar, selectați tipul de instrument din lista verticală.

3. Faceți clic pe User-defined (Definit de utilizator) ca tip de rulare.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol, care va afișa
fișierul de protocol implicit.

4. Faceți clic pe Create New (Creare nou).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează protocolul implicit în timp
real.

Pentru a deschide un nou protocol din caseta de dialog Run Setup (Configurare rulare)

1. În fereastra Home (Fereastră de pornire), urmați una dintre procedurile următoare pentru a
deschide caseta de dialog Run Setup (Configurare rulare):

n Selectați Run > User-defined Run (Rulare > Rulare definită de utilizator).

n Faceți clic pe User-defined Run Setup (Configurare rulare definită de utilizator) de pe bara de
instrumente.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol, care vă va afișa
fișierul de protocol implicit.

2. Faceți clic pe Create New (Creare nou).

Se va deschide fereastra Protocol Editor (Editor Protocol), care afișează protocolul implicit în timp
real.

Deschiderea unui protocol existent în Protocol Editor
(Editor Protocol)
CFXManager Dx furnizează fișiere de protocol probă pe care le puteți edita și salva ca protocoale noi
personalizate. De asemenea puteți crea un protocol nou dintr-un protocol personalizat existent.
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Pentru a deschide un fișier de protocol probă

1. În fereastra Home (Fereastră de pornire), selectați File > Open > Protocol (Fișier > Deschidere >
Protocol).

Implicit, Windows Explorer se deschide la locația folderului CFX Manager Dx Sample files (Fișiere
probă).

2. Deschideți folderul Sample files (Fișiere probă). Vedeți următoarele foldere:

n ConventionalProtocols (ProtocoaleConvenționale) – conține fișiere de protocol exemplu
pentru analiză PCR tradițională.

n DataFiles (FișiereDate) – conține fișiere de date exemplu pe care le puteți utiliza pentru a
explora funcțiile CFX Manager Dx.

n MeltCalibration (CalibrareTopire) – conține fișiere de protocol exemplu pentru utilizare cu
software-ul Precision Melt Analysis al Bio-Rad.

n Plates (Plăci) – conține fișiere de placă exemplu.

n RealTimeProtocols (ProtocoaleTimpReal) – conține fișiere de protocol exemplu pentru
analiză PCR în timp real.

3. Deschideți folderul de protocol pentru tipul de rulare pe care doriți să îl efectuați, fie
ConventionalProtocols (ProtocoaleConvenționale)sau RealTimeProtocols
(ProtocoaleTimpReal).

4. Selectați protocolul pe care îl doriți și faceți clic pe Open (Deschidere).

Protocolul probă se deschide în fereastra Protocol Editor (Editor Protocol).

5. Selectați File > Save As (Fișier > Salvare ca) și salvați protocolul cu o denumire nouă sau într-un
folder nou.

Pentru a deschide un protocol existent

1. În fereastra Home (Fereastră de pornire), efectuați una dintre următoarele:

n Selectați File > Open > Protocol (Fișier > Deschidere > Protocol), navigați la și selectați
protocolul țintă și faceți clic peOpen (Deschidere).
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n Deschideți Startup Wizard (Expert pornire) și efectuați una dintre următoarele:

o Pentru a edita protocolul afișat, faceți clic pe Edit Selected (Editare selectate).

o Pentru a edita un alt protocol existent, faceți clic pe Select Existing (Selectare existent) și
navigați la fișierul țintă.

Protocolul se deschide în fereastra Protocol Editor (Editor Protocol).

2. Selectați File > Save As (Fișier > Salvare ca) și salvați protocolul cu o denumire nouă sau într-un
folder nou.

Configurarea unui nou protocol
Sfat: Dacă fișierul dumneavoastră de protocol include parametrii necesari (de exemplu, dacă
editați un fișier placă existent), puteți omite această secțiune. Continuați cu Adăugarea de pași la
un protocol de la pagina 92.

Noile fișiere de protocol necesită următorii parametri:

n Tipul blocului

n Modul de scanare pentru tipul de bloc selectat

n Temperatura capacului

n Volumul probei

Setarea tipului de bloc

CFXManager Dx calculează automat creșterile de temperatură pentru pașii de gradient pe baza
tipului de bloc.

Observație: Tipul de placă setat în Protocol Editor (Editor Protocol) trebuie să fie același cu cel
pentru placa din modulul de reacție.

Pentru a seta tipul de bloc

u În fereastra Protocol Editor (Editor Protocol), selectați Tools > Gradient Calculator (Instrumente >
Calculator gradient) și alegeți tipul de placă adecvat din lista verticală care apare.

Selectarea modului de scanare pentru tipul de bloc selectat

Pentru a stabili timpul de rulare a protocolului, selectați tipul blocului țintă și modul de scanare.

Pentru a stabili tipul blocului și modul de scanare

u În fereastra Protocol Editor (Editor Protocol), selectați Tools > Run time Calculator (Instrumente >
Calculator timp de rulare) și alegeți tipul de placă și modul de scanare adecvate din lista verticală
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care apare.

Ajustarea temperaturii capacului

CFXManager Dx setează temperatura implicită a capacului la 105,0 °C.

Puteți modifica setările implicite sau opri încălzitorul capacului după cum necesită protocolul.

Sfat: Puteți modifica temperatura implicită a capacului în caseta de dialog User Preferences
(Preferințe utilizator). Consultați Setarea parametrilor de protocol impliciți de la pagina 66.

Pentru a ajusta temperatura capacului

1. În fereastra Plate Editor (Editor placă), selectați Settings > Lid Settings (Setări > Setări capac).

Apare caseta de dialog Lid Settings (Setări capac).

2. Urmați una dintre procedurile următoare:

n Selectați User Defined (Definite de utilizator) și introduceți o valoare de temperatură în
caseta de text.

n Selectați Turn Off Lid Heater (Oprire încălzitor capac).

3. Faceți clic pe OK pentru a accepta modificările și a închide caseta de dialog.

Setarea volumului de probă

Implicit, CFX Manager Dx setează volumul de probă pentru fiecare alveolă la 25 µl. Cu toate acestea,
intervalul CFX Dx system este 0-125 µl.

Instrumentul utilizează unul din două moduri de control al temperaturii pentru a determina când ajunge
proba la temperatura țintă într-un protocol:

n Calculated mode (Mod calculat) – atunci când volumul probei este setat la un volum
corespunzător pentru bloc, instrumentul calculează temperatura probei pe baza volumului probei.
Acesta este modul standard.

n Block mode (Mod bloc) – atunci când volumul probei este setat la zero (0) µl, instrumentul
înregistrează temperatura probei ca fiind aceeași cu temperatura măsurată a blocului.

Pentru a seta volumul de probă pentru un bloc specific

u În fereastra Plate Editor (Editor placă), introduceți valoarea corectă în caseta de text Sample
Volume (Volum probă) de pe bara de instrumente.

Sfat: Puteți modifica volumul de probă implicit în caseta de dialog User Preferences (Preferințe
utilizator). Consultați Schimbarea setărilor implicite ale fișierelor de la pagina 64.
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Adăugarea de pași la un protocol
Pentru a adăuga un pas la un protocol

1. Deschideți protocolul în fereastra Protocol Editor (Editor Protocol).

2. Stabiliți unde doriți să inserați noul pas. Pe bara de instrumente, selectați Before (Înainte) sau
After (După) din lista verticală Step (Pas).

3. În grafic, selectați pasul înainte sau după care intenționați să inserați noul pas.

4. În panoul din stânga, faceți clic pe Insert Step (Inserare pas).

5. Pentru a modifica temperatura sau timpul de așteptare, faceți clic pe valoarea implicită din grafic
sau schița protocolului și tastați o valoare nouă.

6. (Opțional) În panoul din stânga, faceți clic pe Step Options (Opțiuni pași) pentru a deschide
caseta de dialog Step Options (Opțiuni pași) și pentru a modifica opțiunile disponibile pentru pasul
selectat.

Sfat: Puteți accesa caseta de dialog Step Options (Opțiuni pași) din meniul clic dreapta al
panoului graficului sau al panoului schiței protocolului.

7. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările protocolului.

Va apărea caseta de dialog Save As (Salvare ca)

8. În caseta de dialog Save As (Salvare ca), tastați denumirea noului fișier de protocol și faceți clic
pe Save (Salvare).

Inserarea unui pas de gradient
Pentru a insera un pas de gradient

1. Verificați că dimensiunea plăcii pentru gradient este aceeași cu tipul de bloc al instrumentului, cu
96 de alveole.

2. Dacă încă nu ați procedat astfel, selectați dimensiunea plăcii pentru gradient:

Selectați Tools > Gradient Calculator (Instrumente > Calculator gradient) și selectați tipul de
alveolă corespunzător din lista verticală.

3. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

4. În grafic sau în panoul de schiță, selectați pasul înainte sau după care intenționați să inserați
pasul de gradient.
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5. În panoul din stânga, faceți clic pe Insert gradient (Inserare gradient). Noul pas de gradient este
evidențiat în grafic și în panoul de schiță, de exemplu:

Temperatura fiecărui rând din gradient apare în tabelul Gradient în panoul din dreapta.

6. Pentru a edita intervalul de temperatură pentru gradient, efectuați una dintre următoarele:

n Faceți clic pe temperatura implicită în grafic sau panoul de schiță și introduceți o temperatură
nouă.

n Faceți clic pe Step Options (Opțiuni Pas) pentru a introduce intervalul de gradient în fereastra
Step Options (Opțiuni Pas).

n Schimbați valoarea pentruRange (Interval) în tabelul Gradient.

7. Pentru a edita timpul de menținere, faceți clic pe timpul implicit din vizualizarea grafică sau text și
introduceți un timp nou.

8. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.
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Inserarea unui pas GOTO (SaltLa)
Observație: Nu puteți insera un pas GOTO (SaltLa) într-un set GOTO (SaltLa); nu puteți crea
bucle GOTO (SaltLa) imbricate.

Pentru a insera un pas GOTO (SaltLa)

1. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

2. În grafic, selectați pasul înainte sau după care intenționați să inserați pasul GOTO (SaltLa).

3. În panoul din stânga, faceți clic pe Insert GOTO (Inserare SaltLa).

4. Pentru a edita numărul pasului GOTO (SaltLa) sau numărul de repetări GOTO (SaltLa), selectați
numărul implicit din grafic sau din panoul de schiță și introduceți o valoare nouă.

5. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.

Inserarea unui pas de curbă de topire
Sfat: Nu puteți insera un pas de curbă de topire într-o bucla GOTO (SaltLa).

Observație: Pasul de curbă de topire include o menținere de 30 de secunde la începutul pasului,
care nu este afișată în protocol.

Pentru a insera un pas de curbă de topire

1. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

2. În grafic, selectați pasul înainte sau după care intenționați să inserați pasul de curbă de topire.
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3. În panoul din stânga, faceți clic pe Insert Melt Curve (Inserare curbă de topire). Noul pas de curbă
de topire este evidențiat în grafic și în panoul de schiță, de exemplu:

4. Pentru a edita intervalul de temperatură de topire sau timpul de increment, selectați numărul
implicit în grafic sau în panoul de schiță și introduceți o valoare nouă.

5. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.
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Adăugarea sau eliminarea unui pas de citire placă
Sfat: După ce adăugați o comandă de citire placă unui pas, butonul se schimbă în Remove Plate
Read (Eliminare citire placă) atunci când selectați pasul.

Pentru a adăuga o citire de placă la un pas

1. Pe bara de instrumente, selectați Before (Înainte) sau After (După) din lista verticală Insert Step
(Inserare pas).

2. În grafic, selectați pasul înainte sau după care intenționați să inserați pasul de citire placă.

3. În panoul din stânga, faceți clic pe Add Plate Read to Step (Adăugare citire placă la pas) pentru a
adăuga o citire de placă la pasul selectat.

4. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva modificările.

Pentru a elimina o citire de placă dintr-un pas

u În grafic, selectați pasul care conține citirea de placă și faceți clic pe Remove Plate Read
(Eliminare citire placă) în panoul din stânga.

Modificarea opțiunilor pașilor
Pentru a modifica opțiunile pașilor pentru un pas selectat

1. Selectați pasul țintă în grafic sau în panoul de schiță.

2. În panoul din stânga, faceți clic pe Step Options (Opțiuni pași) pentru a deschide caseta de dialog
Step Options (Opțiuni pași).

Ca alternativă, faceți clic dreapta pe pasul țintă în oricare panou și selectați Step Options (Opțiuni
pași) în meniul care apare.

3. Pentru a adăuga, modifica sau elimina opțiuni:

n Introduceți o valoare în caseta de text corespunzătoare.

n Editați o valoare în caseta de text specifică.

n Bifați sau debifați o casetă de selectare.

4. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog Step Options (Opțiuni
pași).

5. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva protocolul.
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Ștergerea unui pas
Pentru a șterge un pas din protocol

1. Selectați pasul în grafic sau în panoul de schiță.

2. În panoul din stânga, faceți clic pe Delete Step (Ștergere pas) pentru a șterge pasul selectat.

3. Faceți clic pe OK și apoi pe Yes (Da) pentru a salva protocolul.

Copierea, exportarea sau imprimarea unui protocol
Pentru a copia un protocol

u Faceți clic dreapta pe schița protocolului și selectați Copy Protocol (Copiere protocol).

Puteți lipi schița într-un fișier .txt, .xls, .doc sau .ppt.

Pentru a exporta un protocol

1. Faceți clic dreapta pe schița protocolului și selectați Export Protocol (Exportare protocol).

Va apărea caseta de dialog Save As (Salvare ca).

2. (Opțional) În Windows Explorer, navigați la un folder în care doriți să salvați fișierul protocolului.

3. În File name (Denumire fișier), introduceți o denumire pentru fișierul de protocol exportat.

4. Faceți clic pe Save (Salvare).

Pentru a imprima un protocol

u Faceți clic dreapta pe schița protocolului și selectați Print (Imprimare).

Puteți imprima schița protocolului utilizând imprimanta dvs. implicită.
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Crearea unui protocol cu Protocol AutoWriter (Utilitar de
scriere automată Protocol)

Important: Bio-Rad nu garantează că rularea unui protocol creat cu Protocol AutoWriter (Utilitar
de scriere automată Protocol) va determina întotdeauna un produs PCR în timp real.

Protocol AutoWriter (Utilitar de scriere automată Protocol) din CFX Manager Dx generează automat
protocoale de ciclu bazate pe următorii parametri de intrare:

n Amplicon length (Lungime amplicon) – lungimea așteptată a produsului PCR

n Annealing temperature (Temperatură de atașare) – Ta de reacție pentru primerii utilizați

Dacă Ta este necunoscută, puteți utiliza Ta Calculator (Calculator Ta) pentru a o calcula automat
pe baza secvențelor de primer.

Observație: Ta este ajustată pe baza informațiilor privind temperatura de topire a primerului
(Tm), care se bazează pe enzima selectată și pe viteza protocolului.

n Enzyme type (Tip de enzimă) – enzima DNA (ADN) polimerază (iTaq, iProof DNA (ADN)
polimerază sau Other (Alta))

Dacă utilizați o altă enzimă decât iTaq sau iProof DNA (ADN) polimerază, puteți introduce
informații suplimentare, inclusiv intervalul de gradient, timpul de activare a polimerazei tip hot-
start (în sec) și timpul de elongare finală (în sec).

n Run speed (Viteza de rulare) – viteza de reacție (standard, rapid sau ultrarapid)

Protocol AutoWriter (Utilitar de scriere automată Protocol) optimizează protocolul în funcție de
setarea de viteză selectată. Timpul de rulare total este determinat de numărul de pași și de cicluri,
de timpul de incubare la fiecare pas și de timpul necesar pentru atingerea uniformității la
temperatura țintă.

Utilizând parametrii introduși de dumneavoastră și ghidul standard pentru PCR, Protocol AutoWriter
(Utilitar de scriere automată Protocol) generează automat un protocol PCR personalizat cu pași de
activare pentru polimeraza hot-start, denaturare inițială, atașare și elongare. Puteți apoi să vizualizați
o reprezentare grafică a protocolului sugerat și să editați, rulați sau salvați protocolul.
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Pentru a crea un nou protocol utilizând Protocol AutoWriter (Utilitar de scriere automată
Protocol) din cadrul CFX Manager Dx

1. În fereastra Home (Fereastră de pornire), selectați Tools > Protocol AutoWriter (Instrumente >
Utilitar de scriere automată Protocol).

Apare caseta de dialog Protocol AutoWriter (Utilitar de scriere automată Protocol).

2. În secțiunea Enter Target Values/Enzyme (Introducere valori țintă/enzimă), procedați după cum
urmează:

n Introduceți temperatura de atașare (Ta) pentru primeri, dacă este cunoscută.

Sfat: Pentru mai multe informații, consultați Utilizarea Ta Calculator (Calculator Ta) de
la pagina 100.

Observație: Pentru informații despre calculele utilizate în Ta Calculator (Calculator Ta),
consultați Breslauer et al. 1986.

n Introduceți lungimea ampliconului în perechi de baze (pb).

n Selectați un tip de enzimă din lista de opțiuni (iTaq DNA (ADN) polimerază, iProof DNA
(ADN) polimerază sau Other (Altal)).

Sfat: Dacă selectați Other (Altal) ca tip de enzimă, parametrii din secțiunea Additional
Parameters (Optional) (Parametri suplimentari (Opțional)) devin activi.
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3. Dacă ați selectat Other (Alta) ca tip de enzimă, puteți adăuga oricare dintre sau toți parametrii
următori la protocol:

n Gradient range (Interval de gradient)

n Hot start activation temperature (Temperatură de activare pentru polimeraza tip hot-start)

n Final extension time (Timp de elongare finală)

4. În secțiunea Type (Tip), deplasați cursorul pentru a selecta o viteză de protocol (Standard, Rapid
sau Ultrarapid). CFX Manager Dx ajustează timpul total de rulare.

5. Selectați tipul de PCR de efectuat (Real-time PCR (PCR în timp real) este opțiunea implicită).

În cazul PCR în timp real, CFX Manager Dx adaugă un pas de citire placă pentru colectarea de
date de fluorescență.

6. În secțiunea Preview (Previzualizare), revizuiți protocolul. Puteți efectua modificări după
necesități.

7. Urmați una dintre procedurile următoare:

n Faceți clic pe OK pentru a salva noul protocol. După ce a fost salvat, protocolul se deschide
în Startup Wizard (Expert pornire). Faceți clic pe Edit Selected (Editare selectate) pentru a
aduce orice modificări protocolului. De exemplu, ați putea avea nevoie să schimbați
temperatura capacului și volumul probei.

n Faceți clic pe Cancel (Anulare) pentru a închide fereastra fără a salva protocolul.

Utilizarea Ta Calculator (Calculator Ta)
Atunci când nu cunoașteți temperatura de atașare pentru primer, puteți folosi Ta Calculator (Calculator
Ta) pentru a calcula valoarea. Puteți folosi valoarea din Protocol AutoWriter (Utilitar de scriere
automată Protocol) sau din Protocol Editor (Editor Protocol) pentru a vă crea protocolul.

Despre Ta Calculator (Calculator Ta)
Ta Calculator (Calculator Ta) calculează valoarea Tm pentru fiecare primer, precum și valoarea Ta
pentru protocol la viteză standard.

Valoarea Ta pentru protocol este bazată pe valorile Tmmedii ale primerului, aplicându-se următoarele
reguli:

n Dacă diferența dintre valorile Tm ale primerului este > 4°C, Ta = (valoarea mai mică dintre cele
două valori Tm ale primerului + 2) – 4 °C

n Dacă diferența dintre valorile Tm este ≤4 °C, Ta = (media valorilor Tm ale primerului) – 4 °C
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Metoda numărării perechilor de baze

Pentru fiecare primer, Ta Calculator (Calculator Ta) utilizează metoda numărării perechilor de baze
pentru secvențe de maximum 14 perechi de baze (pb).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

unde w, x, y și z sunt numerele bazelor A, T, G, respectiv C din secvență.

Metoda Cel mai apropiat vecin

Pentru secvențe mai lungi de 14 bp, se utilizează metoda cu cel mai apropiat vecin. În metoda cu cel
mai apropiat vecin, calculele pentru temperatura de topire sunt bazate pe relația termodinamică dintre
entropie (ordine sau o măsură a caracterului aleatoriu al oligonucleotidei), entalpie (căldură eliberată
sau absorbită de oligonucleotidă), energie liberă și temperatură.

∆H = ∆G + T* ∆S

unde:

n ∆H = Valoare entalpie, Cal/Mol*K

n T = temperatură, Kelvin

n ∆S = Valoare entropie, Cal/Mol*K

n ∆G = Energie liberă Gibbs în Cal/Mol*K

Schimbarea din entropie și entalpie este calculată direct însumând valorile pentru perechile de
nucleotide afișate în Tabelul 12 (Breslauer et al. 1986).

Relația dintre energia liberă și concentrația de reactanți și produse la echilibru este dată de:

∆G = R*T*ln ((ADN * Primer)/(ADN + Primer))

unde R este constanta gazoasă (1,986 Cal/Mol*K).

Prin substituirea G în cele două ecuații și rezolvarea pentru T rezultă

T = ∆H/(∆S + R*Ln((ADN * Primer)/(ADN + Primer)))

presupunând că concentrațiile de ADN și complex ADN-primer sunt egale.

S-a determinat în mod empiric faptul că există o schimbare de energie liberă de 5 kcal (3,4 kcal)
(Sugimoto et al. 1996) în timpul tranziției de la ADN cu catenă unică la ADN de formă B. Aceasta se
presupune a fi energie de inițializare a helixului. La final, adăugarea unei ajustări pentru sare dă
ecuația pe care o utilizează Calculatorul Ta :

T = (∆H – 5(KCal/K*Mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (MolaritateSare)
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Nicio constantă de ajustare pentru concentrația de sare nu este necesară, deoarece diverșii parametri
au fost determinați la 1 M NaCl, iar log10 de 1 este zero.

Calculele termodinamice presupun că procesul de atașare are loc la pH 7,0. Calculele pentru Tm
presupun că secvențele nu sunt simetrice și conțin cel puțin unG sau C.

Secvența de oligonucleotidă trebuie să fie la o lungime de cel puțin 14 baze pentru a oferi valori Tm
rezonabile. Mai puțin de 14 baze utilizează aceeași metodă de numărare a perechilor de baze
(consultați Tabelul 12 care urmează).

Interacțiune ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabelul 12. Constante de interacțiune Breslauer
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Utilizarea Ta Calculator (Calculator Ta)

Pentru a utiliza Ta Calculator (Calculator Ta)

1. Pentru a deschide Ta Calculator (Calculator Ta), urmați una dintre procedurile următoare:

n Dacă momentan vă aflați în Protocol AutoWriter (Utilitar de scriere automată Protocol), faceți
clic pe Ta Calculator (Calculator Ta).

n În fereastra Home (Fereastră de pornire), selectați Tools > Ta Calculator (Instrumente >
Calculator Ta).

Va apărea caseta de dialog Ta Calculator (Calculator Ta).

2. În caseta de dialog Forward Primer (primer Forward), tastați sau lipiți secvența de redirecționare a
primerului.

Sfat: Puteți, de asemenea, folosi butoanele A, T, G, C din partea stângă a casetei de dialog
pentru a introduce secvența.

3. Tastați sau lipiți secvența primerului revers în caseta de text Reverse Primer (primer Reverse).
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4. Faceți clic pe Calculate (Calculare).

Ta Calculator (Calculator Ta) calculează și afișează Tm pentru fiecare primer și media Tm și
valorile Ta, de exemplu:

Dacă valorile Tm ale primerului diferă între ele cu mai mult de 4°C, Protocol AutoWriter (Utilitar de
scriere automată Protocol) folosește valoarea Tm inferioară a primerului + 2 °C ca bază de calcul
pentru valoarea Ta, pe care o puteți modifica ulterior prin modificarea enzimei și a vitezei de
reacție.

Ta Calculator (Calculator Ta) generează o temperatură de atașare pentru viteza standard cu
polimeraza ADN iTaq. Dacă se folosește o altă enzimă, setările de viteză se ajustează automat
Ta.

5. Urmați una dintre procedurile următoare:

n Dacă ați deschis Ta Calculator (Calculator Ta) din Protocol AutoWriter (Utilitar de scriere
automată Protocol), faceți clic pe OK. Reveniți la Protocol AutoWriter (Utilitar de scriere
automată Protocol). Temperatura de atașare este modificată automat.

n Dacă ați deschis Ta Calculator (Calculator Ta) din meniul Tools (Instrumente), înregistrați
calculele și faceți clic pe Cancel (Anulare) pentru a închide calculatorul.
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Un fișier placă conține informații despre parametrii rulării, precummodul de scanare, fluoroforii și
conținutul godeului. După rulare, CFX Manager Dx software asociază conținutul alveolelor cu datele
de fluorescență colectate în timpul rulării și aplică analiza corespunzătoare în fereastra Data Analysis
(Analiză date). De exemplu, alveolele încărcate cu probă de tip standard sunt utilizate pentru a genera
o curbă standard.

CFX Manager Dx software oferă două opțiuni de creare a plăcilor: Plate Editor (Editor placă) pentru
rulări PCR în timp real și Setup Wizard (Expert configurare) pentru analiza expresiei genice
normalizate.

Plate Editor (Editor placă) include următoarele funcții:

n Fluorofori standard și tipuri de probe ce vor fi atribuite alveolelor plăcii

n Capacitatea de a configura țintă de referință și probă de control pentru analiza expresiei genice

n Capacitatea de a edita configurația plăcii înainte, în timpul sau după finalizarea unei rulări

n Capacitatea de a salva fișierele placă pentru reutilizare

n Capacitatea de a imprima fișierul placă la o imprimantă implicită

Setup Wizard (Expert configurare) vă asistă la crearea unei structuri de placă pentru analiza expresiei
genice normalizate. Puteți folosi Setup Wizard (Expert configurare) înainte, în timpul sau după
finalizarea unei rulări.
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Fereastra Plate Editor (Editor placă)
Utilizați Plate Editor (Editor placă) pentru a crea plăci personalizate sau modifica plăcile existente.

1. Bara de meniu furnizează acces rapid la comenzile de meniu File (Fișier) și Settings
(Setări), precum și la opțiunile de instrumente de editare pentru placă.

2. Bara de instrumente oferă acces rapid la funcții de încărcare de placă importante.

3. Panoul principal afișează schița plăcii și opțiunile de placă atunci când le aplicați.

4. Panoul din dreapta afișează opțiuni pe care le utilizați pentru a vă personaliza placa.

5. Panoul de jos afișează tipul de placă și oferă acces rapid la opțiunile de vizualizare.

LEGENDĂ
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Comenzile meniului File (Fișier)
Save (Salvare) – salvează fișierul de date de placă în locația specificată în fila File (Fișier) din caseta
de dialog User Preferences (Preferințe utilizator). Pentru mai multe informații, consultați Schimbarea
setărilor implicite ale fișierelor de la pagina 64. Acest element de meniu este disponibil numai la
crearea unui fișier de placă nou.

Save As (Salvare ca) – salvează fișierul de date de placă deschis cu un nume nou pe care îl furnizați
dumneavoastră Acest element de meniu este disponibil numai la crearea unui fișier de placă nou.

Extract Plate (Extragere placă) – deschide o casetă de dialog în care puteți extrage/salva fișierul de
placă (.pltd). Acest element de meniu este disponibil numai la vizualizarea sau editarea unui fișier de
placă existent.

Print (Imprimare) – imprimă fișierul de date de placă deschis.

Close (Închidere) – închide Plate Editor (Editor placă)

Comenzile meniului Settings (Setări)
Plate Size (Dimensiune placă) – furnizează opțiuni din care puteți selecta o dimensiune a plăcii
pentru rulare.

Observație: CFX Dx system poate folosi doar o placă de 96 de alveole.

Plate Type (Tipul plăcii) – vă permite să alegeți tipul alveolelor din placa cu probele dumneavoastră,
fie BRWhite (BR Alb), fie BR Clear (BR Transparent). Pentru o analiză de date precisă, tipul de placă
selectat trebuie să corespundă cu tipul de placă utilizat în rulare.

Number Convention (Convenție numerică) – vă permite să bifați sau să debifați opțiunea de afișare
a unităților în notație științifică. Opțiunea implicită este afișarea unităților în notație științifică.

Units (Unități) – vă permite să alegeți unitățile de afișat în foile de calcul atunci când efectuați
cuantificarea unei curbe necunoscute vs. una standard.

Comenzile meniului Editing Tools (Instrumente de editare)
Setup Wizard (Expert configurare) – deschide Setup Wizard (Expert configurare), în care puteți
defini parametrii de structură și analiză pentru placa actuală. Puteți folosi Setup Wizard (Expert
configurare) înainte de, în timpul sau după finalizarea unei rulări.

Spreadsheet View/Importer (Vizualizare/importator foaie de calcul) – deschide caseta de dialog
View (Vizualizare), care afișează structura de placă drept șablon în format de foaie de calcul. Puteți
utiliza această casetă de dialog pentru a exporta sau importa datele de șablon de placă în format .csv.

Flip Plate (Întoarcere placă) – întoarce conținutul plăcii la 180o.
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Comenzi bară de instrumente

Salvează fișierul de placă actual.

Afișează o listă verticală din care puteți crește sau reduce mărirea
vizualizării plăcii.

Afișează o listă verticală din care puteți selecta un mod de scanare, care dă
instrucțiuni instrumentului din ce canale să colecteze date de fluorescență
în timpul unei rulări.

Deschide fereastra Well Groups Manager (Manager grupuri de alveole), pe
care o puteți utiliza pentru a crea grupuri de alveole pentru placa actuală.

Afișează o casetă de dialog în care puteți alege culorile și simbolurile pentru
urmele de amplificare.

Deschide caseta de dialog View (Vizualizare), care afișează structura
dumneavoastră de placă drept șablon într-un format de foaie de calcul.
Puteți utiliza această casetă de dialog pentru a exporta sau importa
datele de șablon de placă în format .csv.

Afișează pașii necesari pentru configurarea unei plăci și încărcarea
alveolelor.
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Crearea unui fișier placă utilizând Plate Editor (Editor placă)
Utilizând Plate Editor (Editor placă), puteți crea fișiere placă particularizate. Puteți, de asemenea,
edita și salva fișiere placă salvate anterior sau fișiere placă de probă livrate împreună cu CFX
Manager Dx software.

Pentru a crea un nou fișier placă, procedați în felul următor:

n Deschideți un fișier placă în Plate Editor (Editor placă).

n Selectați tipul plăcii.

Observație: Tipul plăcii pentru fișierul placă trebuie să fie același cu tipul de placă din
modulul de reacție.

n Selectați modul de scanare care va fi utiliza în protocol.

n Selectați fluoroforii care vor fi utilizați în placă.

n Selectați tipul probei, țintele și probele.

n Selectați replicările, dacă este cazul.

n Salvați structura plăcii.

Sfat: Pentru a crea o placă nouă din fișierele salvate anterior sau din fișiere placă de
probă, consultați Deschiderea unui fișier placă existent în Plate Editor (Editor placă) de la pagina
111.

Deschiderea unui fișier placă nou în Plate Editor (Editor placă)
CFXManager Dx software oferă mai multe opțiuni de deschidere a unui nou fișier de placă:

n Din fereastra Home (Fereastră de pornire)

n Din caseta de dialog Startup Wizard (Expert pornire)

n Din caseta de dialog Run Setup (Configurare rulare)

Pentru a deschide un nou fișier de placă din fereastra Home (Fereastră de pornire)

u Selectați File > New > Plate (Fișier > Nou > Placă).

Fereastra Plate Editor (Editor placă) se deschide afișând fișierul de placă implicit pentru
instrumentul selectat.

Sfat: Pentru informații privind setarea fișierului de placă implicit, consultați Schimbarea
setărilor implicite ale fișierelor de la pagina 64.
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Pentru a deschide un nou fișier de placă din Startup Wizard (Expert pornire)

1. În fereastra Home (Fereastră de pornire), urmați una dintre procedurile următoare pentru a
deschide Startup Wizard (Expert pornire) dacă nu apare în vizualizare:

n Selectați View > Startup Wizard (Vizualizare > Expert pornire).

n Faceți clic pe Startup Wizard (Expert pornire) de pe bara de instrumente.

Implicit, Startup Wizard (Expert pornire) afișează fila Run Setup (Configurare rulare) cu
instrumentul CFX96 selectat.

2. Dacă este necesar, selectați tipul de instrument din lista verticală.

3. Pentru a crea o placă nouă, faceți clic pe User-defined (Definit de utilizator) ca tip de rulare.

Se va deschide caseta de dialog Run Setup (Configurare rulare) care afișează fila Protocol.

4. Faceți clic pe fila Plate (Placă) și faceți clic pe Create New (Creare nou).

Fereastra Plate Editor (Editor placă) se deschide afișând structura de placă implicită pentru
instrumentul selectat.

Pentru a deschide un nou fișier de placă din caseta de dialog Run Setup (Configurare
rulare)

1. În fereastra Home (Fereastră de pornire), urmați una dintre procedurile următoare pentru a
deschide caseta de dialog Run Setup (Configurare rulare):

n Selectați Run > User-defined Run (Rulare > Rulare definită de utilizator).

n Faceți clic pe User-defined Run Setup (Configurare rulare definită de utilizator) de pe bara de
instrumente.

Se va deschide caseta de dialog Run Setup (Configurare rulare) în fila Protocol.

2. Pentru a crea o placă nouă, faceți clic pe fila Plate (Placă) și faceți clic pe Create New (Creare
nou).

Fereastra Plate Editor (Editor placă) se deschide afișând structura de placă implicită pentru
instrumentul selectat.
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Deschiderea unui fișier placă existent în Plate Editor
(Editor placă)
CFXManager Dx software furnizează fișiere de placă probă pe care le puteți edita și salva ca o placă
nouă. De asemenea, puteți crea un fișier de placă nou dintr-un fișier de placă salvat.

Pentru a deschide un fișier de placă probă

1. În fereastra Home (Fereastră de pornire), selectați File > Open > Plate (Fișier > Deschidere >
Placă).

Windows Explorer deschide locația folderului CFX Manager Dx Sample files (Fișiere probă).

2. Deschideți folderul Sample files (Fișiere probă), apoi deschideți folderul Plates (Plăci).

3. Selectați placa dorită și faceți clic pe Open (Deschidere).

Fișierul de placă probă se deschide în fereastra Plate Editor (Editor placă).

4. Selectați File > Save As (Fișier > Salvare ca) și salvați fișierul de placă cu o denumire nouă sau
într-un folder nou.

Pentru a deschide un fișier de placă salvat anterior

1. În fereastra Home (Fereastră de pornire), selectați File > Open > Plate (Fișier > Deschidere >
Placă), navigați la și selectați placa țintă și faceți clic peOpen (Deschidere).

Fișierul de placă țintă se deschide în fereastra Plate Editor (Editor placă).

2. Selectați File > Save As (Fișier > Salvare ca) și salvați fișierul de placă cu o denumire nouă sau
într-un folder nou.
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Configurarea unui fișier de placă nou
Sfat: Dacă fișierul dumneavoastră de placă include parametrii necesari (de exemplu, dacă editați
un fișier de probă sau un fișier de placă existent), puteți omite această secțiune. Continuați cu
Atribuirea de parametri opționali fișierului placă de la pagina 118.

Noile fișiere de placă necesită următorii parametri:

n Dimensiune placă

n Tip de placă

n Mod de scanare

n Un fluorofor (colorant)

n Un tip de probă

Selectarea dimensiunii și tipului plăcii

Important: Trebuie să selectați o dimensiune de placă în timpul configurării plăcii. Nu puteți
modifica dimensiunea plăcii în timpul sau după o rulare.

Software-ul aplică dimensiunea și tipul plăcii tuturor alveolelor în timpul rulării. Asigurați-vă că
dimensiunea de placă selectată este aceeași cu cea a plăcii pe care o veți utiliza în rulare.

Instrumentele Bio-Rad CFX96 și CFX96 DeepWell sunt calibrate din fabrică pentru multe combinații
de colorant fluorescent și placă. Calibrarea este specifică instrumentului, colorantului și tipului de
placă. Asigurați-vă că fluoroforul pe care intenționați să îl utilizați este calibrat pentru tipul de placă
selectat.

Selectarea modului de scanare

Sistemele CFX96 și CFX96 DeepWell stimulează și detectează fluoroforii din cinci canale. Toate
sistemele folosesc moduri multiple de scanare a datelor obținute, pentru a colecta date privind
fluorescența din timpul unei rulări.

CFX Manager Dx software oferă trei moduri de scanare:

n Toate canalele

o Scanează canalele de la 1 la 5 de pe sistemele CFX96 și CFX96 DeepWell
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n SYBR® /FAM

o Scanează doar canalul 1

o Oferă o scanare rapidă

n FRET

o Scanează doar canalul FRET

o Oferă o scanare rapidă

Selectarea fluoroforilor

Important: Înainte de a iniția o rulare, CFX Manager Dx software verifică dacă fluoroforii pe care
i-ați specificat în placă sunt calibrați pe instrumentul respectiv. Nu puteți rula o placă dacă include
fluorofori care nu au fost calibrați pe instrumentul respectiv.

Trebuie să încărcați cel puțin un fluorofor în structura plăcii înainte de rulare. Puteți adăuga câți
fluorofori sunt necesari în acest moment, însă placa trebuie să conțină cel puțin un fluorofor.
Fluoroforii selectați apar ca opțiuni pentru țintele din Target Names (Denumiri ținte).

Puteți folosi caseta de dialog Select Fluorophores (Selectare fluorofori) pentru a încărca fluorofori (sau
coloranți placă) în comenzile de încărcare a alveolelor din Plate Editor (Editor placă). Fluoroforii care
apar în caseta de dialog Select Fluorophores (Selectare fluorofori) depind de modul de scanare
selectat:

n Toate canalele

Apar toți fluoroforii disponibili.

Sfat: Puteți adăuga oricâți fluorofori trebuie, însă puteți încărca doar un fluorofor per canal în
fiecare alveolă.

n SYBR®/FAM

Vor apărea doar fluoroforii din canalul 1.

n FRET

Va apărea doar fluoroforul din canalul 6.

Sfat: Fluoroforul din canalul 6 FRET apare doar când modul de scanare selectat este FRET.
Nu este disponibil pentru modul de scanare All Channels (Toate canalele).

Observație: Nu puteți adăuga sau îndepărta fluorofori direct din caseta de dialog Select
Fluorophore (Selectare fluorofor). Trebuie să calibrați noii fluorofori pe un instrument utilizând
Calibration Wizard (Expert calibrare). După calibrare, noul fluorofor este adăugat automat pe
această listă.
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Selectarea tipurilor de probe

Important: Trebuie să selectați cel puțin un tip de probă pe care să îl atribuiți alveolelor plăcii
înainte de rulare.

CFX Manager Dx software oferă cinci tipuri de probă:

n Unknown (Necunoscută)

n Standard

n NTC (control fără țintă de amplificare)

n Positive Control (Control pozitiv)

n Negative Control (Control negativ)

n NRT (fără transcriptază inversă)

Atribuiți tipurile de probe alveolelor plăcii.

Configurarea unei plăci noi

Pentru a configura o placă nouă

1. Deschideți o placă nouă în fereastra Plate Editor (Editor placă).

2. Pentru a seta dimensiunea plăcii, selectați Settings > Plate Size (Setări > Dimensiune placă) și
selectați dimensiunea corespunzătoare a plăcii din meniul vertical.

3. Pentru a seta tipul plăcii, selectați Settings > Plate Type (Setări > Tip de placă) și selectați fie BR
White (Alb), fie BR Clear (Transparent) din meniul vertical.

4. Opțional, din meniul Settings (Setări), puteți schimba convenția numerică și unitățile de afișare:

n Pentru a schimba convenția numerică, selectați Settings > Number Convention (Setări >
Convenție numerică) și selectați Scientific Notation (Notație științifică).

Sfat: Scientific Notation (Notație științifică) este selectată implicit. În acest caz,
selectarea Scientific Notation (Notație științifică) anulează selecția implicită și setează
convenția numerică la forma standard.

n Pentru a schimba unitățile de afișare, selectați Settings > Units (Setări > Unități) și selectați o
nouă valoare pentru unitate.

5. Pentru a configura modul de scanare, selectați modul de scanare corespunzător din lista verticală
Scan Mode (Mod de scanare) de pe bara de instrumente a ferestrei Plate Editor (Editor placă).

114 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Crearea unui fișier placă utilizând Plate Editor (Editor placă)

6. Selectați fluoroforii necesari pentru placă:

a. În panoul din dreapta, faceți clic pe Select Fluorophores (Selectare fluorofori).

Va apărea caseta de dialog Select Fluorophores (Selectare fluorofori). Veți vedea fluoroforii
disponibili pentru tipul modului de scanare selectat de dumneavoastră în Pasul 5, de
exemplu:

b. Pentru a selecta un fluorofor, faceți clic pe caseta sa de selectare Selected (Selectat).

Sfat: Pentru a elimina un fluorofor din listă, debifați-i caseta de selectare Selected
(Selectat).

c. Pentru a modifica culoarea afișajului unui fluorofor, faceți clic pe caseta Color (Culoare) a
acestuia.

Observație: Culoarea pe care o selectați reprezintă fluoroforul atât în fereastra Plate
Editor (Editor placă), cât și în graficele Data Analysis (Analiză date).

d. În caseta de dialog Color (Culoare), selectați culoarea dorită sau faceți clic pe Define Custom
Colors (Definire culori personalizate) și creați o nouă culoare care să reprezinte fluoroforul.

e. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog Select
Fluorophores (Selectare fluorofori).

7. Trebuie să selectați cel puțin o alveolă în care să încărcați un tip de probă. Implicit este selectat o
alveolă A1.
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În panoul plăcii, urmați una dintre procedurile următoare:

n Pentru a încărca mai multe alveole adiacente, faceți clic pe o alveolă și trageți-o în alveola
țintă.

n Pentru a încărca mai multe alveole neadiacente, apăsați tasta Control și faceți clic pe fiecare
alveolă.

n Pentru a încărca o întreagă coloană cu același tip de probă, faceți clic pe numărul coloanei.

n Pentru a încărca un întreg rând, faceți clic pe numărul rândului.

n Pentru a încărca întreaga placă, faceți clic pe colțul din stânga sus al plăcii.

De exemplu:

8. Atribuiți un tip de probă godeului sau alveolelor selectate din meniul vertical Sample Type (Tip
probă).

9. Atribuiți cel puțin un fluorofor tuturor alveolelor care conțin un tip de probă. Puteți atribui mai mult
decât un fluorofor unei alveole sau unui grup de alveole.
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Observație: Puteți atribui doar un singur fluorofor per canal. Nu puteți atribui mai mult de un
fluorofor din același canal aceleiași alveole.

Sfat: Puteți asocia o țintă cu fluoroforul sau puteți atribui doar fluoroforul godeului de această
dată și asocia o țintă fluoroforului după ce ați rulat experimentul.

n Pentru a atribui doar un fluorofor alveolelor selectate, în secțiunea Target Names (Denumiri
ținte) din panoul din dreapta bifați caseta de selectare Load (Încărcare) pentru respectivul
fluorofor.

n Pentru a asocia o țintă unui fluorofor, în secțiunea Target Names (Denumiri ținte) selectați o
denumire de țintă din lista verticală pentru respectivul fluorofor. Software-ul selectează
automat caseta de selectare Load (Încărcare) aferentă.

10. Pentru alveolele care conțin un tip de probă Standard, trebuie să încărcați o concentrație. Fiecare
alveolă poate avea o valoare diferită a concentrației. Implicit, CFX Manager Dx software încarcă o
concentrație de 1,00E+06 tuturor alveolelor cu un tip de probă Standard. Puteți modifica valoarea
dacă este necesar.

a. În panoul plăcii, selectați o alveolă sau un grup de alveole Standard.

b. În secțiunea Concentration (Concentrație), faceți clic pe Load (Încărcare) pentru a încărca
valoarea în alveola sau alveolele selectate.

c. (Opțional) Pentru a încărca altă concentrație, tastați noua valoare în caseta de text
Concentration (Concentrație) și apăsați Enter.

d. Realizați acest pas pentru toate alveolele cu tipul de probă Standard.

Sfat: Pentru a încărca aceeași concentrație pentru toate alveolele Standard, asigurați-
vă că <All> (Toate) apare în lista verticală de sub valoarea Concentration
(Concentrație). Pentru a încărca aceeași valoare de concentrație pentru toate alveolele
cu un anumit fluorofor, faceți clic pe lista verticală și selectați fluoroforul.

11. Faceți clic pe OK pentru a salva noua placă.
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Atribuirea de parametri opționali fișierului placă
Fișierul plăcii conține informații despre conținutul fiecărei alveole încărcate cu probă pentru o rulare.
După rulare, CFX Manager Dx software asociază conținutul alveolelor cu datele de fluorescență
colectate în timpul protocolului și aplică analiza corespunzătoare în fereastra Data Analysis (Analiză
date).

În CFX Manager Dx, puteți atribui parametri fiecărei alveole din placă înainte, în timpul sau chiar după
rularea experimentelor. Puteți atribui parametrii unui fișier de placă existent sau unui nou fișier de
placă. Acești parametri includ:

n Target names (Denumiri ținte) – ținta sau țintele de interes (gene sau secvențe) din fiecare
alveolă încărcată.

n Sample Names (Denumiri probe) – identificatorul sau condiția care corespunde probei din
fiecare alveolă încărcată, de exemplu 0 h, 1 h sau 2 h.

Sfat: Denumiri ținte și denumiri probe trebuie să fie identice între alveole, pentru a putea
compara datele din fila Gene Expression (Expresie genică) din fereastra Data Analysis
(Analiză date). Fiecare denumire trebuie să utilizeze același tip de caractere (majuscule sau
minuscule), punctuație și spații. De exemplu, „Actin (Actină)” nu este totuna cu „actin
(actină)”, „2Hr (2H)” nu este totuna cu „2 hr. (2 h.)” și „Mouse 1 (Șoarece 1)” nu este totuna cu
„mouse1 (șoarece1)”. Pentru a asigura consecvența numirii, introduceți denumirile în
secțiunea Libraries (Biblioteci) din User > User Preferences > Plate (Utilizator > Preferințe
utilizator > Placă), disponibilă în fereastra Home (Fereastră de pornire).

n Biological sets (Seturi biologice) – identificatorul sau condiția care corespunde unui set de
alveole.

n Replicates (Replicări) – fiecare alveolă care este utilizată pentru a analiza aceeași combinație
probă-țintă (ținte), adică replicate ale reacțiilor qPCR.

n Dilution series (Serie de diluție) – cantitatea pentru modificarea concentrației tipului de probă
Standard în cadrul unui grup de replicări, pentru a crea datele curbei standard de analizat.

Atribuirea unei ținte alveolelor
Sfat: Puteți atribui același nume de țintă unui singur sau mai multor alveole. Puteți atribui, de
asemenea, mai multe ținte aceleiași alveole.

Pentru a atribui o țintă unei alveole sau unui grup de alveole

1. În Plate Editor (Editor placă), asigurați-vă că godeului sau grupului de alveole i s-a atribuit un tip
de probă.
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Pentru informații despre atribuirea tipurilor de probe, consultați Selectarea tipurilor de probe de la
pagina 114.

2. În panoul plăcii, selectați alveola sau grupul de alveole:

n Pentru a selecta o singură alveolă, faceți clic pe alveolă.

n Pentru a selecta mai multe alveole adiacente, faceți clic pe o alveolă și trageți-o în alveola
țintă.

n Pentru a selecta mai multe alveole neadiacente, apăsați tasta Ctrl și faceți clic pe fiecare
alveolă.

n Pentru a selecta o întreagă coloană cu același tip de probă, faceți clic pe numărul coloanei.

n Pentru a selecta un întreg rând, faceți clic pe numărul de rând aferent.

3. În panoul din dreapta, selectați un nume din lista verticală Target Name (Denumire țintă) pentru
fiecare fluorofor selectat.

4. Repetați Pasul 3 pentru fiecare alveolă sau grup de alveole căruia trebuie să îi atribuiți o țintă.

Sfat: Puteți atribui aceeași denumire sau o denumire diferită de țintă pentru fiecare fluorofor
selectat.

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Pentru a șterge o denumire de țintă

u Pentru a elimina o denumire de țintă din alveolă sau grupul de alveole selectat, debifați-i caseta
de selectare Load (Încărcare).

Important: Eliminarea unei denumiri de țintă dintr-o alveolă îi elimină și fluoroforii asociați.
Procedați cu atenție când eliminați o denumire de țintă dintr-o alveolă.

Pentru a adăuga o denumire de țintă în listă

u Pentru a adăuga o denumire de țintă în lista verticală, urmați una dintre procedurile următoare:

n Tastați un nume din lista verticală Target Names (Denumiri ținte) și apăsați Enter.

Sfat: Numele țintelor pe care le-ați adăugat pe o listă apar în toate celelalte liste de ținte.
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n Faceți clic pe simbolul + verde din dreapta listei verticale, tastați un nume pentru țintă și
apăsați Enter.

n Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente și adăugați
numele în biblioteca Target Names (Denumiri ținte) din fila Plate (Placă).

Important: Denumirile țintelor pe care le adăugați pe lista verticală sunt disponibile doar
pentru placa curentă și doar dacă atribuiți denumirea unei alveole și salvați structura plăcii.
Dacă nu atribuiți numele unei alveole și nu salvați structura plăcii, numele nu este salvat și nu
este disponibil pentru utilizarea ulterioară. Pentru a adăuga permanent o denumire de țintă,
adăugați-o și în biblioteca Target Names (Denumiri ținte) utilizând caseta de dialog User
Preferences (Preferințe utilizator). Numele pe care le adăugați în bibliotecă sunt disponibile
după ce deschideți din nou Plate Editor (Editor placă). Pentru mai multe informații, consultați
Setarea parametrilor de placă impliciți de la pagina 67.

Pentru a șterge o denumire de țintă din listă

1. Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente.

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Plate (Placă).

2. În biblioteca Target Names (Denumiri ținte) din fila Plate (Placă), selectați denumirea pe care
doriți să o ștergeți și apăsați tasta Delete (Ștergere).

3. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Important: Nu puteți șterge denumirile de ținte pe care le-ați salvat împreună cu un fișier
placă. Numele personalizate pe care le adăugați pe lista verticală Target Names (Denumiri
ținte) și nu le folosiți și salvați împreună cu placa sunt eliminate automat din listă. Numele pe
care le ștergeți din biblioteca Target Names (Denumiri ținte) sunt eliminate automat din
software și nu mai sunt disponibile utilizatorilor. Procedați cu atenție când ștergeți denumiri
de ținte.

Atribuirea unei denumiri de probă alveolelor
Observație: Pentru a atribui o denumire probă, trebuie să atribuiți alveolelor selectate cel puțin
un fluorofor. Dacă alveolelor selectate nu li se atribuie un fluorofor, lista verticală Sample Names
(Denumiri probe) este dezactivată. Pentru informații despre atribuirea fluoroforilor, consultați
Atribuirea unei ținte alveolelor de la pagina 118.

Sfat: Puteți atribui o singură denumire probă fiecărei alveole sau fiecărui grup de alveole.
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Pentru a atribui o denumire probă unei alveole sau unui grup de alveole

1. În Plate Editor (Editor placă), asigurați-vă că godeului sau grupului de alveole i s-a atribuit un
fluorofor.

2. În panoul plăcii, selectați alveola sau grupul de alveole.

3. În panoul din dreapta, selectați un nume din lista verticală Sample Names (Denumiri probe).

4. Repetați Pasul 3 pentru fiecare alveolă sau grup de alveole căruia trebuie să îi atribuiți o denumire
probă.

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Pentru a șterge o denumire probă

u Pentru a elimina o denumire probă din alveola sau grupul de alveole selectate, debifați-i caseta
de selectare Load (Încărcare).

Pentru a adăuga o denumire probă în listă

u Pentru a adăuga o denumire probă în lista verticală, urmați una dintre procedurile următoare:

n Tastați un nume din lista verticală Sample Names (Denumiri probe) și apăsați Enter.

n Faceți clic pe simbolul + verde din dreapta listei verticale și tastați un nume pentru probă.

n Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente și adăugați
numele în biblioteca Sample Names (Denumiri probe) din fila Plate (Placă).

Important: Denumirile probelor pe care le adăugați pe lista verticală sunt disponibile doar
pentru placa curentă și doar dacă atribuiți denumirea unei alveole și salvați configurarea
plăcii. Dacă nu atribuiți numele unei alveole și nu salvați structura plăcii, numele nu este
salvat și nu este disponibil pentru utilizarea ulterioară. Pentru a adăuga permanent o
denumire probă, adăugați-o și în biblioteca Sample Names (Denumiri probe) utilizând caseta
de dialog User Preferences (Preferințe utilizator). Numele pe care le adăugați în bibliotecă
sunt disponibile după ce deschideți din nou Plate Editor (Editor placă). Pentru mai multe
informații, consultați Setarea parametrilor de placă impliciți de la pagina 67.
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Pentru a șterge o denumire probă din listă

1. Faceți clic pe User Preferences (Preferințe utilizator) de pe bara de instrumente.

Va apărea caseta de dialog User Preferences (Preferințe utilizator), afișând fila Plate (Placă).

2. În biblioteca Sample Names (Denumiri probe) din fila Plate (Placă), selectați denumirea pe care
doriți să o ștergeți și apăsați tasta Delete (Ștergere).

3. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog User Preferences
(Preferințe utilizator).

Important: Nu puteți șterge denumirile de probe pe care le-ați salvat împreună cu un fișier
placă. Numele personalizate pe care le adăugați pe lista verticală Sample Names (Denumiri
probe) și nu le folosiți și salvați împreună cu placa sunt eliminate automat din lista verticală.
Numele pe care le ștergeți din biblioteca Sample Names (Denumiri probe) sunt eliminate
automat din software și nu mai sunt disponibile utilizatorilor. Procedați cu atenție când
ștergeți denumiri de probe.

Atribuirea de seturi biologice alveolelor
Observație: Pentru a atribui un set biologic, trebuie să atribuiți alveolelor selectate cel puțin un
fluorofor. Atribuirea unui fluorofor activează lista verticală Biological Set Name (Nume set
biologic). Pentru informații despre atribuirea fluoroforilor, consultați Atribuirea unei ținte alveolelor
de la pagina 118.

Sfat: Puteți atribui un set biologic fiecărei alveole sau fiecărui grup de alveole.

Pentru a atribui un set biologic unei alveole sau unui grup de alveole

1. În opțiunile View (Vizualizare) din partea de jos a ferestrei Plate Editor (Editor placă), bifați caseta de
selectare Biological Set (Set biologic).

2. În Plate Editor (Editor placă), asigurați-vă că godeului sau grupului de alveole i s-a atribuit un
fluorofor.

3. În panoul plăcii, selectați alveola sau grupul de alveole.

4. În panoul din dreapta, faceți o selecție din lista verticală Biological Set Name (Nume set biologic).

CFX Manager Dx software selectează automat caseta de selectare Load (Încărcare).
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5. Repetați Pasul 4 pentru fiecare alveolă sau grup de alveole căruia trebuie să îi atribuiți un set
biologic.

6. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Sfat: Atribuirea de nume de seturi biologice alveolelor activează Biological Set Analysis
Options (Opțiuni analiză set biologic) în caseta de dialog Experiment Settings (Setări
experimente), în care puteți efectua analiza probei folosind una dintre cele patru configurații.
Pentru mai multe informații, consultați Schimbarea setărilor experimentelor de la pagina 129.

Pentru a elimina un set biologic

u Pentru a elimina un set biologic din alveola sau grupul de alveole selectat, debifați-i caseta de
selectare Load (Încărcare).

Pentru a adăuga un set biologic pe listă

u Pentru a adăuga un set biologic pe lista verticală, tastați un nume în caseta listei
verticaleBiological Set Name (Nume set biologic) și apăsați Enter.

Important: Numele seturilor biologice pe care le adăugați pe lista verticală sunt disponibile
doar pentru placa curentă și doar dacă atribuiți numele unei alveole și salvați structura plăcii.
Dacă nu atribuiți numele unei alveole și nu salvați structura plăcii, numele nu este salvat și nu
este disponibil pentru utilizarea ulterioară.

Pentru a vedea toate seturile biologice de pe placă

u Bifați caseta de selectare Biological Set (Set biologic) din opțiunile View (Vizualizare) din partea
de jos a ferestrei Editor.

Toate alveolele afișează numele setului biologic corespunzător, dacă au unul atribuit. Comanda
Biological Set Name (Nume set biologic) este afișată în panoul din dreapta.

Pentru a ascunde seturile biologice, debifați caseta de selectare Biological Set (Set biologic) din
opțiunile View (Vizualizare).

Atribuirea de cifre replicări alveolelor
Important: Pentru a atribui cifre replicări, alveolele selectate trebuie să aibă conținut identic.
Adică alveolele selectate trebuie să aibă același tip de probă și același fluorofor. Dacă se poate,
trebuie, de asemenea, să le fie atribuite aceleași denumiri de țintă și de probă și același set
biologic. Dacă nu sunt aceleași, CFX Manager Dx software nu activează această opțiune.
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Pentru a atribui cifre replicări unui grup de alveole

1. În Plate Editor (Editor placă), asigurați-vă că conținutul grupului de alveole este identic.

2. În panoul plăcii, selectați grupul de alveole țintă.

3. Pentru a atribui aceleași număr de replicate tuturor alveole selectate, în secțiunea Replicate #
(Nr. replicat) din panoul din dreapta tastați numărul replicatului în casetă și selectați Load
(Încărcare).

4. (Opțional) Pentru a aplica o serie de replicate unui set de alveole selectate:

a. Faceți clic pe Replicate Series (Serie replicări). Secțiunea Replicate # (Nr. replicat) se
modifică, afișând următoarele opțiuni:

n Replicate size (Dimensiunea replicatului) – un număr care reprezintă numărul de
alveole din fiecare grup de replicate

n Starting replicate # (Replicat inițial) – primul număr din seria de replicate pentru
grupul selectat de replicate

Observație: Implicit, CFX Manager Dx software afișează numărul inițial al replicatului
cu o cifră mai mare decât ultimul număr al replicatului atribuit în placă. De exemplu, dacă
ultimul număr de replicat din placă este cinci, următorul număr inițial este șase. Puteți
schimba numărul inițial cu orice număr care nu a fost încă atribuit.

n Direcția de încărcare (orizontală sau verticală)

b. Faceți clic pe Apply (Aplicare) pentru a aplica parametrii seriei și a reveni la afișajul Replicate
# (Nr. replicat).

5. Faceți clic pe OK pentru a accepta modificările și a salva placa.
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Pentru a elimina o alveolă dintr-o serie de replicate

u Selectați alveola sau grupul de alveole pe care doriți să le eliminați și debifați caseta de selectare
Replicate # Load (Încărcare nr. replicat).

Alternativ, puteți face clic pe Clear Replicate # (Ștergere nr. replicat) pentru a șterge numărul
replicatului dintr-o alveolă sau dintr-un grup de alveole selectate.

Atribuirea unei serii de diluție probelor de tip standard
După cum a fost menționat anterior, tuturor alveolelor cu probe de tip Standard trebuie să li se atribuie
o valoare de concentrație. Puteți atribui o serie de diluție mai multor alveole cu probe de tip Standard.

Observație: Pentru a atribui o serie de diluție unui grup de alveole, alveolele trebuie să fie incluse
într-o serie de replicări. Pentru informații despre adăugarea alveolelor la o serie de replicate,
consultați Atribuirea de cifre replicări alveolelor de la pagina 123.

Pentru a atribui o serie de diluție unui grup de alveole cu probe de tip Standard

1. În Plate Editor (Editor placă), asigurați-vă că sunt îndeplinite următoarele cerințe:

n Tipul de probă pentru grupul de alveole este Standard.

n Tuturor alveolelor din grup li s-a atribuit cel puțin un fluorofor și toate conțin aceiași fluorofori.

n Toate alveolele din grup sunt incluse în aceeași serie de replicări.

Observație: CFXManager Dx software permite opțiunea Dilution Series (Serie de
diluție) doar dacă toate alveolele selectate îndeplinesc aceste criterii.

2. În panoul plăcii, selectați grupul de alveole țintă.

3. În secțiunea Concentration (Concentrație) din panoul din dreapta, faceți clic pe Dilution Series
(Serie de diluție). Secțiunea Concentration (Concentrație) se modifică, afișând următoarele
opțiuni:
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n Starting concentration (Concentrația inițială) – valoarea concentrației de la care pornește
seria

n Replicates from and to (Replicatele de la și până la) – replicatele din serie cărora li se va
aplica factorul de diluție

n Dilution factor (Factor de diluție) – cantitatea pentru modificarea concentrației din fiecare
grup de replicate

4. Configurați valorile pentru opțiuni sau acceptați valorile implicite.

5. Implicit, seria de diluție scade cu factorul de diluție. Selectați Increasing (Crescător) pentru a
crește seria de diluție.

6. (Opțional) Implicit, factorul de diluție se aplică tuturor fluoroforilor din seria de replicate. Dacă
seria dumneavoastră conține mai mult de un fluorofor și doriți să aplicați diluția unui singur
fluorofor, selectați-l din lista verticală.

7. Faceți clic pe Apply (Aplicare) pentru a aplica seria de diluție grupului de alveole și pentru a reveni
la vizualizarea Concentration (Concentrație).

8. Faceți clic pe OK pentru a accepta modificările și a salva placa.

Copierea conținutului unei alveole într-o altă alveolă
Puteți copia conținutul unei alveole și-l puteți lipi într-o singură alveolă sau în mai multe alveole. Cu
toate acestea, puteți copia conținutul unei singure alveole. Nu puteți selecta mai multe alveole pentru
ca apoi să le copiați conținutul.

Pentru a copia conținutul unei alveole într-o altă alveolă

1. În panoul plăcii, selectați alveola pe care doriți să o copiați.

2. Faceți clic dreapta pe alveolă și selectați Copy Well (Copiere alveolă).

3. Selectați alveola sau alveolele în care doriți să lipiți conținutul:

n Pentru a selecta o singură alveolă, faceți clic pe alveolă.

n Pentru a selecta mai multe alveole adiacente, faceți clic pe o alveolă și trageți-o în alveola
țintă.

n Pentru a selecta mai multe alveole neadiacente, apăsați tasta Ctrl și faceți clic pe fiecare
alveolă.

4. După ce ați selectat alveolele țintă, faceți clic dreapta și selectați Paste Well (Lipire alveolă).

CFX Manager Dx software lipește conținutul primei alveole în alveolele selectate.
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Adăugarea unei note la o alveolă
Puteți adăuga o notă descriptivă la o alveolă. Puteți vizualiza notele alveolelor în fila Quantification
(Cuantificare) din fereastra Data Analysis (Analiză date).

Pentru a adăuga o notă la o alveolă

1. În panoul plăcii, selectați alveola sau alveolele la care intenționați să adăugați o notă.

2. În secțiunea View (Vizualizare) din panoul de jos, selectați Well Note (Notă alveolă).

ZonaWell Note (Notă alveolă) apare în panoul din dreapta.

3. Scrieți conținutul notei în caseta de text și apăsați Enter.

Textul apare în partea de jos a alveolelor selectate.

Sfat: Dacă ați creat o notă de alveolă anterioară, o puteți selecta din lista verticală și o puteți
aplica alveolelor selectate.
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Golirea alveolelor de tot conținutul
Puteți debifa o alveolă individuală, un grup de alveole sau întreaga placă de tot conținutul. Golirea
alveolelor nu elimină datele de fluorescență colectate în timpul citirii plăcii.

Golirea unei alveole elimină permanent conținutul din alveolă. Procedați cu atenție când debifați
alveolele.

Pentru a debifa alveolele de toate setările

1. În Plate Editor (Editor placă), selectați alveola sau grupul de alveole în panoul plăcii:

n Pentru a selecta o singură alveolă, faceți clic pe alveolă.

n Pentru a selecta mai multe alveole adiacente, faceți clic pe o alveolă și trageți-o în alveola
țintă.

n Pentru a selecta mai multe alveole neadiacente, apăsați tasta Ctrl și faceți clic pe fiecare
alveolă.

n Pentru a selecta o întreagă coloană cu același tip de probă, faceți clic pe numărul coloanei.

n Pentru a selecta un întreg rând, faceți clic pe numărul de rând aferent.

2. În panoul din dreapta, faceți clic pe Clear Wells (Debifare alveole).

CFX Manager Dx software debifează alveolele selectate de toate setările.

3. Faceți clic pe OK pentru a accepta modificările și a salva placa.
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Schimbarea setărilor experimentelor
Utilizați caseta de dialog Experiment Settings (Setări experimente) pentru a vizualiza sau a modifica
lista de ținte sau probe sau pentru a selecta grupul de analiză a expresiei genice și opțiunea de analiză
a faptului de atribuire a seturilor biologice alveolelor din cadrul plăcii.

În caseta de dialog Experiment Settings (Setări experimente), fila Targets (Ținte) afișează o listă a
denumirilor țintelor pentru fiecare reacție PCR, de exemplu gena țintă sau secvențele de gene de
interes.

Fila Samples (Probe) afișează o listă de denumiri de probe care indică sursa țintei, de exemplu o
probă recoltată la 1 oră (1 Hr) sau de la un anumit individ (mouse1 (șoarece1)).

Pentru a schimba setările plăcii utilizând caseta de dialog Experiment Settings (Setări
experimente)

1. Pentru a deschide caseta de dialog Experiment Settings (Setări experimente), urmați una dintre
procedurile următoare:

n În panoul din dreapta al Plate Editor (Editor placă), faceți clic pe Experiment Settings (Setări
experimente).

n În fila Gene Expression (Expresie genică) din fereastra Data Analysis (Analiză date), faceți
clic pe Experiment Settings (Setări experimente).

Apare caseta de dialog Experiment Settings (Setări experimente), care afișează conținutul filei
Targets (Ținte).
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2. Pentru a adăuga o nouă denumire de țintă sau probă, în tipul de filă corespunzător introduceți o
denumire în caseta de text New (Nou) și faceți clic pe Add (Adăugare).

3. Pentru a elimina una sau mai multe denumiri de țintă sau probă din listă, în fila corespunzătoare
bifați caseta de selectare a elementului din coloana Select to Remove (Selectare pentru
eliminare) și faceți clic pe Remove checked item(s) (Eliminare elemente bifate).

4. CFX Manager Dx software exclude tipul de probă NTC (control fără ținta de amplificare) din
analiza expresiei genice.

Pentru a include tipurile de probe NTC, debifați caseta de selectare corespunzătoare din
secțiunea Exclude the following sample types (Excludeți următoarele tipuri de probe). Puteți
alege să excludeți următoarele tipuri de probe selectând caseta de selectare corespunzătoare:

n NRT (fără transcriptază inversă)

n Negative Control (Control negativ)

n Positive Control (Control pozitiv)

n Standard
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5. În fila Targets (Ținte):

a. Pentru a selecta o țintă ca referință pentru analiza datelor expresiei genice, selectați-o în
coloana Reference (Referință).

b. Pentru a ascunde setările de analiză care vor fi aplicate în fila Gene Expression (Expresie
genică) din fereastra Analysis Settings (Setări analiză), debifați Show Analysis Settings
(Afișare setări analiză).

Software-ul ascunde următoarele coloane:

n Color (Culoare)

n Show Chart (Afișare grafic)

n Auto Efficiency (Eficiență automată)

n Efficiency (%) (Eficiență (%))

c. Pentru a schimba culoarea țintei așa cum este reprezentată în graficul Gene Expression
(Expresie genică), faceți clic pe celula corespunzătoare din coloana Color (Culoare),
selectați o culoare nouă în caseta de dialog Color (Culoare) și faceți clic pe OK.

d. Pentru a afișa ținta cu culoarea selectată în graficul Gene Expression (Expresie genică),
bifați-i caseta de selectare în coloana Show Chart (Afișare grafic).

e. Implicit, CFX Manager Dx calculează automat eficiența relativă a țintei, dacă datele acesteia
includ o curbă standard.

Pentru a utiliza o valoare de eficiență determinată anterior, introduceți valoarea în celula
corespunzătoare din coloana Efficiency (%) (Eficiență (%)) și apăsați tasta Enter. CFX
Manager Dx debifează caseta de selectare Auto Efficiency (Eficiență automată).

6. În fila Samples (Probe):

a. Pentru a selecta o probă drept probă de control pentru analiza datelor expresiei genice,
selectați caseta sa de selectare în coloana Control.

b. Pentru a atribui condiția de control unei probe pentru o rulare, faceți clic pe caseta sa de
selectare în coloana Control.

c. Dacă nu este deja selectată, faceți clic pe Show Analysis Settings (Afișare setări analiză)
pentru a vizualiza sau a schimba parametrii de analiză care vor fi aplicați în fila Gene
Expression (Expresie genică). Software-ul ascunde coloanele Color (Culoare) și Show Chart
(Afișare grafic).
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7. Dacă atribuiți unul sau mai multe seturi biologice alveolelor de pe placă (consultați Atribuirea de
seturi biologice alveolelor de la pagina 122), selectați una dintre următoarele opțiuni din lista
Biological Set Analysis Options (Opțiuni analiză set biologic):

n Target vs. Sample (Țintă vs. Probă) – numai denumirea probei din alveolă este utilizată în
calculele expresiei genice.

n Target vs. Biological Set (Țintă vs. Set biologic) – numai denumirea setului biologic este
utilizată în calcule.

n Target vs. Sample_Biological Set (Țintă vs. Probă_Set biologic) – denumirea probei și
denumirea setului biologic se combină pentru a crea un nume unic utilizat în calcule.

n Target vs. Biological Set_Sample (Țintă vs. Set biologic_Probă) – denumirea setului
biologic și denumirea probei se combină pentru a crea un nume unic utilizat în calcule.

8. Faceți clic pe OK pentru a salva parametrii în caseta de dialog Experiment Settings (Setări
experimente) și a reveni la fereastra Plate Editor (Editor placă).

Crearea de grupuri de alveole
Grupurile de alveole împart o placă individuală în subseturi de alveole care pot fi analizate
independent în fereastra Data Analysis (Analiză date). După configurarea grupurilor de alveole,
selectați unul în fereastra Data Analysis (Analiză date) pentru a analiza datele pentru fiecare grup în
mod independent. De exemplu, configurați grupuri de alveole pentru a analiza mai multe rulări de
experimente pe o singură placă sau pentru a analiza fiecare grup de alveole cu o curbă standard
diferită.

Observație: Grupul de alveole implicit este All Wells (Toate alveolele).

Pentru a crea grupuri de alveole

1. Pentru a deschide Well Groups Manager (Manager grupuri de alveole), urmați una dintre
procedurile următoare:

n Pe bara de instrumente Plate Editor (Editor placă), faceți clic pe Well Groups (Grupuri
alveole).

n În fereastra Data Analysis (Analiză date), faceți clic pe ManageWell Groups (Gestionare
grupuri alveole).

Apare caseta de dialog Well Groups Manager (Manager grupuri de alveole).
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2. Faceți clic pe Add (Adăugare) pentru a crea un grup nou. Meniul vertical afișează denumirea
grupului ca Group 1 (Grupul 1) pentru primul grup.

3. Selectați alveolele pentru grupul de alveole din vizualizarea plăcii, făcând clic și deplasând
cursorul peste grupul de alveole. Alveolele selectate apar cu albastru în Manager.

4. (Opțional) Pentru a schimba denumirea grupului, selectați-o din meniul vertical și introduceți o
denumire nouă.

5. (Opțional) Pentru a șterge un grup de alveole, selectați denumirea sa din lista verticală și faceți
clic pe Delete (Ștergere).

6. Faceți clic pe OK pentru a finaliza și a închide fereastra sau faceți clic pe Cancel (Anulare) pentru
a închide fereastra fără a efectua modificări.

Important: Pentru a afișa grupurile de alveole, selectați Well Groups (Grupuri alveole) din
opțiunile View (Vizualizare) din partea de jos a ferestrei Plate Editor (Editor placă).
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Elementele de meniu afișate prin clic dreapta pentru caseta de dialog Well
Groups Manager (Manager grupuri de alveole)

Tabelul 13 listează elementele disponibile în caseta de dialog Well Groups Manager (Manager grupuri
de alveole) atunci când faceți clic dreapta pe orice alveolă.

Element Funcție

Copy (Copiere) Copiază conținutul godeului, care poate fi apoi lipit în alt
alveolă sau alte alveole.

Copy as Image (Copiere ca
imagine)

Copiază vizualizarea selector de alveolă sub formă de
imagine.

Print (Imprimare) Imprimă vizualizarea selector de alveolă.

Print Selection (Imprimare
selecție)

Imprimă doar celulele selectate.

Export to Excel (Exportare în
Excel)

Exportă datele într-o foaie de calcul Excel.

Export to Csv (Exportare în Csv) Exportă datele într-un document cu valori separate prin
virgulă.

Export to Xml (Exportare în Xml) Exportă datele drept document .xml.

Export to Html (Exportare în
Html)

Exportă datele drept document .html.

Tabelul 13. Elementele de meniu afișate prin clic dreapta pentru caseta de dialog
Plate Editor Well Selector (Editor placă Selector alveole)
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Modificarea stilurilor urmelor
În timpul configurării plăcii și în cursul rulării, puteți modifica culoarea și stilul urmelor de amplificare.
Apoi puteți vedea cu ușurință urmele în fereastra de stare în timp real, pe măsură ce datele sunt
colectate.

Pentru a modifica stilurile urmelor

1. Faceți clic pe Trace Styles (Stiluri Urme) în bara de instrumente Plate Editor (Editor placă).

Va apărea caseta de dialog Trace Styles (Stiluri Urme) pentru placa deschisă, de exemplu:

2. Pentru a afișa stilurile urmelor în funcție de un anumit fluorofor, selectați-l din lista verticală
Fluorophores (Fluorofori).

3. Pentru a schimba afișarea urmei:

a. Selectați tipul urmei din lista verticală Wells (Godeuri).

b. Faceți clic pe culoarea acesteia în coloana Color (Culoare).

c. În caseta de dialog Color (Culoare) care apare, selectați o altă culoare pentru urmă și faceți
clic pe OK.

Modificarea tipului de alveolă apare în grila de mai jos.

d. (Opțional) Selectați un simbol pentru urmă din lista verticală Symbols (Simboluri).
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4. Pentru a schimba rapid setul de culori, faceți clic pe opțiunea corespunzătoare din secțiunea
Color Quick Set (Set de culori rapid).

5. Pentru a vedea etichetele godeului în grilă, selectați tipul etichetei în secțiunea Well Labels
(Etichete alveole).

6. Faceți clic pe OK pentru a salva modificările sau pe Cancel (Anulare) pentru a anula modificările.
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Vizualizarea plăcii în format foaie de calcul
Instrumentul Spreadsheet View/Importer (Vizualizare/Importator foaie de calcul) afișează conținutul
unei plăci în format foaie de calcul. Puteți utiliza instrumentul Spreadsheet View/Importer
(Vizualizare/Importator foaie de calcul) pentru a exporta conținutul godeului în format delimitat cu
tabulatoare într-o aplicație precumMicrosoft Excel. Puteți, de asemenea, importa conținut dintr-o
aplicație delimitată cu tabulatoare.

Pentru a utiliza instrumentul Spreadsheet View/Importer (Vizualizare/Importator foaie de
calcul)

1. În bara de instrumente Plate Editor (Editor placă), faceți clic pe Spreadsheet View/Importer
(Vizualizare/Importator foaie de calcul) pentru a deschide caseta de dialog Plate Spreadsheet
View (Vizualizare placă în foaie de calcul).

2. Caseta de dialog Spreadsheet View (Vizualizare în foaie de calcul) afișează conținutul plăcii
pentru un singur fluorofor. Pentru a vizualiza conținutul plăcii pentru alt fluorofor, selectați-l din
lista verticală Fluors List (Listă fluorofori).

3. Faceți clic pe Export Template (Exportare șablon) pentru a export un șablon al foii de calcul a
plăcii într-un format de fișier Excel (format .csv). Puteți edita acest șablon pentru a importa
informațiile despre conținutul godeului.

4. (Opțional) Faceți clic pe Import (Importare) pentru a importa conținutul godeului dintr-un fișier cu
delimitare prin virgule.

5. Pentru a sorta foaia de calcul în funcție de datele dintr-o anumită coloană, faceți clic pe triunghiul
de lângă denumirea coloanei.
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Sfat: Puteți edita conținutul oricărei celule dintr-o coloană care are un asterisc (*) lângă
denumirea coloanei (de exemplu, *Target Name (Denumire țintă)).

Observație: Selectați unitățile pentru datele curbei standard din coloana Quantity (Cantitate)
deschizând Plate Editor (Editor placă) și selectând Settings > Units (Setări > Unități) din bara de
meniu. După ce rularea plăcii este finalizată, datele din aceste standarde apar în graficul
Standard Curve (Curbă standard) din fila Quantification (Cuantificare) din fereastra Data Analysis
(Analiză date) cu unitățile pe care le-ați selectat.

Elemente de meniu afișate prin clic dreapta pentru instrumentul Plate
Spreadsheet View/Importer (Vizualizare/Importator foaie de calcul placă)

Tabelul 14 prezintă elementele de meniu disponibile în instrumentul Spreadsheet View/Importer
(Vizualizator/Importator foaie de calcul) atunci când faceți clic dreapta pe orice alveolă din instrument.

Element Funcție

Copy (Copiere) Copiază toată foaia de calcul.

Copy as Image
(Copiere ca imagine)

Copiază foaia de calcul ca fișier imagine.

Print (Imprimare) Imprimă foaia de calcul.

Print Selection
(Imprimare selecție)

Imprimă doar celulele selectate.

Export to Excel
(Exportare în Excel)

Exportă fișierul într-o foaie de calcul Excel.

Export to Csv
(Exportare în CSV)

Exportă fișierul ca fișier .csv.

Export to Xml
(Exportare în Xml)

Exportă fișierul ca fișier .xml.

Export to Html
(Exportare în Html)

Exportă fișierul ca fișier .html.

Find (Găsire) Caută text specific.

Sort (Sortare) Sortează foaia de calcul selectând până la trei coloane de date în
fereastra Sort (Sortare).

Tabelul 14. Elemente de meniu afișate prin clic dreapta în instrumentul Plate
Spreadsheet View/Importer (Vizualizare/Importator foaie de calcul placă)
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Crearea unei structuri de placă folosind Plate Setup Wizard
(Expert configurare placă)

Puteți utiliza Setup Wizard (Expert configurare) pentru a introduce informațiile privind structura plăcii
care sunt necesare pentru analiza expresiei genice normalizate, inclusiv:

n Denumiri ținte

n Denumiri probe

n Poziția țintelor și probei pe placă

n Genă/gene de referință

n Probă de control

Puteți folosi Setup Wizard (Expert configurare) înainte, în timpul sau după finalizarea unei rulări.

Utilizarea Setup Wizard (Expert configurare) al plăcii
Această secțiune explică modul de creare a unei structuri de placă cu ajutorul Setup Wizard (Expert
configurare). Pentru a vizualiza conținutul fiecărei alveole din placă mai ușor, faceți clic pe Zoom plate
(Mărire placă) din partea de sus a Setup Wizard (Expert configurare).

Important: Revenirea la fila Auto layout (Structură automată) când vă aflați în orice altă filă din
Setup Wizard (Expert configurare) resetează structura plăcii. Procedați cu atenție când selectați
această filă.

Sfat: Puteți reseta structura selectând Tools > Clear Plate (Instrumente > Ștergere placă) în
Setup Wizard (Expert configurare).

Pentru a utiliza Setup Wizard (Expert configurare) al plăcii

1. Deschideți Plate Editor (Editor placă)

2. Pentru a deschide Setup Wizard (Expert configurare),, alegeți Editing Tools (Instrumente de
editare) > Setup Wizard (Expert configurare).

Setup Wizard (Expert configurare) va apărea în fila Auto layout (Structură automată).
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3. În fila Auto layout (Structură automată), urmați procedura următoare:

a. Faceți clic pe o alveolă din grilă și trageți peste și în jos pentru a specifica zona de pe placă în
care doriți să încărcați proba.

b. Introduceți numărul de ținte și probe de încărcat.

Sfat: Numărul de ținte și probe trebuie să fie egal cu numărul de celule selectate. Dacă
numerele introduse nu se potrivesc în zona selectată, modificați numerele sau zona de
selectare a plăcii. Orientarea elementelor de pe placă și gruparea acestora pot fi
specificate.

c. (Opțional) Modificați orientarea plăcii. De exemplu, puteți configura țintele în coloane și
probele în rânduri sau puteți grupa după probe.

d. Faceți clic pe Next (Înainte) pentru a accesa fila Target Names (Denumiri ținte).

Observație: Dacă structura plăcii nu are un model obișnuit, folosiți fila Target Names
(Denumiri ținte) pentru a vă poziționa manual țintele sau fila Sample Names (Denumiri probe)
pentru a vă poziționa manual probele pe placă. Faceți clic și trageți pentru a selecta mai
multe alveole.
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4. În fila Target Names (Denumiri țintă), definiți numele țintei pentru grupurile de ținte:

a. Urmați una dintre procedurile următoare:

n Pentru a redenumi țintele după grup, setați Select by (Selectare după) la Target (Țintă).

n Pentru a redenumi țintele după alveolă, setați Select by (Selectare după) la Well
(Alveolă).

b. Selectați un grup de ținte sau alveole din grilă și tastați un nume în lista verticală Target name
(Denumire țintă).

Sfat: Apăsați Tab pentru a selecta următorul grup sau următorul alveolă din dreapta sau
Enter pentru a selecta următorul grup sau următorul alveolă de dedesubt. Alternativ, în
filele Target name (Denumire țintă) și Sample name (Denumire probă), apăsați tasta
Control și faceți clic pe o alveolă pentru a selecta mai multe alveole care nu sunt
adiacente.

c. Faceți clic pe Next (Înainte) pentru a accesa fila Sample Names (Denumiri probe).

5. În fila Sample Names (Denumiri probe), definiți numele probelor pentru grupurile de probe.

6. Faceți clic pe Next (Înainte) pentru a accesa fila Reference targets (Ținte de referință).

7. În fila Reference targets (Ținte de referință), selectați una sau mai multe ținte pe care să le folosiți
drept referințe pentru expresia genică normalizată și faceți clic pe Next (Înainte) pentru a accesa
fila Control sample (Probă de control).

8. În fila Control sample (Probă de control), selectați o probă de utilizat ca și control în calculele
expresiei genice relative.

9. Faceți clic pe OK pentru a salva structura plăcii și a reveni la fila Plate Editor (Editor placă), în care
puteți defini alți parametri de placă. Pentru mai multe informații, consultați Atribuirea de parametri
opționali fișierului placă de la pagina 118.

Alternativ, faceți clic pe Previous (Înapoi) pentru a reveni la o filă anterioară și a efectua orice
modificări.

Observație: Revenirea la fila Auto layout (Structură automată) resetează automat placa.
Procedați cu atenție când faceți clic pe Previous (Înapoi).
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Capitolul 8 Rularea de experimente
Acest capitol vă explică cum să rulați experimente de testare personalizate (definite de utilizator) sau
PrimePCR folosind CFX Manager Dx software.

Un fișier de date de rulare conține informațiile despre protocol și placă pentru rularea respectivă.
Fișierul conține și datele obținute în urma analizelor realizate de CFX Manager Dx după finalizarea
rulării.

CFX Manager Dx software facilitează configurarea și rularea experimentelor definite de utilizator sau
PrimePCR. Fereastra Run Setup (Configurare rulare) vă ghidează prin pașii comuni de configurare a
unui experiment, ducându-vă la caseta de dialog Start Run (Începere rulare), din care puteți iniția
rularea.

Accesarea ferestrei Run Setup (Configurare rulare)
Pentru a accesa fereastra Run Setup (Configurare rulare)

u Urmați una dintre procedurile următoare:

n În fila Run Setup (Configurare rulare) din Startup Wizard (Expert pornire), faceți clic fie pe
User-defined (Definită de utilizator), fie pe PrimePCR.

n În fereastra Home (Fereastră de pornire), faceți clic fie pe User-defined Run Setup
(Configurare rulare definită de utilizator), fie pe PrimePCR Run Setup (Configurare rulare
PrimePCR) de pe bara de instrumente.

n În fereastra Home (Fereastră de pornire), selectați fie Run > User-defined Run (Rulare >
Rulare definită de utilizator), fie Run (Rulare) > PrimePCR Run (Rulare PrimePCR).
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Fereastra Run Setup (Configurare rulare)
Fereastra Run Setup (Configurare rulare) oferă acces rapid la fișierele și setările necesare pentru
configurarea și desfășurarea unui experiment. Când optați să rulați un experiment definit de utilizator,
fereastra Run Setup (Configurare rulare) se deschide, afișând fila Protocol. Când optați să rulați un
experiment PrimePCR, fereastra Run Setup (Configurare rulare) se deschide, afișând fila Start Run
(Începere rulare).

Sfat: Consultați Efectuarea de experimente PrimePCR de la pagina 161 pentru informații privind
PrimePCR; consultați Fila Start Run (Începere rulare) de la pagina 151 pentru informații privind
fila Start Run (Începere rulare).

1. Filele vă ghidează prin configurarea și rularea unui experiment:

n Fila Protocol – selectați un protocol existent pentru rulare sau editare sau
pentru a crea un protocol nou în Protocol Editor (Editor Protocol).

n Fila Plate (Placă) – selectați o placă existentă pentru rulare sau editare sau
pentru a crea o placă nouă în Plate Editor (Editor placă).

n Fila Start Run (Începere rulare) – vizualizați setările experimentului, selectați
unul sau mai multe blocuri de instrumente și începeți rularea.

2. Fereastra principală afișează opțiunile pentru fiecare filă pe măsură ce le aplicați.

3. Butoanele de navigare vă duc la fila Start Run (Începere rulare).

LEGENDĂ
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Fila Protocol
Fila Protocol afișează o previzualizare a fișierului de protocol pe care intenționați să-l rulați. Un fișier
de protocol conține instrucțiunile pentru pașii de temperatură ai instrumentului, precum și opțiunile
instrumentului care controlează viteza de creștere, volumul probei și temperatura capacului.

Implicit, software-ul afișează protocolul definit în secțiunea File Selection for Run Setup (Selectare
fișier pentru configurarea rulării) din fila Files (Fișiere) în caseta de dialog User > User Preferences
(Utilizator > Preferințe utilizator). Puteți modifica protocolul implicit în caseta de dialog User
Preferences (Preferințe utilizator). Pentru mai multe informații, consultați Schimbarea setărilor
implicite ale fișierelor de la pagina 64.

În fila Protocol, puteți:

n Crea un nou protocol de rulat

n Selecta un protocol existent pentru a-l rula sau edita

Pentru mai multe informații despre crearea și modificarea protocoalelor, consultați Capitolul 6,
Crearea de protocoale.
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Pentru a crea un nou protocol

1. În fila Protocol, faceți clic pe Create New (Creare nou).

Va apărea fereastra Protocol Editor (Editor Protocol).

2. Utilizați Protocol Editor (Editor Protocol) pentru a crea un nou protocol.

3. Faceți clic pe OK pentru a salva protocolul și a reveni la fila Protocol din Run Setup (Configurare
rulare).

4. Vizualizați detaliile protocolului și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Înainte) pentru a accesa fila Plate (Placă).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectat) pentru a reveni la
fereastra Protocol Editor (Editor Protocol). Revizuiți protocolul, salvați modificările, apoi faceți
clic pe Next (Înainte) din fila Protocol pentru a accesa fila Plate (Placă).

Pentru a selecta un protocol existent

1. În fila Protocol, urmați una dintre procedurile următoare:

n Faceți clic pe Select Existing (Selectare existent) pentru a naviga la un protocol existent.

n Faceți clic pe Express Load (Încărcare expresă) și selectați un protocol din lista verticală a
protocoalelor.

Sfat: Puteți adăuga sau elimina protocoale din lista verticală Express Load (Încărcare
expresă). Pentru mai multe informații, consultați Adăugarea și ștergerea protocoalelor
cu încărcare expresă.

2. Vizualizați detaliile protocolului și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Înainte) pentru a accesa fila Plate (Placă).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectat) pentru a deschide
fereastra Protocol Editor (Editor Protocol). Revizuiți protocolul, salvați modificările, apoi faceți
clic pe Next (Înainte) din fila Protocol pentru a accesa fila Plate (Placă).
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Adăugarea și ștergerea protocoalelor cu încărcare expresă

Puteți modifica conținutul listei verticale Express Load (Încărcare expresă) care apare în Protocol
Editor (Editor Protocol). Protocoalele din această listă sunt salvate în următorul folder:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Pentru a modifica lista de protocoale Express Load (Încărcare expresă)

1. Navigați la și deschideți folderul ExpressLoad (Încărcare expresă).

2. Verificați fișierele de protocol (.pcrl) din folder.

3. Urmați una dintre procedurile următoare:

n Ștergeți protocoalele din folder pentru a le îndepărta din lista verticală.

n Copiați protocoalele în folder pentru a le adăuga în lista verticală.
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Fila Plate (Placă)
Observație: Dacă protocolul selectat în fila Protocol nu include un pas de citire placă pentru
analiza PCR în timp real, fila Plate (Placă) este ascunsă. Pentru a vizualiza fila Plate (Placă),
adăugați cel puțin o citire de placă la protocol.

Fila Plate (Placă) afișează o previzualizare a fișierului de placă pe care doriți să îl încărcați. Într-o
rulare PCR în timp real, fișierul de placă conține o descriere a conținutului fiecărei alveole, incluzând
fluoroforii acestora, modul de scanare și tipul de placă. CFX Manager Dx software utilizează aceste
descrieri pentru colectarea și analiza datelor.

Implicit, software-ul afișează placa definită în secțiunea File Selection for Run Setup (Selectare fișier
pentru configurarea rulării) din fila Files (Fișiere) din caseta de dialog User > User Preferences
(Utilizator > Preferințe utilizator). Puteți modifica placa implicită în caseta de dialog User Preferences
(Preferințe utilizator). Pentru mai multe informații, consultați Schimbarea setărilor implicite ale
fișierelor de la pagina 64.

În fila Plate (Placă), puteți:

n Creați o placă nouă pentru încărcare.

n Selectați o placă existentă pentru încărcare sau editare.
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Pentru mai multe informații privind crearea și modificarea plăcilor, consultați Capitolul 7, Pregătirea
plăcilor.

Pentru a crea o placă nouă

1. Pe fila Plate (Placă), faceți clic pe Create New (Creare nou).

Apare Plate Editor (Editor placă).

2. Utilizați Plate Editor (Editor placă)pentru a crea o placă nouă.

3. Faceți clic pe OK pentru a salva placa și a reveni la fila Plate (Placă) din Run Setup (Configurare
rulare).

4. Vizualizați detaliile plăcii și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Înainte) pentru a accesa fila Start Run
(Începere rulare).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectate) pentru a reveni la
fereastra Plate Editor (Editor placă). Revizuiți fișierul de placă, salvați modificările, apoi
faceți clic pe Next (Înainte) pentru a accesa fila Plate (Placă) pentru a continua la fila Start
Run (Începere rulare).

Pentru a selecta un fișier de placă existent

1. În fila Plate (Placă), urmați una dintre procedurile următoare:

n Faceți clic pe Select Existing (Selectare existent) pentru a naviga la un fișier de placă
existent.

n Faceți clic pe Express Load (Încărcare expresă) și selectați un fișier de placă din lista
verticală.

Sfat: Puteți adăuga sau elimina plăci din lista verticală Express Load (Încărcare
expresă). Pentru mai multe informații, consultați Adăugarea și ștergerea fișierelor placă
cu încărcare expresă.

2. Vizualizați detaliile plăcii și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Next (Înainte) pentru a accesa fila Start Run
(Începere rulare).

n Dacă detaliile sunt incorecte, faceți clic pe Edit Selected (Editare selectat) pentru a deschide
fereastra Plate Editor (Editor placă). Revizuiți fișierul de placă, salvați modificările, apoi faceți
clic pe Next (Înainte) pentru a accesa fila Start Run (Începere rulare).
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Adăugarea și ștergerea fișierelor placă cu încărcare expresă

Puteți modifica conținutul listei verticale Express Load (Încărcare expresă) care apare în Plate Editor
(Editor placă). Plăcile care apar în această listă sunt salvate în următorul folder:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Pentru a modifica lista de fișiere de placă Express Load (Încărcare expresă)

1. Navigați la și deschideți folderul ExpressLoad (Încărcare expresă).

2. Verificați fișierele de placă (.pltd) din folder.

3. Urmați una dintre procedurile următoare:

n Ștergeți fișierele de placă din folder pentru a le îndepărta din lista verticală.

n Copiați fișierele de placă din folder pentru a le adăuga în lista verticală.

150 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Fila Start Run (Începere rulare)

Fila Start Run (Începere rulare)
Fila Start Run (Începere rulare) afișează informații despre experimentul care urmează a fi rulat.
Aceasta afișează, de asemenea, blocul sau blocurile instrumentului conectat pe care puteți rula
experimentul.

Utilizând fila Start Run (Începere rulare), puteți face următoarele lucruri:

n Vizualiza informații detaliate despre rulare, inclusiv fișierul de protocol selectat, fișierul placă și
modul de scanare.

n Adăuga observații despre rulare.

n Vizualiza detalii despre toate instrumentele conectate, inclusiv starea lor de rulare (în funcțiune
sau inactiv), volumul probei în µl, temperatura capacului, modul de emulare și nr. de identificare
sau codul de bare, dacă sunt disponibile.

Observație: Puteți modifica coloanele care apar în tabelul Start Run on Selected Blocks
(Începere rulare pe blocurile selectate). Pentru detalii, consultați Modificarea detaliilor din
tabelul Selected Blocks (Blocuri selectate) de la pagina 152.

n Selectați blocul sau blocurile pe care doriți să realizați rularea.

n Deschideți sau închideți de la distanță capacul fiecărui instrument selectat.

n Porniți rularea.
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Modificarea detaliilor din tabelul Selected Blocks (Blocuri selectate)

Puteți modifica coloanele care apar în tabelulStart Run on Selected Block(s) (Începere rulare pe
blocurile selectate). Puteți, de asemenea, modifica valorile implicite pentru volumul probei și
temperatura capacului în tabel. Schimbările setărilor sunt aplicate asupra rulării de efectuat.

Pentru a adăuga coloane în tabelul Start Run on Selected Blocks (Începere rulare pe
blocurile selectate)

u Faceți clic dreapta pe tabel și selectați o opțiune în meniul care apare.

Pentru a elimina coloane din tabelul Start Run on Selected Blocks (Începere rulare pe
blocurile selectate)

u Faceți clic dreapta pe tabel și ștergeți opțiunea din meniul care apare.

Pentru a edita valorile pentru volumul probei sau temperatura capacului pentru un bloc

u Selectați celula pentru volumul probei sau temperatura capacului pentru blocul țintă și introduceți
o valoare nouă în celulă.

Pentru a adăuga un ID de rulare sau un cod de bare pentru un bloc

u Selectați celula ID/Bar Code (ID/Cod de bare) pentru blocul țintă și introduceți un ID sau scanați
blocul cu un cititor de cod de bare.

Rularea unui experiment
Important: Înainte de a rula un experiment, asigurați-vă că software-ul anti-virus al computerului
dumneavoastră nu va iniția o scanare în timpul rulării.

Pentru a rula un experiment

1. În fila Start Run (Începere rulare), verificați detaliile despre placă și protocol în secțiunea Run
Information (Informații rulare).

2. (Opțional) Adăugați observații despre rulare sau experiment în caseta de text Notes (Observații).

3. Bifați caseta de selectare a blocului sau blocurilor pe care doriți să realizați rularea.

Sfat: Pentru a rula experimentul pe toate blocurile, selectați Select All Blocks (Selectare
toate blocurile) de sub tabelul Selected Blocks (Blocuri selectate).
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Fila Start Run (Începere rulare)

4. (Opțional) Faceți clic pe Flash Block Indicator (Indicator lumină intermitentă bloc) pentru a face să
lumineze indicatorul LED de pe blocurile selectate ale instrumentului.

5. Introduceți plăcile experimentului în bloc:

a. Faceți clic pe Open Lid (Deschidere capac). Se va deschide capacul motorizat al fiecărui bloc
selectat.

b. Introduceți un bloc de experiment în fiecare bloc selectat.

c. Faceți clic pe Close Lid (Închidere capac)).

Sfat: Pentru a deschide și închide capacul, puteți, de asemenea, apăsa butonul de pe partea
frontală a fiecărui bloc.

6. Faceți clic pe Open Lid (Deschidere capac) și Close Lid (Închidere capac) pentru a deschide și
închide capacul motorizat al fiecărui bloc selectat pentru instrument.

7. Vizualizați detaliile rulării și urmați una dintre procedurile următoare:

n Dacă detaliile sunt corecte, faceți clic pe Start Run (Începere rulare).

n Dacă detaliile sunt incorecte:

o Corectați detaliile în tabelul Selected Blocks (Blocuri selectate) și faceți clic pe Start Run
(Începere rulare).

o Reveniți la fila corectă și efectuați modificările adecvate, salvați modificările, apoi faceți
clic pe Next (Înainte) pentru a reveni la fila Start Run (Începere rulare) și a iniția rularea.

Pentru a iniția o nouă rulare dintr-o rulare anterioară

u Urmați una dintre procedurile următoare:

n Selectați File > Repeat a Run (Fișier > Repetare rulare) din bara meniului principal al
software-ului; navigați la și faceți dublu clic pe fișierul de date al rulării pe care doriți să o
repetați.

n Selectați fila Repeat Run (Repetare rulare) din Startup Wizard (Expert pornire) și faceți dublu
clic pe fișierul de date al rulării pe care doriți să o repetați.

Opțional, în fila Repeat Run (Repetare rulare) puteți face clic pe Browse (Navigare) și naviga
la și face dublu clic pe fișierul de date al rulării pe care doriți să o repetați.
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Caseta de dialog Run Details (Detalii rulare)
Când faceți clic pe Start Run (Începere rulare), CFX Manager Dx software vă indică să salvați fișierul
de date (.pcrd), începe rularea și deschide caseta de dialog Run Details (Detalii rulare). Caseta de
dialog Run Details (Detalii rulare) cuprinde trei file de stare:

n Run Status (Stare rulare) – utilizată pentru a vizualiza starea actuală a protocolului, a deschide
sau închide capacul, a pune pe pauză o rulare, a adăuga repetări, a omite pași sau a opri rularea.

n Real-time Status (Stare în timp real) – utilizată pentru a vizualiza datele fluorescenței PCR în
timp real, pe măsură ce sunt colectate.

n Time Status (Stare timp) – utilizată pentru a vizualiza pe întregul ecran cronometrul pentru
numărătoarea inversă pentru protocol.

Aceste file sunt explicate în detaliu în următoarele secțiuni.

Fila Run Status (Stare rulare)
Fila Run Status (Stare rulare) afișează starea actuală a unei rulări în curs de desfășurare. În această
vizualizare puteți, de asemenea, să controlați capacul și să schimbați rularea în curs de desfășurare.
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1. Panoul Run Status (Stare rulare) – afișează progresul actual al protocolului.

2. Soluții de control pentru Run Status (Stare rulare) – vă permit să operați
instrumentul sau să întrerupeți protocolul actual.

3. Panoul Run Information (Informații rulare) – afișează detaliile rulării.

LEGENDĂ

Comenzi Run Status (Stare rulare)

Utilizați comenzile din fila Run Status (Stare rulare) fie pentru a opera instrumentul din software, fie
pentru a modifica o rulare în curs.

Observație: Schimbările aduse protocolului în timpul rulării, precum adăugarea de repetări, nu
modifică fișierul de protocol asociat rulării. Aceste acțiuni sunt înregistrate în Run Log (Jurnal
rulare).

– deschide capacul motorizat al instrumentelor selectate.

Important: Deschiderea capacului în timpul unei rulări pune rularea pe pauză în timpul
pasului curent și ar putea modifica datele.

– închide capacul motorizat al instrumentelor selectate.

– adaugă mai multe repetări la pasul curent GOTO (SaltLa) din protocol. Această opțiune este
disponibilă doar când rulează un pas GOTO (SaltLa).

– omite pasul curent din protocol.

Observație: Dacă omiteți un pas GOTO (SaltLa), software-ul vă cere să confirmați că doriți
să omiteți întreaga bucla GOTO (SaltLa) și să continuați cu următorul pas din protocol.

– face să lumineze intermitent LED-ul de pe instrumentul selectat, pentru a identifica blocurile
selectate.
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– pune protocolul pe pauză.

Observație: Această acțiune este înregistrată în Run Log (Jurnal rulare).

– reia un protocol care a fost pus pe pauză.

– oprește rularea înainte ca protocolul să fie finalizat.

Observație: Oprirea unei rulări înainte ca protocolul să fie finalizat vă poate modifica datele.
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Fila Real-time Status (Stare în timp real)
Fila Real-time Status (Stare în timp real) afișează datele PCR în timp real colectate în fiecare ciclu în
timpul rulării, după primele două citiri ale plăcii.

1. Panoul urme de amplificare – afișează datele de amplificare în timp real din
timpul rulării.

2. Identificator grup de alveole – dacă la configurarea plăcii au fost identificate
grupuri de alveole, utilizatorii pot selecta un anumit grup de alveole pentru a-i
vizualiza urmele, alveolele și informațiile tabelare.

Identificator număr de pas – dacă protocolul colectează date la mai mult de un
pas (de exemplu, în timpul amplificării și curbei de topire), utilizatorii pot selecta
un anumit pas și vizualiza urmele colectate la pasul respectiv.

3. Panoul selectorului de alveole – afișează alveolele active, inactive și goale din
placă.

4. Panoul tabelului de configurare a plăcii – afișează configurarea plăcii în format
tabelar.

LEGENDĂ
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5. Panoul cu detalii despre rulare – afișează starea rulării în timp real, inclusiv:

n Pasul curent

n Repetarea curentă

n Temperatura curentă

n Timpul rămas

n Temperatura probei

n Temperatura capacului

6. Plate Setup (Configurare placă) – deschide caseta de dialog Plate Setup
(Configurare placă), în care utilizatorii pot modifica configurarea curentă a plăcii
în timpul unei rulări.

În fila Real-time Status (Stare în timp real) puteți:

n Afișa sau ascunde urmele în timp real, selectându-le în panoul selectorului de alveole sau în
tabelul de configurare a plăcii.

n Vizualiza o singură urmă sau grupuri de urme selectându-le din meniul vertical al grupurilor de
alveole.

n Edita placa sau înlocui fișierul placă.

n Aplica un fișier PrimePCR la rulare.

Afișarea sau ascunderea urmelor în timp real

Implicit, toate alveolele umplute sunt active și apar în tabelul de configurare a plăcii. Alveolele active
apar cu albastru în panoul selectorului de alveole. Alveolele ascunse apar cu gri deschis, iar alveolele
nefolosite apar cu gri închis în panoul selectorului de alveole.

Puteți ascunde urmele din alveolele active în timpul rulării. CFX Manager Dx continuă să colecteze
date pentru toate alveolele; când ascundeți alveole, datele lor nu apar în tabelul de configurare a
plăcii.

Pentru a ascunde urmele în timp real

u În panoul selectorului de alveole, faceți clic pe alveolele active (albastre) pe care doriți să le
ascundeți.
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Pentru a afișa urmele în timp real

u În panoul selectorului alveole, faceți clic pe alveolele ascunse (gri deschis) pe care doriți să le
afișați.

Pentru mai multe informații despre selectorul de alveole, consultați Selectorul de alveole de la pagina
174.

Editarea configurării plăcii

Pentru a edita configurarea plăcii

u Faceți clic pe Plate Setup (Configurare placă) și apoi selectați View/Edit Plate (Vizualizare
editare/placă).

Apare fereastra Plate Editor (Editor placă) în care puteți edita placa în timp ce rularea este în curs.
Pentru mai multe informații despre editarea plăcilor, consultați Capitolul 7, Pregătirea plăcilor.

Observație: De asemenea, puteți edita stilurile de urme din fereastra Plate Editor (Editor
placă). Modificările apar în graficul urmelor de amplificare din fila Real-time Status (Stare în
timp real).

Înlocuirea unui fișier placă

Sfat: Înlocuirea unui fișier placă este utilă în special dacă inițiați o rulare cu un fișier Quick Plate
(Placă rapidă) din folderul ExpressLoad (Încărcare expresă) .

Pentru a înlocui un fișier placă

u Faceți clic pe Plate Setup (Configurare placă), apoi selectați una dintre următoarele opțiuni:

n Replace Plate file (Înlocuire fișier placă) – selectați noul fișier placă din lista din fereastra de
navigare

n Apply PrimePCR file (Aplicare fișier PrimePCR) – căutați un fișier de rulare din care se va
obține structura plăcii, utilizând Smart search (Căutare inteligentă) sau făcând clic pe Browse
(Răsfoire) pentru a găsi un fișier pe care l-ați descărcat de pe site-ul web Bio-Rad și care nu
se află în folderul PrimePCR

Observație: CFXManager Dx verifică modul de scanare și dimensiunea plăcii pentru fișierul
placă. Acestea trebuie să corespundă cu cele din setările rulării cu care a început rularea.
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Fila Time Status (Stare timp)
Fila Time Status (Stare timp) afișează timpul rămas pentru finalizarea rulării actuale.
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Efectuarea de experimente PrimePCR
Experimentele PrimePCR utilizează teste specifice pentru cale biologică sau afecțiune pe care Bio-
Rad le-a validat și le-a optimizat în laborator umed și care sunt disponibile în următoarele formate:

n Panouri cu placă preconfigurată – plăci care conțin teste care sunt specifice pentru o cale
biologică sau afecțiune; acestea includ soluții de control PrimePCR și gene de referință

n Plăci cu o configurație personalizată – plăci care pot fi configurate într-o structură definită de
utilizator, cu opțiunea de a selecta teste pentru ținte de interes, soluții de control și referințe

n Teste individuale – eprubete care conțin seturi de primeri individuale pentru utilizare în reacții în
timp real

Pentru a reduce timpul de rulare general, puteți elimina pasul de topire din protocol. Bio-Rad vă
recomandă insistent să nu faceți nicio altă modificare unui protocol de rularePrimePCR. Protocolul
implicit este cel care a fost utilizat pentru validarea testului. Orice deviere de la aceasta poate afecta
rezultatele. Schimbările privind protocolul sunt notate în fila Run Information (Informații rulare) pentru
fișierul de date rezultat și în orice rapoarte create.

Pentru a iniția o rulare PrimePCR

u Pentru a iniția o rulare PrimePCR, efectuați oricare dintre următoarele:

n În Startup Wizard (Expert pornire), selectați PrimePCR pe fila Run Setup (Configurare rulare)
și apoi selectați chimia corespunzătoare (SYBER sau sondă).

n Selectați o rulare PrimePCR din lista Recent Runs (Rulări recente) de pe fila Repeat Run
(Repetare rulare) în Startup Wizard (Expert pornire).

n Selectați File > New > PrimePCR Run (Fișier > Nou > Rulare PrimePCR) în fereastra Home
(Fereastră de pornire).

n Selectați File > New > PrimePCR Run File (Fișier > Nou > Fișier Rulare PrimePCR) în
fereastra Home (Fereastră de pornire).

n Trageți și eliberați un fișier de rulare PrimePCR în fereastra Home (Fereastră de pornire).

După ce ați selectat o rulare PrimePCR, fereastra Run Setup (Configurare rulare) se deschide pe fila
Start Run (Începere rulare) cu structura implicită de placă PrimePCR încărcată în funcție de
instrumentul selectat.

Pentru a elimina pasul de topire din protocol

u Pe fila Protocol, ștergeți caseta adiacentă față deInclude Melt Step (Includere pas topire).
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Pentru a importa informații țintă pentru plăci PrimePCR într-o structură de placă

1. Urmați una dintre procedurile următoare:

n În fila Real-time Status (Stare în timp real) din caseta de dialogRun Details (Detalii rulare),
selectați Plate Setup > Apply PrimePCR File (Configurare placă > Aplicare fișier PrimePCR).

n În fereastra Data Analysis (Analiză date), selectați Plate Setup > Apply PrimePCR File
(Configurare placă > Aplicare fișier PrimePCR).

2. În caseta de dialog fișier de rulare PrimePCR, faceți clic pe Browse (Răsfoire) pentru a naviga la
fișierul PrimePCR corespunzător (.csv).

3. Selectați fișierul PrimePCR țintă și faceți clic pe Open (Deschidere).

CFX Manager Dx importă informațiile țintă în structura dvs. de placă.
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(Analiză date)

CFXManager Dx furnizează mai multe metode de a deschide și vizualiza fișierele de date. Puteți:

n Să selectați File > Open > Data File (Fișier > Deschidere > Fișier de date) din fereastra Home
(Fereastră de pornire) și să navigați la fișierul .pcrd țintă.

n Să selectați File > Recent Data Files (Fișier > Fișiere de date recente) din fereastra Home
(Fereastră de pornire) pentru a selecta dintr-o listă cu cele mai recente zece fișiere de date
deschise.

Fereastra Data Analysis (Analiză date)
Fereastra Data Analysis (Analiză date) afișează mai multe file, fiecare filă afișând datele analizate
pentru o anumită metodă de analiză sau informații specifice rulării. Filele apar doar dacă datele
colectate în timpul rulării sunt disponibile pentru tipul respectiv de analiză.

Sfat: Pentru a alege filele care vor fi afișate, selectați-le din meniul vertical View (Vizualizare) din
fereastra Data Analysis (Analiză date). Pentru a reveni la aspectul original al filei, selectați
Settings > Restore Default Window Layout (Setări > Restabilire Aspect fereastră implicit).
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Bara de instrumente de analiză a datelor
Bara de instrumente din fereastra Data Analysis (Analiză date) oferă acces rapid la funcții importante
de analiză a datelor.

Tabelul 15 listează funcțiile butoanelor de pe bara de instrumente.

Buton Denumire Funcție

Plate Setup
(Configurare
placă)

View/Edit (Vizualizare/Editare) placă:
Deschide Plate Editor (Editor placă) pentru a
vizualiza și edita conținutul alveolelor.

Fișier de înlocuire placă: selectează un fișier
placă pentru a înlocui configurarea plăcii.

Fișier pentru aplicarea PrimePCR:
selectează un fișier de rulare care va înlocui
structura plăcii pentru o rulare PrimePCR.

Gestionare grupuri
de alveole

Deschide fereastra Well Groups Manager
(Manager grupuri de alveole) pentru a crea,
edita și șterge grupuri de alveole.

Grup de alveole Selectează numele unui grup de alveole
existent din meniul vertical. Selecția implicită
este All Wells (Toate alveolele). Acest buton
apare doar când sunt create grupuri de
alveole.

Analysis Mode
(Mod Analiză)

Analizează datele fie în modul Fluorophore
(Fluorofor), fie în modul Target (Țintă).

Help (Ajutor) Deschide o copie digitală a acestui manual în
format Acrobat PDF.

Tabelul 15. Bara de instrumente a ferestrei Data Analysis (Analiză date)
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Bara de meniu de analiză a datelor
Tabelul 16 listează elementele barei de meniu din fereastra Data Analysis (Analiză date).

Element de
meniu Comandă Funcție

File (Fișier) Save (Salvare) Salvează fișierul.

Save As (Salvare ca) Salvează fișierul cu o denumire nouă.

Repeat Run (Repetare rulare) Extrage fișierul de protocol și placă din rularea
curentă, pentru a-l rula din nou.

Close (Închidere) Închide fereastra Data Analysis (Analiză date).

View
(Vizualizare)

Run Log (Jurnal rulare) Deschide o fereastră Run Log (Jurnal rulare)
pentru a vizualiza jurnalul rulării fișierului de
date curent.

Quantification, Melt Curve,
Gene Expression, End Point,
Custom Data View, QC, Run
Information (Cuantificare,
Curbă de topire, Expresie
genică, Momentul final,
Vizualizare de date
personalizată, CC, Informații
rulare)

Afișează datele analizate din filele selectate în
fereastra Data Analysis (Analiză date). Trebuie
selectată cel puțin o filă.

Settings (Setări) Cq Determination Mode (Mod
determinare Cq)

Selectați modul Regression (Regresie) sau
Single Threshold (Prag unic) pentru a
determina cum se calculează valorile Cq
pentru fiecare urmă.

Baseline Setting (Setarea
Nivel inițial)

Selectați metoda Baseline Subtraction
(Scădere nivel inițial) pentru grupurile de
alveole selectate.

Analysis Mode (Mod Analiză) Selectați pentru a analiza datele în funcție de
Fluorophore (Fluorofor) sau Target (Țintă).

Tabelul 16. Elementele barei de meniu din fereastra Data Analysis (Analiză date)
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Element de
meniu Comandă Funcție

Cycles to Analyze (Cicluri de
analizat)

Selectați ciclurile care urmează a fi analizate.

Baseline Thresholds (Praguri
nivel inițial)

Deschide fereastra Baseline Thresholds
(Praguri nivel inițial) pentru a ajusta nivelul
inițial sau pragul.

Trace Styles (Stiluri Urme) Deschide fereastra Trace Styles (Stiluri Urme).

Plate Setup (Configurare
placă)

Deschide Plate Editor (Editor placă) pentru a
vizualiza și edita placa; înlocuiți placa curentă
cu una dintr-un fișier placă definit de utilizator
sau un fișier de rulare PrimePCR.

Include All Excluded Wells
(Includeți toate alveolele
excluse)

Include toate alveolele excluse în analiză.

Mouse Highlighting
(Evidențiere cu mouse-ul)

Activează sau dezactivează evidențierea
simultană a datelor cu indicatorul mouse-ului.

Sfat: Dacă Mouse Highlighting
(Evidențiere cu mouse-ul) este
dezactivată, apăsați tasta Control pentru a
activa temporar evidențierea.

Restore Default Window
Layout (Restabilire Aspect
fereastră implicit)

Restabilește aranjarea ferestrei la setările
implicite.

Tabelul 16. Elementele barei de meniu din fereastra Data Analysis (Analiză date), continuare
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Element de
meniu Comandă Funcție

Export
(Exportare)

Export All Data Sheets to
Excel (Exportă toate fișele de
date în Excel)

Exportă toate vizualizările foilor de calcul din
fiecare filă în fișiere Excel individuale.

Custom Export (Exportare
personalizată)

Deschide fereastra Custom Export (Exportare
personalizată) în care pot fi specificate
câmpurile de exportat și formatul fișierului.

Export to LIMS Folder
(Exportare în folderul LIMS)

Deschide o fereastră pentru a salva datele într-
un format predeterminat în folderul LIMS.

Seegene Export (Exportare
Seegene)

Deschide o fereastră pentru a identifica locul
de salvare a datelor din toate foile de calcul în
fișiere Excel structurate special pentru a fi
utilizate de Seegene, Inc.

Tools
(Instrumente)

Reports (Rapoarte) Deschide Raportul pentru acest fișier de date.

Well Group Reports (Rapoarte
pentru grupuri de alveole)

Deschide fereastra Well Group Report
(Rapoarte pentru grupuri de alveole) pentru a
genera rapoarte pentru grupurile de alveole
specificate.

Import Fluorophore Calibration
(Importare calibrare fluorofor)

Selectați un fișier de calibrare de aplicat
fișierului de date curent.

qbase+ Lansează qbase+ v2.5 direct din fișierul .pcrd
curent, dacă este instalat.

Tabelul 16. Elementele barei de meniu din fereastra Data Analysis (Analiză date), continuare

Manual de utilizare | 167



Capitolul 9 Prezentare generală a Data Analysis (Analiză date)

Detalii filă
Fiecare filă din fereastra Data Analysis (Analiză date) afișează datele în grafice și foi de calcul pentru o
anumită metodă de analiză și include un selector de alveolă pentru selectarea datelor pe care doriți să
le afișați. Când se deschide, Data Analysis (Analiză date) afișează implicit fila Quantification
(Cuantificare). Puteți utiliza datele din graficul Amplification (Amplificare) din fila Quantification
(Cuantificare) pentru a determina setările adecvate de analiză pentru rulare.

Observație: Software-ul asociază datele din panourile fiecărei file Data Analysis (Analiză date).
De exemplu, evidențierea unei alveole prin plasarea indicatorului mouse-ului pe alveolă în
vizualizarea selector de alveole evidențiază datele din toate celelalte panouri.
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Selector Step Number (Număr pas)
Sistemele CFX96 și CFX96 DeepWell pot achiziționa date de fluorescență în cadrul mai multor pași
de protocol; software-ul păstrează datele achiziționate separat pentru fiecare pas. Software-ul
afișează selectorul Step Number (Număr pas). Atunci când un protocol conține cel puțin un pas de
colectare a datelor, CFX Manager Dx software afișează datele din primul pas de colectare.

Dacă protocolul conține mai mult de un pas de colectare, puteți selecta un alt pas din lista verticală, de
exemplu:

Când selectați un pas, software-ul aplică acea selecție tuturor datelor afișate în fereastra Data
Analysis (Analiză date).

Vizualizarea grupurilor de alveole în Data Analysis (Analiză date)
Alveolele din placă pot fi grupate în subseturi pentru analiză independentă utilizând grupuri de alveole.
Când creați grupuri de alveole, denumirea grupului apare în fereastra Data Analysis (Analiză date), în
lista verticală Well Groups (Grupuri de alveole) de pe bara de instrumente.

Dacă ați creat grupuri de alveole, software-ul afișează grupul implicit de alveole All Wells (Toate
alveole) atunci când deschideți fereastra Data Analysis (Analiză date), afișând datele din toate
alveolele cu conținut în grafice și foi de calcul. Doar alveolele din grupul de alveole respectiv încărcate
cu conținut apar în selectorul de alveole și doar datele pentru alveolele respective sunt incluse în
calculele analizei datelor.

Observație: Dacă nu ați creat grupuri de alveole, lista verticală Well Groups (Grupuri de alveole)
nu va apărea în bara de instrumente.

Modificarea conținutului alveolelor după o rulare
În timpul analizei datelor, modificarea modului în care sunt afișate datele prin modificarea conținutului
alveolelor în Plate Editor (Editor placă) nu modifică niciodată datele de fluorescență colectate din
fiecare alveolă în timpul rulării. După ce modulul colectează datele de fluorescență, acele date nu pot
fi șterse, dar puteți să le eliminați din vizualizare și din analiză.

Pentru modificarea conținutului alveolelor după o rulare

u În fereastra Data Analysis (Analiză date), faceți clic pe Plate Setup (Configurare placă) și selectați
una dintre următoarele opțiuni:

n Edit/View Plate (Editare/Vizualizare placă) – deschide Plate Editor (Editor placă), unde
puteți face modificări manuale la configurare.
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n Replace Plate file (Înlocuire fișier placă) – deschide browser-ul Select Plate (Selectare
placă), în care puteți naviga la o placă salvată anterior cu care să înlocuiți structura actuală a
plăcii.

n Apply PrimePCR file (Aplicare fișier PrimePCR) – deschide caseta de dialog Select
PrimePCR file (Selectare fișier PrimePCR), în care puteți naviga la un fișier de rulare
PrimePCR, pe care îl puteți aplica structurii plăcii.

Sfat: Puteți adăuga sau edita informații despre conținutul godeului înainte de o rulare, în timpul
sau după o rulare sau după finalizarea unei rulări PCR. Trebuie să atribuiți modul de scanare și
dimensiunea plăcii înainte de rulare. Acești parametri nu pot fi modificați după rulare.
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Setări Analiză date
Datele graficului Amplification (Amplificare) din fila Quantification (Cuantificare) indică fluorescența
relativă (RFU) pentru fiecare alveolă din fiecare ciclu. Fiecare urmă din grafic reprezintă datele de la
un singur fluorofor dintr-o alveolă. Aceste date sunt utilizate pentru determinarea valorilor Cq pentru
fiecare alveolă și fluorofor. Software-ul folosește unul dintre cele două moduri pentru a determina
valorile Cq:

n Regression (Regresie) – aplică un model de regresie neliniar, cu mai multe variabile, urmelor
individuale ale godeului, iar apoi utilizează modelul respectiv pentru a calcula o valoare Cq
optimă.

n Single Threshold (Prag unic) – folosește o singură valoare de prag pentru a calcula valoarea
Cq în funcție de punctul de depășire a pragului urmelor de fluorescență individuale.

Selectați Settings > Cq Determination Mode (Setări > Mod determinare Cq) pentru a alege modul de
determinare al Cq.

Ajustarea pragului
În modul Single Threshold (Prag unic), puteți ajusta pragul pentru un fluorofor făcând clic pe linia de
prag din graficul Amplification (Amplificare) și deplasând indicatorul mouse-ului pe verticală.
Alternativ, puteți specifica un prag exact pentru fluoroforul existent.

Setarea Nivel inițial
Software-ul setează automat nivelul inițial individual pentru fiecare alveolă. Setarea Nivel inițial
determină metoda de scădere a nivelului inițial pentru toate urmele de fluorescență. Software-ul oferă
trei opțiuni de scădere a nivelului inițial:

n No Baseline Subtraction (Fără scădere a nivelului inițial) – afișează datele sub formă de
urme de fluorescență relativă. Anumite analize nu sunt posibile în acest mod de analiză, prin
urmare software-ul nu afișează filele Gene Expression (Expresie genică), End Point (Momentul
final) și Allelic Discrimination (Evidențiere alelică).

n Baseline Subtracted (Nivelul inițial scăzut) – afișează datele sub formă de urme din care s-a
scăzut nivelul inițial pentru fiecare fluorofor dintr-o alveolă. Software-ul trebuie să scadă nivelul
inițial din date pentru a determina ciclurile de cuantificare, construi curbele standard și determina
concentrația probelor necunoscute. Pentru a genera o urmă din care s-a scăzut nivelul inițial,
software-ul integrează cea mai bună linie dreaptă prin fluorescența înregistrată a fiecărei alveole
în timpul ciclurilor inițiale, apoi scade datele cele mai potrivite din datele de fond din care s-a
scăzut nivelul inițial la fiecare ciclu.
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n Baseline Subtracted Curve Fit (Potrivirea curbei din care s-a scăzut nivelul inițial) –
afișează datele drept urme din care s-a scăzut nivelul inițial, iar software-ul ajustează curba din
care s-a scăzut nivelul inițial folosind un filtru de medie centrat. Acest proces este realizat în așa
fel încât fiecare Cq să rămână invariabilă.

Pe lângă aceste opțiuni, puteți selecta și Apply Fluorescent Drift Correction (Aplicare corecție deviație
fluorescență). Pentru alveolele care au valori de deviație RFU anormale în timpul primelor câteva cicluri
ale unei rulări, software-ul derivă un nivel inițial estimat din alveolele adiacente pentru care s-a generat cu
succes un nivel inițial orizontal.

Pentru a schimba setarea scăderii nivelului inițial:

u Selectați Settings > Baseline Setting (Setări > Setarea nivelului de referință).

Analysis Mode (Mod Analiză)
Datele pot fi grupate și analizate fie după fluorofor, fie după denumirea țintei. Atunci când sunt grupate
după fluorofor, urmele de date sunt afișate în funcție de fluorofor, așa cum este indicat de configurația
plăcii pentru rularea respectivă. Datele individuale ale fluoroforului apar în graficul curbei de amplificare
și în graficul curbei standard (dacă este disponibil) atunci când sunt bifate casetele de selectare a
fluoroforului localizate sub graficul de amplificare.

Atunci când sunt grupate după țintă, urmele de date sunt afișate în funcție de denumirea țintei, așa
cum a fost introdusă în configurația plăcii pentru rularea respectivă.
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Pentru a alege un mod de analiză a datelor

u Urmați una dintre procedurile următoare:

n Selectați Settings > Analysis Mode (Setări > Mod Analiză).

n Alegeți un mod din meniul vertical Analysis Mode (Mod Analiză) de pe bara de instrumente.

Cycles to Analyze (Cicluri de analizat)
Puteți restricționa numărul de cicluri de analizat. Puteți, de asemenea, analiza date dintr-un anumit set
de cicluri. Numărul maxim de cicluri pe care le puteți analiza este 50.

Observație: Eliminarea ciclurilor de la începutul unei rulări poate avea un impact semnificativ
asupra valorii inițiale.

Pentru a restricționa analiza datelor la un anumit interval de cicluri

1. Selectați Settings > Cycles to Analyze (Setări > Cicluri de analizat).

Va apărea caseta de dialog Cycles to Analyze (Cicluri de analizat).

2. Introduceți valorile ciclului inițial și final și faceți clic pe OK.

Faceți clic pe Restore Defaults (Restaurare valori implicite) din caseta de dialog Cycles to Analyze
(Cicluri de analizat) pentru a reveni la ciclurile utilizate original pentru analiză.

Manual de utilizare | 173



Capitolul 9 Prezentare generală a Data Analysis (Analiză date)

Selectorul de alveole
Folosiți Selectorul de alveole pentru a afișa sau ascunde datele alveolelor în graficele sau foile de
calcul din fereastra Data Analysis (Analiză date). Doar alveolele încărcate cu probă pot fi selectate în
selectorul de alveole. Software-ul colorează alveolele din Well Selector (Selectorul de alveole):

n Albastru – indică alveolele selectate. Datele din alveolele selectate apar în fereastra Data
Analysis (Analiză date).

n Gri deschis – indică alveolele neselectate. Datele din alveolele neselectate nu apar în fereastra
Data Analysis (Analiză date).

n Gri închis – indică alveolele goale.

Pentru a afișa sau ascunde datele alveolelor

u În selectorul de alveole, urmați oricare dintre procedurile următoare:

n Pentru a ascunde o alveolă, faceți clic pe alveola respectivă. Pentru a afișa alveola
respectivă, faceți clic din nou pe ea.

n Pentru a ascunde mai multe alveole, trageți cu mouse-ul peste alveolele pe care doriți să le
selectați. Pentru a afișa alveolele respective, trageți din nou cu mouse-ul peste alveole.

n Faceți clic pe colțul din stânga sus al plăcii pentru a ascunde toate alveolele. Faceți clic din
nou pe colțul din stânga sus pentru a afișa toate alveolele.

n Faceți clic pe începutul unei coloane sau al unui rând pentru a ascunde alveolele respective.
Faceți clic din nou pe coloană sau pe rând pentru a afișa alveolele.
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Selectorul de alveole

Elementele de meniu afișate prin clic dreapta în Well Selector
(Selector alveole)
Tabelul 17 listează opțiunile afișate prin clic dreapta disponibile în vizualizarea selector de alveolă.

Element Funcție

Well XX (Alveolă XX) Afișează numai această alveolă, elimină această alveolă din
vizualizare, setează culoarea pentru această alveolă sau exclude
această alveolă din analiză.

Selected Wells (Godeuri
selectate) (faceți clic dreapta și
trageți)

Afișează numai aceste alveole, elimină aceste alveole din
vizualizare, setează culoarea pentru aceste alveole sau exclude
aceste alveole din analiză.

Copy (Copiere) Copiază conținutul godeului pe clipboard, inclusiv Sample Type (Tip
probă) și Replicate # (Nr. replică) opțional.

Copy as Image (Copiere ca
imagine)

Copiază vizualizarea selector de alveolă sub formă de imagine.

Print (Imprimare) Imprimă vizualizarea selector de alveolă.

Print Selection (Imprimare
selecție)

Imprimă selecția curentă.

Export to Excel (Exportare în
Excel)

Exportă datele într-o foaie de calcul Excel.

Export to Csv (Exportare în
Csv)

Exportă datele ca document text.

Export to Xml (Exportare în
Xml)

Exportă datele drept document .xml.

Well Labels (Etichete alveole) Schimbă etichetele alveolelor în Sample Type (Tip probă), Target
Name (Denumire țintă) sau Sample Name (Denumire probă).

Tabelul 17. Elementele de meniu afișate prin clic dreapta în selectoarele de alveole
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Excluderea temporară a alveolelor din analiză
Pentru a exclude temporar alveole din analiza datelor

1. Faceți clic dreapta pe alveolă în selectorul de alveole. Pentru a exclude alveole multiple, faceți clic
dreapta și trageți pentru a evidenția mai multe alveolele, urme sau puncte.

2. Din meniul afișat prin clic dreapta, alegeți opțiunea corespunzătoare:

n Well > Exclude Well (Alveolă > Excludere alveolă)

n Selected Wells > Exclude from Analysis (Godeuri selectate > Excludere din analiză)

n Selected Traces > Exclude these wells from Analysis (Urme selectate > Excludere aceste
urme din analiză)

Alternativ, pentru a elimina permanent alveole din analiză, ștergeți conținutul godeului în Plate
Editor (Editor placă), făcând clic pe butonul Clear Wells (Debifare alveole).

Important: Trebuie să reintroduceți orice conținut de alveolă care este debifat.

Pentru a include o alveolă exclusă

u Faceți clic dreapta pe alveola corespunzătoare în selectorul de alveole și selectați Well > Include
Well in Analysis (Alveolă > Includere alveolă în analiză).
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Grafice

Grafice
Fiecare grafic din fereastra Data Analysis (Analiză date) afișează datele într-o reprezentare grafică
diferită și include opțiuni pentru ajustarea și exportarea datelor sau a imaginilor din grafice.

Elementele de meniu comune afișate prin clic dreapta pentru
grafice
Tabelul 18 listează elementele de meniu afișate prin clic dreapta disponibile în grafice. Câteva dintre
elementele disponibile sunt prezente în toate graficele, iar aceste elemente pot fi utilizate pentru a
schimba modul de afișare sau pentru a exporta cu ușurință datele dintr-un grafic.

Element Funcție

Copy (Copiere) Copiază graficul pe clipboard.

Save Image As (Salvați
imaginea ca)

Salvează imaginea la o anumită dimensiune și rezoluție și într-un
anumit tip de fișier. Formatele de imagine disponibile sunt PNG
(implicit), JPG și BMP.

Page Setup (Configurare
pagină)

Previzualizarea și configurarea paginii pentru imprimare.

Print (Imprimare) Imprimă graficul.

Set Scale to Default
(Setare scară la implicit)

Restaurează vizualizarea implicită a graficului după ce acesta a fost
mărit.

Chart Options (Opțiuni
grafic)

Deschide fereastra Chart Options (Opțiuni grafic) pentru a modifica
graficul, incluzând schimbarea titlului, selectarea limitelor pentru axele x
și y, afișarea liniilor grilei și a gradațiilor minore de pe axe.

Tabelul 18. Elementele de meniu afișate prin clic dreapta pentru grafice

Observație: Elementele de meniu aplicabile anumitor grafice sunt descrise în Capitolul 10,
Detalii despre fereastra Data Analysis (Analiză date).
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Copierea datelor din grafic pe clipboard
Puteți copia conținutul din vizualizarea graficului și lipi acest conținut în orice aplicație care acceptă
fișiere imagine bitmap.

Pentru a copia date din grafic pe clipboard

1. Din meniul clic dreapta al graficului, selectați Copy (Copiere).

2. Deschideți o aplicație care acceptă imagini bitmap, de exemplu Microsoft Word.

3. Faceți clic dreapta și selectați Paste (Lipire) pentru a lipi imaginea bitmap din clipboard în
aplicație.

Modificarea setărilor de prag pentru nivelul inițial
În modul Single Threshold (Prag unic), puteți ajusta pragul pentru un fluorofor făcând clic pe linia de
prag din graficul Amplification (Amplificare) și deplasând indicatorul mouse-ului pe verticală.
Alternativ, puteți specifica un prag exact pentru fluoroforul existent.

Sfat: Puteți specifica un interval de cicluri pentru a determina nivelul inițial pentru toate fișierele
de date din fila Data Analysis (Analiză date) din User > User Preferences (Utilizator > Preferințe
utilizator).
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Pentru a ajusta ciclul inițial pentru început și sfârșit pentru fiecare alveolă

1. În fila Quantification (Cuantificare), selectați un singur fluorofor de sub graficul Amplification
(Amplificare).

2. Din meniul clic dreapta al graficului, selectați Baseline Threshold (Prag nivel inițial).

Apare caseta de dialog Baseline Threshold (Prag nivel inițial).

3. În secțiunea Baseline Cycles (Cicluri nivel inițial), urmați una dintre procedurile următoare:

n Pentru a selecta o alveolă, faceți clic pe numărul de rând al acesteia.

n Pentru a selecta mai multe alveole adiacente, faceți clic pe numărul de rând al primei alveole
și deplasați cursorul în jos de-a lungul coloanei până la ultima alveolă.

n Pentru a selecta mai multe alveole neadiacente, apăsați tasta Ctrl și faceți clic pe numărul de
rând al fiecărei alveole țintă.

n Pentru a selecta toate alveolele, faceți clic în colțul din stânga sus al tabelului.

4. Ajustați ciclul inițial pentru început și ciclul inițial pentru sfârșit pentru toate alveolele selectate sau
modificați numărul ciclurilor de început și de sfârșit în partea de jos a foii de calcul.
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Capitolul 9 Prezentare generală a Data Analysis (Analiză date)

Sfat: Pentru a readuce setările la ultimele valori salvate, faceți clic pe Reset All User Defined
Values (Resetare toate valorile definite de utilizator).

5. Faceți clic pe OK pentru a salva modificările și a reveni la grafic.

Pentru a specifica un interval de cicluri pentru toate fișierele de date

u Din fereastra Home (Fereastră de pornire) sau fereastra Plate Editor (Editor placă), selectați User
(Utilizator) > User Preferences (Preferințe utilizator) și alegeți fila Data Analysis (Analiză date).

Sortarea datelor țintei și probei
Observație: Această opțiune este disponibilă numai în graficele de expresie genică.

Implicit, lista Targets and Samples (Ținte și probe) apare în ordine alfabetică. Utilizați caseta de dialog
Sort (Sortare) pentru a sorta afișajul în ordine alfabetică inversă sau pentru a muta manual un termen
în altă poziție din listă.

Pentru a sorta datele țintei și probei

1. Din meniul clic dreapta al graficului, faceți clic pe Sort (Sortare).

Va apărea caseta de dialog Gene Expression Chart Sorting (Sortare grafic expresie genică).

2. În caseta de dialog, faceți clic pe Z-A pentru a sorta lista în ordine alfabetică inversă.

3. Pentru a muta manual un termen, selectați-l și faceți clic pe butonul corespunzător dintre grafice:

n Faceți clic pe săgeata În sus sau În jos pentru a muta termenul selectat cu o poziție.

n Faceți clic pe săgeata bară În sus sau În jos pentru a muta termenul selectat în partea de sus
sau de jos a listei.

4. Faceți clic pe OK pentru a salva modificările și a reveni la fila Gene Expression (Expresie genică).

180 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Grafice

Mărirea unei zone a graficului
Pentru a mări o zonă a graficului

u Faceți clic și deplasați mouse-ul deasupra graficului, apoi faceți clic pe Zoom (Mărire)*. Software-
ul redimensionează graficul și îl centrează asupra zonei selectate.

Observație: * Pentru graficul cu bare, nu este necesar să faceți clic pe comanda pop-up
Zoom (Mărire).

Pentru a reseta graficul la vizualizarea completă

u Faceți clic dreapta în grafic și selectați Set Scale to Default (Setare scară la implicit).

Copierea graficelor într-un fișier Microsoft
Puteți copia grafice de date în documente Microsoft Word, Excel sau PowerPoint. Rezoluția imaginii
corespunde cu cea a ecranului din care a fost obținută imaginea

Pentru a copia grafice într-un fișier Microsoft

1. În fereastra Data Analysis (Analiză date), selectați Copy (Copiere) din meniul clic dreapta al
graficului.

2. Deschideți un fișier Microsoft gol și lipiți conținutul din clipboard.

Alternativ: Faceți clic pe pictograma „clic și glisare” și trageți și fixați graficul într-un fișier
Microsoft.

Manual de utilizare | 181



Capitolul 9 Prezentare generală a Data Analysis (Analiză date)

Foi de calcul
Foile de calcul afișate în Data Analysis (Analiză date) includ opțiuni pentru sortarea și transferarea
datelor. Sortați coloanele folosind una dintre aceste metode:

n Faceți clic pe și trageți o coloană într-o nouă locație din tabelul selectat.

n Faceți clic pe antetul coloanei pentru a sorta datele în ordine ascendentă sau descendentă.

Pentru a sorta până la trei coloane de date din fereastra Sort (Sortare)

1. Faceți clic dreapta în foaia de calcul și selectați Sort (Sortare).

2. În caseta de dialog Sort (Sortare), selectați titlul primei coloane pe care doriți să o sortați. Sortați
datele în ordine ascendentă sau descendentă.

3. Selectați a doua sau a treia coloană pe care doriți să o sortați și alegeți Ascending (Ascendent)
sau Descending (Descendent).

4. Faceți clic pe OK pentru a sorta datele sau clic pe Cancel (Anulare) pentru a opri sortarea.

Evidențiați datele din graficele asociate și selectorul de alveole ținând indicatorul mouse-ului pe o
celulă. Faceți clic într-o celulă pentru a copia și lipi conținutul acesteia în alt program software.

Elementele de meniu comune afișate prin clic dreapta pentru
foile de calcul
Tabelul 19 listează elementele de meniu afișate prin clic dreapta disponibile în orice vizualizare a foii
de calcul.

Element Funcție

Copy (Copiere) Copiază conținutul alveolelor selectate pe clipboard, apoi lipește
conținutul într-o foaie de calcul precum un document Excel.

Copy as Image (Copiere ca
imagine)

Copiază vizualizarea foii de calcul sub formă de fișier imagine și o
lipește într-un fișier care acceptă un fișier imagine, precum fișierele
text, imagine sau foaie de calcul.

Print (Imprimare) Imprimă vizualizarea curentă.

Print Selection (Imprimare
selecție)

Imprimă selecția curentă.

Tabelul 19. Elementele de meniu afișate prin clic dreapta pentru foile de calcul
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Element Funcție

Export to Excel (Exportare în
Excel)

Exportă datele într-o foaie de calcul Excel.

Export to Csv (Exportare în
CSV)

Exportă datele într-un fișier (.csv) cu valori separate prin virgulă.

Export to Xml (Exportare în Xml) Exportă datele într-un fișier Xml.

Export to Html (Exportare în
Html)

Exportă datele într-un fișier Html.

Find (Găsire) Caută text.

Sort (Sortare) Sortează datele din până la trei coloane.

Select Columns (Selectare
coloane)

Selectează coloanele care vor fi afișate în foaia de calcul.

Tabelul 19. Elementele de meniu afișate prin clic dreapta pentru foile de calcul, continuare
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Export (Exportare)
CFXManager Dx software oferă patru opțiuni de exportare din meniul vertical Export (Exportare):

n Export All Data Sheets (Exportă toate fișele de date)

n Custom Export (Exportare personalizată)

n Export to LIMS (Exportare în LIMS)

n Seegene Export (Exportare Seegene)

Exportarea tuturor fișelor de date
Puteți exporta toate vizualizările foilor de calcul din fiecare filă a CFX Manager Dx software în fișiere
individuale.

Pentru a exporta toate fișele de date

u Selectați Export > Export All Data Sheets (Exportare > Exportă toate fișele de date).

n CSV (*.csv)

n Text (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Export (Exportare)

Crearea unui fișier de exportare particularizată
Pentru a crea un fișier de exportare particularizată

1. Selectați Export > Custom Export (Exportare > Exportare particularizată). Apare caseta de dialog
Custom Export (Exportare particularizată).

2. Selectați formatul de exportare din lista verticală care apare.

3. Bifați casetele de selectare pentru elementele de exportat.

4. (Opțional) Faceți clic pe Customize Column Names (Personalizare nume coloană) pentru a
modifica numele coloanei.

5. Faceți clic pe Export (Exportare). Va apărea caseta de dialog Save As (Salvare ca).

6. În caseta de dialog Save As (Salvare ca), specificați un nume de fișier și locul în care doriți să
salvați fișierul exportat.

7. Faceți clic pe OK pentru a salva fișierul exportat.
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Exportarea către un folder LIMS
Puteți exporta datele într-un format de fișier compatibil cu LIMS.

Pentru a exporta datele în format LIMS

1. Selectați Export > Export to LIMS Folder (Exportare > Exportare către folder LIMS).

Va apărea caseta de dialog Save As (Salvare ca).

2. În caseta de dialog Save As (Salvare ca), specificați un nume de fișier și locul în care doriți să
salvați fișierul exportat.

3. Faceți clic pe OK pentru a salva fișierul exportat.

Exportarea de date în format Seegene
Puteți exporta datele din toate vizualizările foilor de calcul în fișiere Excel structurate special pentru a fi
utilizate de Seegene, Inc.

Pentru a exporta date într-un format specific Seegene

1. Selectați Export > Seegene Export (Exportare > Exportare Seegene).

Va apărea caseta de dialog Save As (Salvare ca).

2. În caseta de dialog Save As (Salvare ca), specificați localizarea folderului în care doriți să salvați
fișierele în format Seegene Excel (.xlsx) exportate.

3. Faceți clic pe OK pentru a salva fișierele exportate.
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Capitolul 10 Detalii despre fereastra Data
Analysis (Analiză date)

În CFX Manager Dx software, fereastra Data Analysis (Analiză date) cuprinde mai multe file în care
pot fi vizualizate datele. Acest capitol explică detaliat aceste file.

Sfat: Puteți alege filele pe care doriți să le vizualizați în fereastra Data Analysis (Analiză date)
utilizând meniul View (Vizualizare). Aspectul personalizat al ferestrei este salvat împreună cu
fișierul de date.
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Fila Quantification (Cuantificare)
Utilizați datele din fila Quantification (Cuantificare) pentru a seta condițiile pentru analiza datelor,
inclusiv setările de nivel inițial pentru alveole individuale și setările de prag. Fila Quantification
(Cuantificare) afișează date în aceste patru vizualizări:

n Graficul Amplification (Amplificare) – afișează unitățile de fluorescență relativă (RFU) pentru
fiecare alveolă la fiecare ciclu. Fiecare urmă din grafic reprezintă datele de la un singur fluorofor
dintr-o alveolă.

n Standard curve (Curbă standard) – apare numai dacă rularea include alveole desemnate ca tip de
probă standard (Std). Curba standard afișează ciclul de prag reprezentat pe baza logaritmului
cantității inițiale. Legenda afișează Eficiența reacțiilor (E) pentru fiecare fluorofor din alveole cu un
tip de probă Standard.

n Well selector (Selector alveole) – selectează alveolele cu datele de fluorescență pe care doriți să
le afișați.

n Spreadsheet (Foaie de calcul) – afișează o foaie de calcul a datelor colectate în alveolele
selectate.
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Opțiuni fluorofori
Pentru a afișa datele pentru fluorofori în fila Quantification (Cuantificare) a graficelor și foilor de calcul,
selectați fluoroforul (fluoroforii) țintă de sub graficul Amplification (Amplificare). Pentru a ascunde
datele pentru fluorofori din fereastra Data Analysis (Analiză date), debifați caseta de selectare
aferentă.

Caseta de dialog Trace Styles (Stiluri Urme)
Folosind caseta de dialog Trace Styles (Stiluri Urme), puteți ajusta aspectul urmelor în graficele pentru
amplificare și curbă de topire din filele Quantification (Cuantificare) și Melt Curve (Curbă de topire).
Apoi puteți previzualiza schimbările în selectorul de alveole care apare în caseta de dialog Trace
Styles (Stiluri Urme).

Pentru a ajusta stilurile de urme

1. Selectați un singur fluorofor din graficul Amplification (Amplificare).

2. Pentru a deschide caseta de dialog Trace Styles (Stiluri Urme), efectuați una dintre următoarele:

n Faceți clic pe Trace Styles (Stiluri Urme) în graficul Amplification (Amplificare).

n Selectați Settings > Trace Styles (Setări > Stiluri Urme) din bara de meniu Data Analysis
(Analiză date).

n Faceți clic dreapta pe o urmă și selectați Trace Styles (Stiluri Urme).

Apare dialogul Trace Styles (Stiluri Urme).
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3. În caseta de dialog Trace Styles (Stiluri Urme), selectați un set specific de alveole în selectorul de
alveole din panoul de jos. Alternativ, selectați alveole care conțin un tip de probă în meniul vertical
din coloanaWells (Alveole).

4. Urmați oricare dintre procedurile următoare:

n Pentru a alege o culoare pentru alveolele selectate, faceți clic pe caseta din coloana Color
(Culoare).

n Pentru a aloca un simbol alveolelor selectate, selectați un simbol din lista verticală Symbol
(Simbol).

n Pentru a colora rapid alveolele prin eticheta butonului, faceți clic pe setul rapid
corespunzător:

o Random byWell (Aleatoriu după alveole)

o Random by Replicate (Aleatoriu după replicate)

o Use Fluor Colors (Utilizare culori fluorofor)

o Use Target Colors (Utilizare culori pentru țintă)

o Use Sample Colors (Utilizare culori pentru probă)

n Pentru a aloca etichete de alveolă, selectați Sample Type (Tip de probă), Target Name
(Denumire probă), Sample Name (Denumire probă) sau Symbol (Simbol).
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Opțiunea Log Scale (Scară logaritmică)
Selectați Log Scale (Scară logaritmică) de sub graficul Amplification (Amplificare) pentru a vizualiza
urmele de fluorescență într-o scară semilogaritmică:

Sfat: Pentru a mări orice zonă a graficului, trageți de-a lungul zonei țintă. Pentru a reveni la o
vizualizare completă, faceți clic dreapta în grafic și selectați Set Scale to Default (Setare scară la
implicit).

Graficul Standard Curve (Curbă standard)
Software-ul creează un grafic Standard Curve (Curbă standard) în fila Quantification (Cuantificare)
dacă datele includ tipuri de probă definite ca Std pentru cel puțin un fluorofor din rulare.
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Graficul Standard Curve (Curbă standard) afișează următoarele informații:

n Denumirea fiecărei curbe (fluoroforul sau ținta).

n Culoarea fiecărui fluorofor sau fiecărei ținte.

n Eficiența reacțiilor (E). Utilizați această statistică pentru a optimiza o reacție multiplă și pentru a
egaliza datele unei curbe standard.

Observație: Eficiența reacțiilor descrie cât de mult este produsă ținta dumneavoastră cu
fiecare ciclu din protocol. O eficiență de 100% indică faptul că vă dublați ținta cu fiecare ciclu.

n Coeficientul de determinare, R2 (scris sub forma R^2). Folosiți această statistică pentru a
determina cât de corect descrie linia datele (adecvarea potrivirii).

n Pantă

n Punct de intersecție Y

Opțiunile meniului Amplification Chart (Grafic Amplificare)
Pe lângă opțiunile comune de meniu ale graficelor afișate prin clic dreapta (consultați Elementele de
meniu comune afișate prin clic dreapta pentru grafice de la pagina 177), Tabelul 20 prezintă opțiunile de
meniu disponibile numai în graficul Amplification (Amplificare).

Observație: Graficul Standard Curve (Curbă standard) oferă numai opțiunile de meniu afișate
prin clic dreapta.

Opțiune de meniu Funcție

Show Threshold Values (Afișare
valori prag)

Afișează valoarea pragului pentru fiecare curbă de amplificare din
grafic.

Trace Styles (Stiluri Urme) Deschide fereastra Trace Styles (Stiluri Urme) pentru a schimba
stilurile urmelor care apar pe filele Quantification (Cuantificare) și
Melt Curve (Curbă de topire).

Baseline Thresholds (Praguri
nivel inițial)

Deschide fereastra Baseline Thresholds (Praguri de nivel de
referință) pentru a schimba nivelul de referință sau pragurile
fiecărui fluorofor (schimbările apar în graficul Amplification
(Amplificare) din fila Quantification (Cuantificare)).

Tabelul 20. Elementele de meniu afișate prin clic dreapta și clic stânga în graficul de
amplificare
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Foaia de calcul din fila Quantification (Cuantificare)
Tabelul 21 definește datele afișate în foaia de calcul din fila Quantification (Cuantificare).

Informație Descriere

Well (Alveolă) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Target (Țintă) Denumirea țintei încărcate în alveolele Plate Editor (Editor placă)

Content (Conținut) O combinație între Tipul de probă (obligatoriu) și Numărul
replicatului (opțional) încărcate în Plate Editor (Editor placă)

Sample (Probă) Denumirea probei încărcate în alveolele Plate Editor (Editor placă)

Cq Ciclul de cuantificare pentru fiecare urmă

Tabelul 21. Conținutul foii de calcul din fila Quantification (Cuantificare)

Modificarea datelor aferente țintei, conținutului sau probei

Puteți modifica datele din coloanele Țintă, Conținut și Probă editând fișierul plăcii cu Editor placă chiar
și după rularea experimentului.

Pentru a modifica datele din coloanele Conținut, Țintă și Probă

u Faceți clic pe Plate Setup (Configurare placă) și selectați View/Edit Plate (Vizualizare/editare
placă) pentru a deschide Plate Editor (Editor placă).
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Fila Quantification Data (Date de cuantificare)
Fila Quantification Data (Date de cuantificare) afișează datele de cuantificare colectate în fiecare
alveolă. CFX Manager Dx software afișează datele în patru vizualizări de foaie de calcul diferite:

n Results (Rezultate) – afișează o foaie de calcul a datelor. Aceasta este vizualizarea implicită.

n Standard Curve Results (Rezultate Curbă standard) – afișează o foaie de calcul cu datele curbei
standard.

n Plate (Placă) – afișează datele din fiecare alveolă sub formă de hartă placă.

n RFU – afișează cantitățile RFU din fiecare alveolă pentru fiecare ciclu.

Selectați fiecare foaie de calcul din lista verticală care apare sub fila Quantification Data (Date de
cuantificare).

Foaia de calcul Results (Rezultate)
Foaia de calcul Results (Rezultate) afișează date pentru fiecare alveolă din placă.

Observație: Toate calculele Std. Dev (deviație standard) se aplică grupelor de replicate alocate
în alveolele din fereastra Plate Editor (Editor placă). Calculele stabilesc media pentru valoarea Cq
pentru fiecare alveolă din grupul de replicate.

Tabelul 22 definește datele care apar în foaia de calcul Results (Rezultate).

194 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Fila Quantification Data (Date de cuantificare)

Informație Descriere

Well (Alveolă) Poziția godeului în placă

Fluor (Fluorofor Fluorofor detectat

Target (Țintă) Nume țintă amplificare (genă)

Content (Conținut) Tipul de probă și Numărul replicatului

Sample (Probă) Descrierea probei

Biological Set Name (Denumire
set biologic)

Denumirea setului biologic

Cq Ciclul de cuantificare

CqMedie Media ciclului de cuantificare pentru grupul de replicate

Cq Std. Dev Deviația standard a ciclului de cuantificare pentru grupul de
replicate

Starting Quantity (SQ)
(Cantitate inițială (SQ))

Estimare a cantității inițiale a țintei

Log Starting Quantity (Log.
cantitate inițială)

Logaritmul cantității inițiale

SQMean (Medie SQ) Media cantității inițiale

SQ Std. Dev Deviație standard a cantității inițiale între replicate

Tabelul 22. Conținutul foii de calcul Results (Rezultate)
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Foaia de calcul Standard Curve Results (Rezultate Curbă
standard)
Foaia de calcul Standard Curve Results (Rezultate Curbă standard) afișează parametrii curbei
standard calculați.

Tabelul 23 definește datele care apar în foaia de calcul Standard Curve Results (Rezultate Curbă
standard).

Informație Descriere

Fluor (or Target) (Fluorofor sau
Țintă)

Fluorofor (sau Țintă) detectat(ă)

Efficiency % (% Eficiență) Eficiența reacțiilor

Slope (Pantă) Panta curbei standard

Y-intercept (Punct de
intersecție Y)

Punctul în care curba se intersectează cu axa y

R^2 Coeficientul de determinare

Tabelul 23. Conținutul foii de calcul Rezultate Curbă standard

196 | Sistemele CFX96 Dx și CFX96 DeepWell Dx



Fila Quantification Data (Date de cuantificare)

Foaia de calcul Plate (Placă)
Foaia de calcul Plate (Placă) afișează o hartă a plăcii datelor pentru câte un fluorofor pe rând.

Pentru a vedea datele pentru un anumit fluorofor

u Faceți clic pe fila sa din partea de jos a foii de calcul.

Foaia de calcul RFU
Foaia de calcul RFU afișează citirile de unități de fluorescență relativă (RFU) pentru fiecare alveolă
obținute la fiecare ciclu al rulării. Numărul de alveole apare în partea de sus a fiecărei coloane și
numărul de cicluri apare la stânga fiecărui rând.
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Fila Melt Curve (Curbă de topire)
Exonerare de răspundere: Bio-Rad nu acordă niciun drept pentru utilizarea analizei curbei de
topire la analizarea topirii la înaltă rezoluție în domeniul diagnosticului in vitro la oameni sau animale.
În plus, este responsabilitatea cumpărătorului să obțină orice drepturi de proprietate intelectuală care
ar putea fi obligatorii pentru aplicațiile sale specifice.

Pentru coloranții de fixare a DNA (ADN) și sondele de hibridizare neclivabile, fluorescența este cea
mai puternică atunci când cele două catene de DNA (ADN) se atașează. Prin urmare, pe măsură ce
temperatura crește apropiindu-se de temperatura de topire (Tm), fluorescența scade cu o viteză
constantă (pantă constantă). La Tm se înregistrează o reducere dramatică a fluorescenței, cu o
schimbare notabilă a pantei. Viteza acestei schimbări este determinată prin trasarea primei regresii
negative a fluorescenței versus temperatura (-d(RFU)/dT). Cea mai mare viteză de modificare a
fluorescenței determină valori de vârf vizibile și reprezintă Tm (Temperatura de topire) a complexelor
DNA (ADN) cu două catene.

CFX Manager Dx software trasează datele RFU colectate în timpul unei curbe de topire ca o funcție a
temperaturii. Pentru a analiza datele valorilor de vârf de topire, software-ul atribuie o temperatură
inițială și finală fiecărui vârf, deplasând bara de prag. Valoarea minimă a zonei de vârf este specificată
de poziția barei pragului de topire. Un vârf valid trebuie să aibă o înălțime minimă relativ la distanța
dintre bara de prag și înălțimea celui mai înalt vârf.

Fila Melt Curve (Curbă de topire) afișează Tm (temperatura de topire) a produselor PCR amplificate în
patru vizualizări:

n Melt Curve (Curbă de topire) – afișează datele în timp real pentru fiecare fluorofor sub formă de
RFUs per temperatura pentru fiecare alveolă.

n Melt Peak (Vârf de topire) – afișează regresia negativă a datelor RFU per temperatură pentru
fiecare alveolă.

n Well selector (Selector alveole) – afișează alveolele pentru a arăta sau ascunde datele.

n Peak spreadsheet (Foaie de calcul vârf) – afișează datele colectate din alveola selectată.

Observație: Această foaie de calcul afișează până la două vârfuri pentru fiecare urmă.
Pentru a vedea mai multe vârfuri, faceți clic pe fila Melt Curve (Curbă de topire).
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Fila Melt Curve (Curbă de topire)

Tabelul 24 de la pagina 199 definește datele care apar în foaia de calcul Melt Curve (Curbă de topire).

Informație Descriere

Well (Alveolă) Poziția godeului în placă

Fluor (Fluorofor Fluorofor detectat

Content (Conținut) O combinație între Tipul de probă și Numărul replicării

Sample (Probă) Denumirea probei încărcate în Plate Editor (Editor
placă)

Melt Temp (Temperatura de topire) Temperatura vârfului de topire pentru fiecare alveolă

Observație: Doar cele mai mari două valori de vârf
apar în această foaie de calcul.

Tabelul 24. Conținutul foii de calcul Melt Curve (Curbă de topire)
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Ajustarea datelor Melt Curve (Curbă de topire)
Pentru a ajusta datele Melt Curve (Curbă de topire)

u Urmați oricare dintre procedurile următoare:

n Faceți clic pe și trageți barele de prag din graficul Melt Peak (Vârf de topire) pentru a include
sau exclude valorile de vârf în analiza datelor.

n Selectați Positive (Pozitive) în meniul vertical Peaks (Valori de vârf) pentru a afișa datele din
foaia de calcul pentru valorile de vârf de deasupra linei Melt Threshold (Prag de topire) sau
selectați Negative (Negative) pentru a vizualiza datele din foaia de calcul pentru valorile de
vârf de sub linia pragului de topire.

n Deschideți fereastra Trace Styles (Stiluri Urme) pentru a schimba culoarea urmelor din
graficele Melt Curve (Curbă de topire) și Melt Peak (Vârf de topire).

n Selectați un număr în selectorul Step Number (Număr pas) pentru a vizualiza datele din Melt
Curve (Curbă de topire) la un alt pas din protocol. Lista afișează mai mult de un pas dacă
protocolul include citiri ale plăcii în mai mult de un pas al curbei de topire.

n Selectați alveole din selectorul de alveole, pentru a vă axa pe subseturi de date.

n Selectați un grup de alveole pentru a vizualiza și analiza un subset al alveolelor din placă.
Selectați fiecare grup de alveole după nume în meniul vertical Well Group (Grup alveole) de
pe bara de instrumente.
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Fila Melt Curve Data (Date curbă de topire)
FilaMelt Curve Data (Date curbă de topire) afișează datele din fila Melt Curve (Curbă de topire) în mai
multe foi de calcul care includ toate vârfurile de topire pentru fiecare urmă. CFX Manager DX software
oferă patru opțiuni de foi de calcul în care să vizualizați datele pentru curba de topire:

n Melt Peaks (Vârfuri de topire) – afișează toate datele, inclusiv toate vârfurile de topire, pentru
fiecare urmă. Aceasta este vizualizarea implicită.

n Plate (Placă) – afișează o vizualizare a datelor și conținutului fiecărei alveole din placă.

n RFU – afișează cantitățile RFU la fiecare temperatură pentru fiecare alveolă.

n -d(RFU)/dT – afișează rata negativă de schimbare din RFU pe măsură ce se schimbă
temperatura (T). Acesta este un grafic de regresie inițial pentru fiecare alveolă din placă.

Selectați fiecare foaie de calcul din lista verticală care apare sub fila Melt Curve Data (Date curbă de
topire).

Foaia de calcul Melt Peaks (Vârfuri de topire)
Foaia de calcul Melt Peaks (Vârfuri de topire) afișează toate datele curbei de topire.

Tabelul 25 de la pagina 202 definește datele care apar în foaia de calcul Melt Peaks (Vârfuri de topire).
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Informație Descriere

Well (Alveolă) Poziția godeului în placă

Fluor (Fluorofor Fluorofor detectat

Content (Conținut) Tipul de probă listat în fereastra Plate Editor (Editor placă)

Target (Țintă) Ținta amplificării (genă)

Sample (Probă) Denumirea probei listată în fereastra Plate Editor (Editor placă)

Melt Temperature (Temperatura
de topire)

Temperatura de topire a fiecărui produs, listată ca valoare de vârf
(cea mai mare) per rând în foaia de calcul

Peak Height (Înălțime de vârf) Înălțimea vârfului

Begin Temperature
(Temperatura inițială)

Temperatura la începutul vârfului

End Temperature (Temperatura
finală)

Temperatura la finalul vârfului

Tabelul 25. Conținutul foii de calcul Melt Peaks (Vârfuri de topire)

Foaia de calcul Plate (Placă)
Foaia de calcul Plate (Placă) afișează datele privind curba de topire într-un format placă.

Observație: Pentru a ajusta vârful apelat de software, ajustați linia pragului din graficul Melt Peak
(Vârf de topire) în fila Melt Curve (Curbă de topire).

Tabelul 26 de la pagina 203 definește datele care apar în foaia de calcul Plate (Placă).
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Fila Melt Curve Data (Date curbă de topire)

Informație Descriere

Content (Conținut) O combinație între Tipul de probă (obligatoriu) și numărul replicatului (opțional)

Sample (Probă) Descrierea probei

Peak 1 (Vârful 1) Primul vârf de topire (cel mai mare)

Peak 2 (Vârful 2) Al doilea (cel mai mic) punct de topire

Tabelul 26. Conținutul foii de calcul Plate (Placă)

Foaia de calcul RFU
Foaia de calcul RFU afișează fluorescența pentru fiecare alveolă în fiecare ciclu achiziționat în timpul
curbei de topire.

Tabelul 27 definește datele afișate în foaia de calcul RFU.

Informație Descriere

Well number (Număr alveolă) (A1, A2, A3,
A4, A5)

Poziția godeului în placă pentru alveolele
încărcate

Temperature (Temperatura) Temperatura de topire a țintei amplificate,
reprezentată ca o alveolă per rând și mai multe
alveole pentru mai multe produse din aceeași
alveolă

Tabelul 27. Conținutul foii de calcul RFU
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Foaia de calcul -d(RFU)/dT
Foaia de calcul -d(RFU)/dT afișează raportul negativ de schimbare din RFU pe măsură ce
temperatura (T) se modifică.

Tabelul 28 definește datele care apar în foaia de calcul -d(RFU)/dT.

Informație Descriere

Well number (Număr alveolă) (A1, A2,
A3, A4, A5)

Poziția godeului în placă pentru alveolele încărcate

Temperature -d(RFU)/dT (Temperatura
-d(RFU)/dT)

Raportul negativ de schimbare din RFU pe măsură ce
temperatura (T) se modifică

Tabelul 28. Conținutul foii de calcul -d(RFU)/dT
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Fila End Point (Momentul final)
Deschideți fila End Point (Momentul final) pentru a analiza unitățile finale de fluorescență relativă
(RFU) pentru alveolele cu probe. Software-ul compară nivelurile RFU pentru alveolele cu probe
necunoscute cu nivelurile RFU pentru alveolele cu controale negative și determină dacă proba
necunoscută este pozitivă sau negativă. Probele pozitive au o valoare RFUmai mare decât media
valorii RFU a controalelor negative plus valoarea limită.

Pentru a analiza datele din momentul final, placa trebuie să conțină controale negative, altfel software-
ul nu poate efectua analiza. Rulați unul dintre aceste două tipuri de protocol:

n Rulați un protocol Quantification (Cuantificare) – configurați un protocol standard. După
finalizarea rulării, deschideți fereastra Data Analysis (Analiză date), ajustați setările analizei
datelor în fila Quantification (Cuantificare), apoi faceți clic pe fila End Point (Momentul final)
pentru a alege un ciclu final.

n Rulați un protocol End Point Only (Doar momentul final) – încărcați protocolul End Point Only
(Doar momentul final) în fila Plate (Placă) a ferestrei Run Setup (Configurare rulare), selectați sau
creați o placă și inițiați rularea.

Fila End Point (Momentul final) afișează media valorilor RFU, pentru a determina dacă ținta a fost
amplificată de ultimul ciclu (final). Folosiți aceste date pentru a stabili dacă o anumită secvență țintă
este prezentă (pozitivă) într-o probă. Țintele pozitive au valori RFU mai mari decât nivelul de prag
definit de dumneavoastră.
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Sfat: Pentru a crea un protocol pentru momentul final, deschideți fila Protocol (fereastra Run
Setup (Configurare rulare)) și selectați Run > End Point Only Run (Rulare > Rulare doar
momentul final).

După finalizarea rulării, fișierul de date se deschide la fila End Point (Momentul final), care cuprinde
următoarele secțiuni:

n Settings (Setări) – ajustează setările analizei datelor.

n Results (Rezultate) – afișează rezultatele imediat după ce ați ajustat setările.

n Well selector (Selector alveole) – selectează alveolele cu datele finale pe care doriți să le afișați.

n RFU spreadsheet (Foaie de calcul RFU) – afișează datele RFU finale colectate din alveolele
selectate.

Date rezultate
Secțiunea Results (Rezultate) afișează următoarele date:

n Lowest RFU value (Cea mai mică valoare RFU) – cea mai mică valoare RFU din cadrul datelor

n Highest RFU value (Cea mai mare valoare RFU) – cea mai mare valoare RFU din cadrul datelor

n Negative Control Average (Medie control negativ) – valoarea RFUmedie pentru alveolele care
conțin controale negative

n Cut Off Value (Valoare limită) – calculată prin adunarea toleranței (RFU sau Percentage (Procent)
al intervalului indicat în Setări) și a mediei controalelor negative. Probele cu RFUmai mare decât
valoarea limită vor fi numite „Pozitive”. Pentru a ajusta valoarea limită, modificați RFU sau
Percentage of Range (Procent interval)

Valoarea limită este calculată utilizând următoarea formulă:

Valoare limită = medie control negativ + toleranță

Selectați o toleranță printr-una dintre următoarele metode:

n RFU (implicit) – selectați această metodă pentru a utiliza o valoare RFU absolută pentru
toleranță. Valoarea minimă a toleranței RFU este 2. Valoarea maximă este valoarea absolută a
celei mai mari valori RFU minus valoarea absolută a celei mai mici valori RFU. Valoarea implicită
a toleranței RFU este 10 % din intervalul RFU total.

n Percent of Range (Procent interval) – selectați această metodă pentru a utiliza un procent al
intervalului RFU pentru toleranță. Procentul minim al intervalului este 1 %. Procentul maxim al
intervalului este 99 %. Procentul implicit al intervalului este 10 %.
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Ajustarea analizei datelor din momentul final
Pentru a ajusta datele din fila End Point (Moment final)

u Urmați oricare dintre procedurile următoare:

n Alegeți un fluorofor din lista verticală.

n Alegeți o valoare End Cycle to Average (Ciclu final la medie) pentru a configura numărul de
cicluri cu care să calculați valoarea medie finală RFU.

n Selectați RFUs (Valori RFU) pentru a vizualiza datele în unități de fluorescență relativă.

n Selectați Percentage of Range (Procentaj interval) pentru a vizualiza datele sub formă de
procentaj al intervalului RFU.

n Selectați alveole din selectorul de alveole, pentru a vă axa pe subseturi de date.

n Selectați un grup de alveole pentru a vizualiza și analiza un subset al alveolelor din placă.
Selectați fiecare grup de alveole după nume în meniul vertical Well Group (Grup alveole) de
pe bara de instrumente.

Foaia de calcul RFU pentru analiza momentului final
Tabelul 29 definește datele care apar în foaia de calcul RFU din fila End Point (Momentul final).

Informație Descriere

Well (Alveolă) Poziția godeului în placă

Fluor (Fluorofor) Fluorofor detectat

Content (Conținut) O combinație între tipul de probă și numărul replicatului

End RFU (RFU final) RFU pentru ciclul de la momentul final

Call (Apel) Pozitiv sau negativ, unde probele pozitive au o valoare RFUmai mare
decât RFUmedie a controalelor negative plus valoarea limită

Sample (Probă) Denumirea probei încărcate în Plate Editor (Editor placă)

Tabelul 29. Conținutul foii de calcul End Point (Momentul final)

Manual de utilizare | 207



Capitolul 10 Detalii despre fereastra Data Analysis (Analiză date)

Fila Allelic Discrimination (Evidențiere alelică)
Fila Allelic Discrimination (Evidențiere alelică) atribuie genotipuri alveolelor cu probe necunoscute.
Utilizați aceste date pentru a identifica probe cu diferite genotipuri, inclusiv Alela 1, Alela 2,
Heterozigot, Niciun apel (nicio amplificare) sau Nedeterminat.

Observație: Datele pentru evidențierea alelică trebuie să provină din rulări multiplex cu cel puțin
doi fluorofori. Fiecare fluorofor identifică o alelă în toate probele.

Analiza evidențierii alelice necesită următorul conținut minim al alveolelor:

n Doi fluorofori în fiecare alveolă

n Probe NTC (control fără țintă de amplificare) pentru analiza de date optimizată

CFX Manager Dx software oferă patru opțiuni în care puteți vizualiza datele privind evidențierea
alelică:

n Graficul Allelic Discrimination (Evidențiere alelică) – afișează datele într-un grafic al RFU pentru
Alela 1/Alela 2. Fiecare punct din grafic reprezintă datele din ambii fluorofori dintr-o alveolă. Puteți
comuta între coordonate carteziene și polare, bifând și debifând caseta de selectare Polar
Coordinates (Coordonate polare). Coordonatele carteziene reprezintă RFU pentru Alela 1 de pe
axa x și RFU pentru Alela 2 de pe axa y. Coordonatele polare reprezintă unghiul de pe axa x și
distanța dintre origine și RFU de pe axa y (media tuturor NTC).
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n Well spreadsheet (Foaie de calcul alveolă) – afișează datele de evidențiere alelică colectate în
fiecare alveolă a plăcii.

n Well selector (Selector alveole) – selectează alveolele cu datele alelice pe care doriți să le afișați.

n Selected Fluorophores panel (Panoul Fluorofori selectați) – schimbă etichetele axei x și y în
graficul Evidențiere alelică, ciclul de analizat și afișarea sau ascunderea hărții apelurilor.

Ajustarea datelor pentru evidențiere alelică
Software-ul atribuie automat un genotip alveolelor cu probe necunoscute, pe baza pozițiilor probelor
martor NTC și a unghiului și distanței punctelor de date necunoscute din probele martorNTC.

Pentru a ajusta datele de evidențiere alelică

u Urmați oricare dintre procedurile următoare:

n Pentru a afișa coordonatele polare, bifați caseta de selectare din graficul Allelic
Discrimination (Evidențiere alelică).

n Pentru a vizualiza un alt fluorofor, alegeți-l din lista verticală de pe panoul Selected
Fluorophores (Fluorofori selectați).

n Pentru a schimba un apel, glisați peste punctul (punctele) de date din graficul Allelic
Discrimination (Evidențiere alelică) și alegeți o opțiune din lista Selected Wells (Godeuri
selectate):

o Allele 1 (Alela 1)

o Allele 2 (Alela 2)

o Heterozygote (Heterozigot)

o Undetermined (Nedeterminat)

o No Call (Niciun apel)

o Auto Call (Apel automat)

Sfat: Selectați Auto Call (Apel automat) pentru a reveni la apelul implicit.

Manual de utilizare | 209



Capitolul 10 Detalii despre fereastra Data Analysis (Analiză date)

Opțiunile de meniu pentru grafice
Pe lângă opțiunile comune de meniu pentru grafice, afișate prin clic dreapta (consultați Elementele de
meniu comune afișate prin clic dreapta pentru grafice de la pagina 177), Tabelul 30 listează opțiunile de
meniu disponibile în graficul Allelic Discrimination (Evidențiere alelică).

Opțiune de meniu Funcție

Zoom (Mărire) Focalizează vizualizarea graficului asupra zonei selectate (făcând
clic și trăgând cursorul în grafic).

Sfat: Pentru a anula mărirea și a afișa toate punctele de date,
faceți clic dreapta și selectați Set Scale to Default (Setare
scară la implicit).

Well (Alveolă) Pentru alveola selectată, opțiunile sunt: afișează doar această
alveolă, elimină această alveolă din vizualizare, setează culoarea
pentru această urmă sau exclude această alveolă din analiză.

Selected Wells (Godeuri
selectate)

Pentru alveolele selectate (făcând clic și trăgând cursorul în grafic),
opțiunile sunt: afișează doar aceste alveole, elimină aceste alveole
din vizualizare, setează culoarea pentru aceste urme sau exclude
aceste alveole din analiză.

Tabelul 30. Opțiunile de meniu dreapta și stânga pentru graficul Allelic Discrimination
(Evidențiere alelică)
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Foaia de calcul Allelic Discrimination (Evidențiere alelică)
Tabelul 31 definește datele care apar în foaia de calcul Allelic Discrimination (Evidențiere alelică).

Informație Descriere

Well (Alveolă) Poziția godeului în placă

Sample (Probă) Descrierea denumirii probei

Call (Apel) Identitatea alelei, incluzând opțiunile automate Alelă 1, Alelă 2,
Heterozigot, Niciun apel sau Nedeterminat

Type (Tip) Auto (Automat) sau Manual, descrie modul în care a fost efectuat
apelul. Automat indică faptul că software-ul a selectat apelul.
Manual indică faptul că utilizatorul a ales apelul.

RFU1 RFU pentru Alelă 1

RFU2 RFU pentru Alelă 2

Tabelul 31. Conținutul foii de calcul Allelic Discrimination (Evidențiere alelică)
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Fila Custom Data View (Vizualizare de date personalizată)
Fila Custom Data View (Vizualizare de date personalizată) afișează simultan mai multe panouri într-un
format personalizabil.

Lista verticală Load a Preset View (Încărcare vizualizare prestabilită) oferă o selecție a șabloanelor de
format de afișare. Vizualizarea implicită afișată depinde de fișierul analizat. De exemplu, dacă sunt
prezente date Melt Curve (Curbă de topire), va apărea vizualizarea implicită Amp+Melt.
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Crearea unei vizualizări de date personalizată
Pentru a crea o vizualizare de date personalizată

u Urmați oricare dintre procedurile următoare:

n Selectați o vizualizare prestabilită alternativă din lista verticală.

n Selectați altă vizualizare grafic din lista verticală aflată în partea de sus a fiecărui panou
individual.

n Modificați numărul de rânduri și coloane din filă.

n Modificați dimensiunile panourilor individuale. Trageți de barele de la marginea fiecărui
panou.

Faceți clic pe Save as Preset (Salvare ca prestabilit) pentru a salva vizualizarea personalizată ca
șablon prestabilit. Faceți clic pe Manage Presets (Gestionare prestabilite) pentru a șterge, redenumi
sau restabili vizualizări prestabilite existente.
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Fila QC (CC)
Utilizați fila QC (CC) pentru a evalua rapid calitatea datelor de rulare pe baza regulilor definite în fila
QC (CC).

CFX Manager Dx software oferă patru opțiuni în care puteți vizualiza datele QC (CC):

n Graficul Amplification (Amplificare) – afișează RFU pentru fiecare alveolă la fiecare ciclu.
Fiecare urmă din grafic reprezintă datele de la un singur fluorofor dintr-o alveolă.

n Tabelul de reguli QC (CC) – afișează regulile QC (CC) disponibile și setările care definesc
fiecare regulă. Regulile QC (CC) aplicate sunt indicate printr-o bifă.

n Well selector (Selector alveole) – selectează alveolele cu datele de fluorescență pe care doriți
să le afișați.

n QC rule summary pane (Panou rezumat regulă QC) – afișează regula QC (CC) selectată și
evidențiază alveolele care nu îndeplinesc regula.

Schimbarea criteriilor QC (CC)
Pentru a schimba criteriile QC (CC)

u Bifați sau debifați caseta de selectare Use (Utilizare) pentru regulă, pentru a o include sau
exclude din QC (CC).
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Excluderea alveolelor care nu îndeplinesc QC (CC)
CFXManager Dx software afișează alveolele care nu îndeplinesc criteriile QC (CC) în coloana
Rezultate din tabelul de reguli QC (CC) și în panoul rezumativ.

Pentru a exclude alveolele care nu îndeplinesc criteriile QC (CC)

u Selectați Exclude Wells (Excludere alveole) pentru fiecare alveolă pe care doriți să o excludeți.
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Fila Run Information (Informații rulare)
Fila Run Information (Informații rulare) afișează informații despre protocol și alte informații despre
fiecare rulare. Folosiți această filă pentru a:

n Vizualiza protocolul.

n Introduce și edita observații despre rulare.

n Introduce sau edita ID (Nr. de identificare) sau codul de bare al rulării.

n Vizualiza evenimentele potențial produse în timpul rulării. Folosiți aceste mesaje pentru
depanarea unei rulări.

Sfat: Faceți clic dreapta pe Protocol pentru a-l copia, exporta sau imprima. Faceți clic dreapta pe
panourile Notes (Observații), ID/Bar Code (Nr. de identificare/cod de bare) sau Other (Altele)
pentru a tăia, copia, lipi, șterge sau selecta textul.
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Rapoarte de analiză a datelor
Caseta de dialog Report (Raport) afișează informații despre fișierul de date curent în fereastra Data
Analysis (Analiză date) . Pentru a deschide un raport, selectați Tools > Reports (Instrumente >
Rapoarte).

Caseta de dialog Report (Raport) cuprinde următoarele secțiuni:

n Meniu și bară de instrumente – oferă opțiuni de formatare, salvare și imprimare a raportului sau
șablonului.

n Listă de opțiuni (partea stângă sus a casetei de dialog) – oferă opțiuni de afișare a raportului.

n Panou de opțiuni (partea stângă jos a casetei de dialog) – afișează casete text în care puteți
introduce informații despre o opțiune selectată.

n Panou de previzualizare (partea dreaptă a casetei de dialog) – afișează o previzualizare a
raportului curent.
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Categorii de rapoarte de analiză a datelor
Tabelul 32 afișează toate opțiunile disponibile pentru un raport de analiză a datelor, în funcție de tipul
de date din fereastra Data Analysis (Analiză date).

Categorie Opțiune Descriere

Header (Antet)

Titlu, subtitlu și logo pentru raport

Report Information (Informații
raport)

Data rulării, nume utilizator, denumirea
fișierului de date, calea fișierului de
date și grupul de alveole selectat

Audit Information (Informații
audit)

Informații suplimentare necesare
pentru audit, inclusiv semnături

Notes (Observații) Observații despre raportul de date

Run Setup (Configurare rulare)

Run Information (Informații
rulare)

Data rulării, nume utilizator, denumirea
fișierului de date, calea fișierului de
date și grupul de alveole selectat

Protocol Vizualizare în format text a pașilor și
opțiunilor protocolului

Plate Display (Afișare placă) Vizualizare a plăcii, cu informații despre
fiecare alveolă din placă

Quantification (Cuantificare)

Analysis Settings (Setări
analiză)

Numărul pașilor de colectare a datelor,
modul de analiză și metoda de scădere
a nivelului inițial

Graficul Amplification
(Amplificare)

Graficul de amplificare pentru rulările
care includ date de cuantificare

Standard Curve Chart (Grafic
Curbă standard)

Grafic curbă standard

Tabelul 32. Categorii de rapoarte de analiză a datelor în lista de opțiuni
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Categorie Opțiune Descriere

Data (Date) Foaie de calcul care listează datele din
fiecare alveolă

Gene Expression – Bar Chart (Expresie genică – Grafic cu bare)

Analysis Settings (Setări
analiză)

Modul de analiză, datele graficului,
opțiunea de scalare și erori grafic

Chart (Grafic) Copie a graficului cu bare

Target Names (Denumiri ținte) Grafic cu denumirile țintelor

Sample Names (Denumiri
probe)

Grafic cu denumirile probelor

Data (Date) Foaie de calcul care listează datele din
fiecare alveolă

Target Stability (Stabilitatea
țintei)

Grafic cu valorile de stabilitate a țintelor

Gene Expression (Expresie genică) – Clustergram (Clustergramă) și Scatter Plot
(Corelogramă)

Analysis Settings (Setări
analiză)

Setări pentru fiecare tip de grafic

Chart (Grafic) Copie a graficului

Data (Date) Foaie de calcul care listează datele din
fiecare țintă

Melt Curve (Curbă de topire)

Analysis Settings (Setări
analiză)

Număr pași de topire și setare bară
prag

Grafic Melt Curve (Curbă de
topire)

Graficul curbei de topire

Grafic Melt Peak (Vârf de topire) Graficul Melt peak (Vârf de topire)

Tabelul 32. Categorii de rapoarte de analiză a datelor în lista de opțiuni, continuare
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Categorie Opțiune Descriere

Data (Date) Foaie de calcul care listează datele din
fiecare alveolă

Allelic Discrimination (Evidențiere alelică)

Analysis Settings (Setări
analiză)

Afișează fluoroforii, ciclul și harta
apelurilor de vizualizare

Allelic Discrimination Chart
(Grafic evidențiere alelică)

Copie a graficului de evidențiere alelică

Data (Date) Foaie de calcul care listează datele din
fiecare alveolă

End Point (Momentul final)

Analysis Settings (Setări
analiză)

Fluorofor, cicluri finale la medie, mod,
cea mai mică valoare RFU, cea mai
mare valoare RFU și valoarea limită

Data (Date) Foaie de calcul care listează datele din
fiecare alveolă

QC Parameters (Parametri CC)

Data (Date) Foaie de calcul cu parametrii pentru
fiecare regulă CC

Tabelul 32. Categorii de rapoarte de analiză a datelor în lista de opțiuni, continuare
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Crearea unui raport de analiză a datelor
Puteți salva structura raportului drept șablon, pe care-l puteți utiliza din nou pentru rapoarte similare.

Pentru a crea un raport de analiză a datelor

1. Efectuați ajustările finale la conținutul godeului, alveolele selectate, grafice și foile de calcul în
fereastra Data Analysis (Analiză date) înainte de a crea raportul.

2. Selectați Tools > Reports (Instrumente > Rapoarte) din bara de meniu Data Analysis (Analiză
date) pentru a deschide caseta de dialog Report (Raport).

3. Alegeți opțiunile pe care doriți să le includeți în raport. Raportul se deschide cu opțiunile implicite
selectate. Bifați sau debifați casetele de selectare pentru a schimba categorii întregi sau opțiuni
individuale dintr-o categorie.

Observație: Datele care apar în raport depind de selecțiile curente din cadrul filelor ferestrei
Data Analysis (Analiză date). De exemplu, o rulare de cuantificare poate să nu conțină o
curbă standard și prin urmare datele respective nu apar în fereastra Data Analysis (Analiză
date) sau în raportul de date.

4. Schimbați ordinea categoriilor și elementelor dintr-un raport. Trageți opțiunile în poziția aferentă.
Elementele pot fi reordonate doar în cadrul categoriilor cărora le aparțin.

5. (Opțional) În panoul Report Options (Opțiuni raport), introduceți informațiile relevante pentru
opțiunea selectată:

n Alegeți un subset de informații de afișat în raport.

n Alegeți setările specifice pentru opțiunea selectată.

n Modificați textul de afișat pentru opțiunea selectată.

6. Faceți clic pe Update Report (Actualizare raport) pentru a actualiza Report Preview
(Previzualizare raport) cu orice modificări.

7. Imprimați sau salvați raportul. Faceți clic pe butonul Print Report (Imprimare raport) de pe bara de
instrumente pentru a imprima raportul curent. Selectați File > Save (Fișier > Salvare) pentru a
salva raportul în format PDF (fișier Adobe Acrobat Reader) și selectați un loc în care să salvați
fișierul. Selectați File > Save As (Fișier > Salvare ca) pentru a salva raportul cu o nouă denumire
sau într-un nou loc.

8. (Opțional) Creați un șablon de raport cu informațiile pe care le doriți. Pentru a salva setările
raportului curent într-un șablon, selectați Template > Save (Șablon > Salvare) sau Save As
(Salvare ca). Apoi încărcați șablonul raportului data viitoare când doriți să creați un raport nou.
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Crearea rapoartelor pentru grupuri de alveole
Pentru a crea un raport pentru un grup de alveole

1. Selectați Tools > Well Group Reports (Instrumente > Rapoarte grupuri de alveole) din fereastra
Data Analysis (Analiză date).

2. Din caseta de dialog Well Groups Reports (Rapoarte grupuri de alveole), selectați grupurile de
alveole, pașii de amplificare și pașii de topire de inclus în raport.

3. Introduceți calea sau navigați la folderul de destinație în care doriți să salvați raportul.

4. (Opțional) Selectați Choose a Report Template (Alegeți un șablon de raport) și navigați la folderul
fișierului șablon.

5. (Opțional) Selectați Open Destination Folder (Deschidere folder destinație) pentru a deschide
folderul și vizualiza rapoartele după ce sunt generate.

6. Faceți clic pe Create Reports (Creare rapoarte).
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Cu ajutorul unor probe control calificate mai stringent în reacțiile dumneavoastră, puteți utiliza CFX
Manager Dx software pentru a efectua o rulare de expresie genică pentru a normaliza diferențele
relative dintr-o concentrație țintă printre probe. În mod tipic, nivelurile de expresie pentru una sau mai
multe gene de referință sunt utilizate pentru a normaliza nivelurile de expresie ale unei gene de
interes. Genele de referință iau în considerare diferențele de încărcare sau alte variații reprezentate în
fiecare probă și nivelurile lor de expresie trebuie să nu fie afectate în sistemul biologic studiat.

Selectați fila Gene Expression (Expresie genică) în fereastra Data Analysis (Analiză date) pentru a
evalua diferențele relative între reacțiile PCR din două sau mai multe alveole. De exemplu, puteți
evalua numerele relative de genomi virali sau numerele relative de secvențe transfectate dintr-o
reacție PCR. Cea mai comună aplicație pentru studiul de expresie genică este comparația între
concentrația cDNA (ADNc) în mai mult de o reacție pentru a estima nivelurile de stare de echilibru al
RNA (ARN) mesager.

Software-ul calculează nivelul de expresie relativă al unei ținte cu unul dintre aceste scenarii:

n Nivelul de expresie relativă pentru o secvență țintă (Ținta 1) relativ la o altă țintă (Ținta 2); de
exemplu cantitatea unei gene relativ la o altă genă sub același tratament al probei.

n Nivelul de expresie relativă al unei secvențe țintă dintr-o probă în comparație cu aceeași țintă sub
un tratament diferit al probei; de exemplu, cantitatea relativă a unei gene în raport cu ea însăși în
alte condiții temporale, geografice sau de dezvoltare.

Configurarea plăcii pentru analiza expresiei genice
Pentru a realiza analiza expresiei genice, conținutul alveolelor trebuie să includă următoarele:

n Două sau mai multe ținte – cele două ținte care reprezintă diferite gene amplificate sau secvențe
din probele dumneavoastră.

n Una sau mai multe ținte de referință – cel puțin o țintă trebuie să fie țintă de referință pentru
expresia normalizată. Atribuiți toate țintele de referință în fereastra Experiment Settings (Setări
experimente), pentru a analiza datele în modul Expresie normalizată (ΔΔCq). Rulările care nu
conțin o referință trebuie analizate utilizând modul Expresie relativă (ΔCq).

n Probe comune – reacțiile dumneavoastră trebuie să includă probe comune (minimum două
necesare) pentru a vă vizualiza datele reprezentate grafic în fila Gene Expression (Expresie
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genică). Aceste probe ar trebui să reprezinte diferite tratamente sau condiții pentru fiecare dintre
secvențele dumneavoastră țintă. Atribuiți o probă de control (opțională) în fereastra Experiment
Settings (Setări experimente). Dacă nu este selectată nicio probă de control, software-ul
folosește cea mai mică valoare Cq drept valoare de control.

Cerințele pentru setarea Gene Expression (Expresie genică) din Plate Editor (Editor placă) depind de
tipul conținutului reacției: PCR singleplex, cu un fluorofor în reacții sau PCRmultiplex, cu mai mulți
fluorofori în reacție.

Configurarea ghidată a plăcii
Dacă configurarea plăcii unui fișier de date nu conține informațiile necesare pentru analiză și fila Gene
Expression (Expresie genică) este selectată, spațiul ocupat în mod normal de graficul cu bare va
conține instrucțiuni pentru introducerea acestor informații. Pentru expresia genică normalizată,
finalizați următorii pași:

1. Definiți denumirile Target (Țintă) și Sample (Probă) urmând oricare dintre procedurile următoare:

n Plate Setup (Configurare placă) – deschide fereastra Plate Editor (Editor placă).

n Replace Plate File (Înlocuire fișier placă) – deschide browser-ul Select Plate (Selectare
placă), în care puteți naviga la un fișier placă salvat anterior cu care să înlocuiți structura
curentă a plăcii.

n Replace PrimePCR File (Înlocuire fișier PrimePCR) – deschide caseta de dialog Select
PrimePCR File (Selectare fișier PrimePCR), în care puteți naviga la un fișier de rulare
PrimePCR pe care să-l aplicați la structura plăcii.

2. Selectați una sau mai multe ținte de referință și o probă de control utilizând caseta de dialog
Experiment Settings (Setări experimente).

Dacă structura plăcii conține deja informații despre țintă și probă, doar al doilea pas este necesar
și este evidențiat cu portocaliu. Acest pas trebuie finalizat înainte de realizarea analizei expresiei
genice normalizate.

Observație: Datele pentru clustergramă și corelogramă sunt afișate doar dacă toate
cerințele pentru expresia genică normalizată listate în Plate Setup (Configurare placă) pentru
Gene Expression Analysis (Analiza expresiei genice) sunt îndeplinite.
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Graficele de expresie genică
CFXManager Dx software afișează datele expresiei genice în mai multe vizualizări. Tabelul 33
listează opțiunile graficelor disponibile în software.

Buton Denumire Funcție

Grafic cu bare Afișează datele expresiei genice
normalizate în format de grafic cu bare.

Clustergramă Afișează datele expresiei normalizate într-o
ierarhie bazată pe gradul de similaritate a
expresiei pentru diferite ținte și probe.

Corelogramă Afișează expresia normalizată a țintelor
pentru un control versus o probă
experimentală.

Rezultate Rezumă datele din toate graficele.

Tabelul 33. Opțiunile graficelor de expresie genică
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Grafic cu bare

Expresia relativă a țintelor este prezentată în aceste două vizualizări:

n Graficul Expresie genică – afișează datele PCR în timp real, sub una dintre următoarele forme:

o ΔΔCq – expresie normalizată relativă, calculată folosind probe de control și ținte de referință.

o ΔCq – cantitatea relativă a genei țintă dintr-o probă în raport cu o probă de control.

n Foaie de calcul – afișează o foaie de calcul a datelor expresiei genice.

Sfat: Faceți clic dreapta pe orice grafic sau foaie de calcul pentru a accesa opțiunile.
Selectați View/Edit Plate (Vizualizare/Editare placă) din meniul vertical Plate Setup
(Configurare placă) pentru a deschide Plate Editor (Editor placă) și a modifica conținutul
godeului din placă.

Sfat: Selectați Sort (Sortare) din meniul clic dreapta pentru a rearanja ordinea denumirilor
Target (Țintă) și Sample (Probă) din grafic.
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Expresie genică normalizată

Pentru a normaliza datele, utilizați nivelul expresiei măsurat pentru una sau mai multe gene de
referință ca factor de normalizare. Genele de referință sunt ținte care nu sunt regulate în sistemul
biologic studiat, de exemplu actină,GAPDH sau tubulină.

Pentru a configura analiza expresiei genice normalizate (ΔΔCq)

1. Deschideți un fișier de date (extensia .pcrd).

2. Revizuiți datele din fila Quantification (Cuantificare) din fereastra Data Analysis (Analiză date).
Ajustați datele, de exemplu schimbând pragul și modul de analiză.

3. Alegeți fila Gene Expression (Expresie genică).

4. În fila Gene Expression (Expresie genică), faceți clic pe Experiment Settings (Setări
experimente).

5. În caseta de dialog Experiment Settings (Setări experimente), urmați procedura următoare:

a. Alegeți fila Samples (Probe) și selectați un control. La atribuirea unui control, CFX Manager Dx
software normalizează cantitățile relative pentru toate genele la cantitatea de control, care este
setată la 1.

b. Alegeți fila Target (Țintă) și selectați genele de referință. Analiza expresiei genice necesită o
referință între țintele din probele dumneavoastră

6. Selectați Normalized Expression (Expresie normalizată) (ΔΔCq) dacă această opțiune nu este
deja selectată și apoi vizualizați nivelurile de expresie în fila Gene Expression (Expresie genică).

Cantitate relativă

Prin definiție, datele de cantitate relativă (ΔCq) nu sunt normalizate. Această metodă este utilizată
pentru a cuantifica probele care nu includ gene de referință (ținte). În mod obișnuit, cercetătorii se
bazează pe una dintre următoarele considerente când setează rularea:

n Fiecare probă conține aceeași cantitate de RNA (ARN) sau cDNA (ADNc) în fiecare alveolă.

n Orice variație a cantității de probă biologică încărcată va fi normalizată după rulare printr-o metodă
de analiză a datelor, în afara software-ului. De exemplu, un cercetător poate alege să împartă
valoarea cantității relative la factorul de normalizare, dacă se poate la masa de acid nucleic
încărcată pentru fiecare probă, sau la numărul de celule din care a fost izolat acidul nucleic.

Pentru a rula o analiză a cantității relative (ΔCq)

u In fila Gene Expression (Expresie genică), selectați Relative Quantity (ΔCq) (Cantitate relativă)
(ΔCq) din lista verticală Mode (Mod) din panoul din dreapta.
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Sfat: Pentru a compara rezultatele cu datele din alte rulări ale expresiei genice, deschideți un
nou studiu genic sau adăugați un fișier de date la un studiu genic existent.

Sortarea datelor țintei și probei
Observație: Această opțiune este disponibilă numai în graficele de expresie genică.

Implicit, lista Targets and Samples (Ținte și probe) apare în ordine alfabetică. Utilizați caseta de dialog
Sort (Sortare) pentru a sorta afișajul în ordine alfabetică inversă sau pentru a muta manual un termen
în altă poziție din listă.

Pentru a sorta datele țintei și probei

1. Din meniul clic dreapta al graficului, faceți clic pe Sort (Sortare).

Va apărea caseta de dialog Gene Expression Chart Sorting (Sortare grafic expresie genică).

2. În caseta de dialog, faceți clic pe Z-A pentru a sorta lista în ordine alfabetică inversă.

3. Pentru a muta manual un termen, selectați-l și faceți clic pe butonul corespunzător dintre grafice:

n Faceți clic pe săgeata În sus sau În jos pentru a muta termenul selectat cu o poziție.

n Faceți clic pe săgeata bară În sus sau În jos pentru a muta termenul selectat în partea de sus
sau de jos a listei.

4. Faceți clic pe OK pentru a salva modificările și a reveni la fila Gene Expression (Expresie genică).

Ajustarea datelor de expresie genică
După ce ați selectat modul de analiză – expresie normalizată (∆∆Cq) sau cantitate relativă (∆Cq),
ajustați datele pe care le vedeți în fila Gene Expression (Expresie genică) modificând opțiunile de
setare din partea dreaptă a graficului.
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Sfat: Setați opțiunile implicite pentru datele de Gene Expression (Expresie genică) în caseta de dialog
User Preferences (Preferințe utilizator) (consultați Setarea parametrilor impliciți pentru fișierul de date de
expresie genică de la pagina 71).

Datele graficului

Setați valoarea axei y la scara liniară pentru a activa opțiunile datelor graficului. Opțiunile datelor
graficului vă permit să prezentați datele din grafic folosind una dintre următoarele opțiuni:

n Relativ la control – reprezentarea grafică a datelor cu axa scalată de la 0 la 1. Dacă atribuiți o
valoare de control în rularea dumneavoastră, selectați această opțiune pentru a vizualiza rapid
reglarea pozitivă și negativă a țintei.

n Relativ la zero – reprezentarea grafică a datelor cu originea la zero.

Probă de control

Utilizați meniul vertical Control Sample (Probă de control) pentru a selecta o probă care va fi utilizat(ă)
la normalizarea cantității relative:

Setări grafic

Următoarele opțiuni (descrise mai jos) sunt afișate atunci când selectați caseta Show Chart Settings
(Afișare setări grafic): X-Axis (Axa x), Y-Axis (Axa y), Scaling (Scalare), Error Type (Tip eroare) și
Chart Error Multiplier (Multiplicator eroare grafic).

Opțiuni axa x

Opțiunea axei x vă permite să selectați datele axei x ale graficului Gene Expression (Expresie genică):

n Target (Țintă) – reprezintă grafic denumirile țintelor pe axa x.

n Sample (Probă) – reprezintă grafic denumirile probelor pe axa x.

Opțiuni axa y

Opțiunea axei y vă permite să afișați graficul Gene Expression (Expresie genică) pe una dintre
următoarele trei scări:

n Linear (Liniară) – selectați această opțiune pentru a afișa o scară liniară.

Sfat: Setarea axei y la Linear (Liniară) activează lista verticală Graph Data (Date grafic), din
care puteți alege să reprezentați grafic datele relativ la control sau relativ la zero.

n Log 2 – selectați această opțiune pentru a evalua probele la nivelul unui interval dinamic mare.

n Log 10 – selectați această opțiune pentru a evalua probele la nivelul unui interval dinamic foarte
mare.
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Opțiuni de scalare

Selectați Normalized Gene Expression (Expresie genică normalizată) (ΔΔCq) și setați Control Sample
(Probă de control) la None (Niciuna) pentru a activa opțiunile de scalare în graficul Gene Expression
(Expresie genică). Selectați una dintre aceste opțiuni de scalare pentru a calcula și prezenta datele în
maniera cea mai adecvată pentru designul rulării dumneavoastră:

n Unscaled (Nescalat) – prezintă expresia genică normalizată nescalată.

n Highest (Cel mai ridicat) – scalează expresia genică normalizată pentru fiecare țintă, împărțind
nivelul expresiei fiecărei probe la cel mai ridicat nivel de expresie pentru toate probele.

Această opțiune de scalare folosește formula „scalat la cel mai ridicat nivel”.

n Lowest (Cel mai scăzut) – scalează expresia genică normalizată pentru fiecare țintă, împărțind
nivelul expresiei fiecărei probe la cel mai scăzut nivel de expresie pentru toate probele.

Această opțiune de scalare folosește formula „scalat la cel mai scăzut nivel”.

n Average (Mediu) – scalează expresia genică normalizată pentru fiecare țintă, împărțind nivelul
expresiei fiecărei probe la media geometrică a nivelurilor de expresie pentru toate probele.

Această opțiune de scalare folosește formula „scalat la nivel mediu”.

Tip de eroare

Selectați o opțiune pentru calcularea tipului de eroare (barele de eroare) din graficul Gene Expression
(Expresie genică).

n Standard error of the mean (default) (Eroarea standard a mediei (implicită))

n Standard deviation (Deviație standard)

Multiplicator bare de eroare din grafic

Selectați un multiplicator pentru barele de eroare din graficul Gene Expression (Expresie genică).
Selectați unul dintre aceste numere întregi:
+/- 1 (implicit), 2 sau 3. Tipul multiplicatorului se schimbă atunci când selectați tipul de eroare:

n SEMs pentru eroarea standard a mediei

n Std Devs pentru deviațiile standard

Setări experimente
Sfat: Această casetă de dialog este disponibilă și în Plate Editor (Editor placă). Pentru mai multe
informații, consultați Schimbarea setărilor experimentelor de la pagina 129.
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În caseta de dialog Experiment Settings (Setări experimente), puteți vizualiza sau modifica lista de
ținte sau probe, selecta genele de referință, selecta controalele sau seta grupul Gene Expression
Analysis (Analiză expresie genică) de analizat, dacă denumirile seturilor biologice au fost adăugate la
alveole.

Pentru a deschide caseta de dialog Experiment Settings (Setări experimente)

u În Bar Chart (Grafic cu bare), faceți clic pe Experiment Settings (Setări experimente) în partea de
jos a panoului din dreapta.

Apare caseta de dialog Experiment Settings (Setări experimente), care afișează fila Targets
(Ținte).

Pentru a ajusta setările pentru Targets (Ținte)

u În fila Targets (Ținte), urmați oricare dintre procedurile următoare:

n Pentru a selecta o țintă ca referință pentru analiza datelor expresiei genice, selectați
denumirea sa în coloana Reference (Referință).

n Pentru a schimba culoarea țintei, faceți clic pe celula corespunzătoare din coloana Color
(Culoare) și modificați culoarea în caseta de dialog Color (Culoare) care apare.

Schimbarea culorii apare în graficele Gene Expression (Expresie genică).

n Pentru a utiliza o valoare de eficiență determinată anterior, debifați caseta de selectare
aferentă țintei din coloana Auto Efficiency (Eficiență automată) și introduceți un număr pentru
procentul de eficiență al unei ținte.
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Software-ul calculează eficiența relativă a unei ținte folosind Auto Efficiency (Eficiență
automată), dacă datele pentru o țintă includ o curbă standard.

Pentru a ajusta setările pentru Sample (Probă)

u În fila Samples (Probe), urmați oricare dintre procedurile următoare:

n Pentru a selecta o probă drept control pentru analiza datelor expresiei genice, selectați
denumirea sa în coloana Control.

n Pentru a schimba culoarea probei, faceți clic pe celula corespunzătoare din coloana Color
(Culoare) și schimbați culoarea în caseta de dialog Color (Culoare) care apare.

Schimbarea culorii apare în graficele Gene Expression (Expresie genică).

n Pentru a afișa proba în graficele Gene Expression (Expresie genică), selectați-o în coloana
Show Chart (Afișare grafic).

n Pentru a elimina proba din graficele Gene Expression (Expresie genică), debifați-o în
coloana Show Chart (Afișare grafic).

Sfat: Datele probei rămân în tabelul Results (Rezultate).

Pentru a modifica selecția Biological Set Analysis Options (Opțiuni analiză set biologic)

u Dacă atribuiți unul sau mai multe seturi biologice alveolelor de pe placă (consultați Atribuirea de
seturi biologice alveolelor de la pagina 122), lista Biological Set Analysis Options (Opțiuni analiză
set biologic) afișează caseta de dialog Experiment Settings (Setări experimente), permițându-vă
să modificați selecția după necesități.

n Target vs. Sample (Țintă vs. Probă) – numai denumirea probei din alveolă este utilizată în
calculele expresiei genice.

n Target vs. Biological Set (Țintă vs. Set biologic) – numai denumirea setului biologic este
utilizată în calcule.

n Target vs. Sample_Biological Set (Țintă vs. Probă_Set biologic) – denumirea probei și
denumirea setului biologic se combină pentru a crea un nume unic utilizat în calcule.

n Target vs. Biological Set_Sample (Țintă vs. Set biologic_Probă) – denumirea setului
biologic și denumirea probei se combină pentru a crea un nume unic utilizat în calcule.
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Pentru a exclude un tip de probă din calculele analizei

u Bifați caseta de selectare aferentă din partea de jos a casetei de dialog Experiment Settings
(Setări experimente).

Observație: Aceasta exclude controalele și/sau standardele din analiza expresiei genice.

Valoarea stabilității țintei
Valorile stabilității țintei sunt calculate ori de câte ori se utilizează mai mult decât o genă de referință.
CFX Manager Dx software calculează doi parametri de calitate pentru genele de referință:

n Varianța coeficienților (VC) pentru cantitățile relative ale genelor de referință normalizate.
O valoare VC mai mică denotă o stabilitate mai mare.

n Valoarea M (M), o măsură a stabilității expresiei genice de referință.

Valorile VC și M recomandate sunt afișate în partea de jos a casetei de dialog Stability Value (Valoare
stabilitate).

Pentru a vizualiza valoarea stabilității țintei

u În fila Gene Expression Bar Chart (Grafic cu bare expresie genică), faceți clic pe Target Stability
Value (Valoarea stabilității țintei) în partea de jos a panoului din dreapta.

Apare caseta de dialog Stability Value (Valoare stabilitate).

Opțiunile de meniu afișate prin clic dreapta
Faceți clic dreapta pe graficul expresiei genice pentru a selecta elementele afișate în Tabelul 34.

Element Funcție

Copy (Copiere) Copiază graficul pe clipboard.

Save Image As (Salvați
imaginea ca)

Salvează graficul ca fișier imagine. Configurați rezoluția și
dimensiunile imaginii, apoi selectați tipul fișierului (PNG, GIF, JPG,
TIF sau BMP).

Page Setup (Configurare
pagină)

Selectează configurarea paginii pentru imprimare.

Print (Imprimare) Imprimă graficul.

Tabelul 34. Elementele de meniu afișate prin clic dreapta pentru expresia genică
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Element Funcție

Set Scale to Default (Setare
scară la implicit)

Show All (Afișare toate) afișează toate datele din graficul cu bare.
Scroll Bar (Bară de defilare) afișează o bară de defilare dacă există
prea multe probe de afișat în cadrul graficului, menținând o lățime
minimă a barei.

Chart Options (Opțiuni grafic) Deschide fereastra Chart Options (Opțiuni grafic), pentru a ajusta
graficul.

Sort (Sortare) Sortează ordinea probelor sau țintelor care apar pe axa x a
graficului.

Use Corrected Std Devs
(Utilizare deviații standard
corectate)

Calculează barele de eroare utilizând formula deviației standard
corectate.

Use Solid Bar Colors (Utilizare
culori compacte bare)

Afișează barele compacte din grafic.

X–Axis Labels (Etichete axă x) Afișează etichetele axei x pe orizontală sau în unghi.

Tabelul 34. Elementele de meniu afișate prin clic dreapta pentru expresia genică, continuare

Foaia de calcul Data (Date)
Tabelul 35 definește datele afișate în tabelul de date Gene Expression (Expresie genică).

Observație: Valorile din tabel sunt calculate pe baza tipului de grafic și a preferințelor selectate în
panoul din dreapta.

Informație Descriere

Țintă Denumirea țintei (genă amplificată) selectată în fereastra
Experiment Settings (Setări experimente).

Probă Denumirea probei și/sau a grupului biologic selectată în fereastra.

Ctrl Denumirea controlului selectat în fereastra Experiment Settings
(Setări experimente).

Cantitate relativă sau
Expresie

Cantitate relativă (ΔCq) sau Expresie genică normalizată (ΔΔCq), în
funcție de modul selectat.

Tabelul 35. Descrierea informațiilor din foaia de calcul din fila Reprezentare graficăGrafic cu
bare
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Informație Descriere

SEM (sau SD) pentru cantitate
relativă sau expresie

Eroarea standard a mediei (SEM) sau deviația standard (SD) a
cantității relative sau a expresiei normalizate, în funcție de opțiunea
selectată.

SEM (sau SD) corectată pentru
cantitate relativă sau expresie

Calculul valorii corectate pentru SEM sau SD a cantității relative sau
a expresiei normalizate, în funcție de opțiunea selectată.

Medie Cq Media ciclului de cuantificare.

SEM (sau SD) Cq SEM sau SD a ciclului de cuantificare, în funcție de opțiunea
selectată.

Opțiunea Show Details (Afișare detalii)
Tabelul 36 definește datele afișate când este selectată opțiunea Show Details (Afișare detalii) din
meniul clic dreapta al foii de calcul a graficului cu bare.

Informație Descriere

Set de date Date privind fluorescența de la un fluorofor din fișierul de date

Cantitate relativă Cantitatea relativă calculată a probelor

SD cantitate relativă Deviația standard a calculării cantității relative

SD cantitate relativă corectată Deviația standard calculată a cantității relative corectate

SEM cantitate relativă Eroarea standard a mediei calculării cantității relative

SEM cantitate relativă corectată Eroarea standard a mediei calculării cantității relative corectate

Cantitate relativă(lg) Log2 al cantității relative utilizate pentru analiza statistică

SD RQ(lg) Deviația standard a cantității relative (log2)

SEM expresie(lg) Eroarea standard a mediei expresiei (log2)

Expresie nescalată Expresia nescalată calculată

SD expresie nescalată Deviația standard calculată a expresiei nescalate

Tabelul 36. Informațiile din foaia de calcul a graficului cu bare cu opțiunea Show Details
(Afișare detalii) selectată
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Informație Descriere

SD expresie nescalată
corectată

Deviația standard calculată a expresiei nescalate corectate

SEM expresie nescalată Eroarea standard a mediei calculată a expresiei nescalate

SEM expresie nescalată
corectată

Eroare standard a mediei calculată a expresiei nescalate corectate

Expresie nescalată(lg) Log2 al expresiei nescalate

SD expresie nescalată(lg) Deviația standard a expresiei nescalate (log2)

SEM expresie nescalată(lg) Eroarea standard a mediei expresiei nescalate (log2)

Expresie Expresie genică normalizată

SD expresie corectată Deviația standard calculată

SEM expresie Eroarea standard a mediei

SEM expresie corectată Eroarea standard a mediei calculată

Expresie(lg) Log2 al expresiei (expresia normalizată) utilizate pentru analiza
statistică

SD expresie(lg) Deviația standard a expresiei (log2)

SEM expresie(lg) Eroarea standard a mediei expresiei (log2)

Medie Cq Media ciclului de cuantificare

SD Cq Deviație standard a ciclului de cuantificare

SEM Cq Eroarea standard a mediei ciclului de cuantificare

Tabelul 36. Informațiile din foaia de calcul a graficului cu bare cu opțiunea Show Details
(Afișare detalii) selectată, continuare
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Clustergramă
Clustergrama afișează datele într-o ierarhie bazată pe gradul de similaritate a expresiei pentru
diferitele ținte și probe.

Observație: Trebuie să alegeți o țintă de referință pentru a afișa oricare dintre reprezentările
grafice de date, în afară de expresia relativă pentru graficele cu bare.

Imaginea clustergramei descrie expresia relativă a unei probe sau ținte, după cum urmează:

n Reglare pozitivă (roșu) – expresie mai mare

n Reglare negativă (verde sau albastru) – expresie mai mică

n Nicio reglare (negru)

n Nicio valoare calculată (negru cu un X alb)

Cu cât nuanța culorii este mai deschisă, cu atât mai mare este diferența expresiei relative. Dacă nu se
poate calcula nicio valoare Cq normalizată, pătratul va fi negru cu un X alb.

Pe marginile exterioare ale graficului de date se găsește o dendrogramă, care indică ierarhia de
clustering. Țintele sau probele care au tipare de expresie similare vor avea ramuri adiacente, iar cele
cu tipare nesimilare vor fi mai depărtate.

Setări
Puteți seta următoarele opțiuni:

n Cluster By (Grupare după) – alegeți dintre Targets (Ținte), Samples (Probe), Both (Ambele) sau
None (Niciuna).

n Size (Dimensiune) – ajustează dimensiunea imaginii și modifică gradul de mărire a graficului.

n Split Out Replicates (Replicate individuale) – afișează valoarea pentru replicatele individuale.

Sfat: Puteți schimba schema de culoare pentru clustergramă și corelogramă de la setarea implicită
Red/Green (Roșu/Verde) la Red/Blue (Roșu/Albastru) selectând această opțiune din meniul clic
dreapta din oricare dintre aceste grafice.

Opțiunile de meniu afișate prin clic dreapta
Opțiunile de meniu afișate prin clic dreapta pentru clustergramă sunt aceleași cu cele pentru graficul
cu bare. Consultați Tabelul 34 de la pagina 233 pentru opțiunile disponibile. De asemenea, selectați
Color Scheme (Schemă de culori) pentru a modifica expresia de reglare negativă de la setarea
implicită Red/Green (Roșu/Verde) la Red/Blue (Roșu/Albastru) pe grafic.
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Foaia de calcul Data (Date)
Foaia de calcul afișează valorile pentru țintă, probă și expresia normalizată. Faceți clic pe caseta de
selectare de lângă o țintă pentru a o include sau a o exclude din reprezentarea grafică.
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Corelogramă
Corelograma afișează expresia normalizată a țintelor pentru un control versus o probă experimentală. Liniile
din grafic indică pragul de reglare. Punctele de date dintre linii indică faptul că diferența de expresie pentru
ținta (gena) respectivă este neglijabilă între probe. Punctele de date din afara liniilor depășesc pragul de
reglare și ar putea fi de interes.

Imaginea din grafic afișează următoarele modificări în expresia țintă pe baza pragului de reglare:

n Reglare pozitivă (cerc roșu) – expresie relativ mai mare

n Reglare negativă (cerc verde sau albastru) – expresie relativ mai mică

n Nicio schimbare (cerc negru)

Faceți clic pe și trageți oricare linie de prag pentru a ajusta valoarea de prag a reglării.

Setări
Puteți seta următoarele opțiuni:

n Probă de control

n Probă experimentală

n Pragul de reglare. Pe măsură ce măriți sau micșorați valoarea de reglare, liniile de prag din grafic
se mută și ele în mod corespunzător.

Opțiunile de meniu afișate prin clic dreapta
Opțiunile de meniu afișate prin clic dreapta pentru corelogramă sunt aceleași cu cele pentru graficul cu
bare. Consultați Tabelul 34 de la pagina 233 pentru opțiunile disponibile. În plus, selectați Symbol
(Simbol) pentru a schimba simbolul utilizat pe grafic din cercul implicit în unul dintre următoarele:

n Triunghi

n Cruce

n Pătrat

n Romb
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Foaia de calcul Data (Date)
Foaia de calcul afișează valorile pentru țintă și expresia normalizată pentru proba de control și proba
experimentală. Indică, de asemenea, dacă țintele sunt reglate pozitiv sau negativ în comparație cu
pragul de reglare. Faceți clic pe caseta de selectare de lângă o țintă pentru a o include sau a o exclude
din reprezentarea grafică.
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Results (Rezultate)
Fila Rezultate oferă o foaie de calcul care sintetizează datele din toate graficele. Tabelul 37 definește
datele afișate în foaia de calcul Rezultate.

Informație Descriere

Target (Țintă) Denumirea țintei (genă amplificată)

Sample (Probă) Denumire probă

Mean Cq (Medie Cq) Media ciclului de cuantificare

Mean Efficiency Corrected Cq
(Cq corectată eficient medie)

Media ciclului de cuantificare după ajustarea pentru eficiența
reacțiilor

Normalized Expression
(Expresie normalizată)

Expresia țintei normalizată în funcție de o țintă de referință (ΔΔCq)

Relative Normalized
Expression (Expresie
normalizată relativă)

Expresie normalizată relativă la o probă de control; denumită și Fold
Change (Schimbarea factorului)

Regulation (Reglare) Modificare a expresiei relativă la o probă de control

Compared to Regulation
Threshold (Comparativ cu
pragul de reglare)

Reglare pozitivă sau negativă a unei probe experimentale bazată pe
setarea pragului

Tabelul 37. Informațiile din fila Rezultate

Observație: Datele pentru replicate se găsesc numai în foile de calcul ale filelor de analiză a
datelor în care s-a selectat Split Out Replicates (Replicate individuale) (respectiv Clustergram
(Clustergramă)). Poate exista o discrepanță între datele de expresie din foile de calcul de analiză
a expresiei genice dacă selectați „none” (niciuna) drept probă de control pe graficul cu bare.
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Studiu genic
Creați un studiu genic pentru a compara datele de expresie genică de la unul sau mai multe
experimentePCR în timp real folosind un calibrator între rulări pentru normalizare între experimente.
Creați un studiu genic adăugând date din unul sau mai multe fișiere de date (extensia .pcrd) la studiul
genic. Software-ul le grupează într-un fișier unic (extensie .mgxd).

Observație: Numărul maxim de probe pe care le puteți analiza într-un studiu genic este limitat de
mărimea memoriei RAM a computerului și de memoria virtuală.

Inter-run Calibration (Calibrare între rulări)
Inter-run calibration (Calibrare între rulări) este încercată automat în fiecare studiu genic pentru fiecare
țintă pentru a normaliza variațiile între rulări între țintele testate în rulări PCR în timp real separate (cu
alte cuvinte, fișiere .pcrd generate din plăci diferite).

Pentru ca software-ul să recunoască o probă drept calibrator între rulări, aceasta trebuie să aibă
același nume de țintă, nume de probă și, dacă este utilizat, același nume de set biologic pe fiecare
placă comparată.

Observație: Cel puțin o probă calibrator între rulări trebuie să fie prezentă în studiul genic pentru
a avea loc calibrarea între rulări. Țintele fără probe calibrator între rulări adecvate vor fi procesate
fără corecție în studiul genic (nerecomandat).

Calibrările între rulări pot fi aplicate în două moduri:

n Per țintă – diferiți primeri PCR pot avea eficiențe diferite. În mod implicit, calibratorul între rulări
este aplicat tuturor alveolelor unei placi care au aceeași denumire a țintei de amplificare, de
exemplu Cq generată cu același test.

n Întregul studiu – un calibrator între rulări este selectat de utilizator și aplicat întregului studiu
genic.

Caseta de dialog Gene Study (Studiu genic)
Caseta de dialog Gene Study (Studiu genic) include două file:

n Fila Study Setup (Configurare studiu) – gestionează rulările din studiul genic.

Important: Adăugarea sau eliminarea fișierelor de date într-un studiu genic nu modifică
datele din fișierul original.

n Fila Study Analysis (Analiză studiu) – afișează datele de expresie genică pentru rulările
combinate.
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Fila Study Setup (Configurare studiu)
Tabelul 38 definește datele care apar în fila Study Setup (Configurare studiu).

Titlu coloană Descriere

File Name (Nume fișier) Denumirea fișierului de date pentru rulare (extensie pcrd)

File Folder (Folder fișiere) Director care stochează fișierul de date pentru fiecare rulare din studiul
genic

Date Created (Data creării) Data la care au fost colectate datele rulării

Well Group Name (Nume
grup alveole)

Numele grupului de alveole care a fost selectat atunci când fișierul a
fost adăugat la studiul genic

Sfat: Pentru a analiza un grup de alveole din studiul genic, trebuie
să selectați acel grup de alveole din fereastra Data Analysis
(Analiză date) înainte de a importa fișierul de date în studiul genic.

Step (Pas) Pas de protocol care include citirea de placă pentru colectarea datelor
PCR în timp real

Run Type (Tip rulare) Rulare definită de utilizator sau rulare PrimePCR

Protocol Edited (Protocol
editat)

Dacă este selectată, indică faptul că protocolul utilizat pentru o rulare
PrimePCR a fost editat

View Plate (Vizualizare
placă)

Deschide o hartă de placă a plăcii cu datele din fiecare rulare inclusă în
studiul genic

Tabelul 38. Fila Study Setup (Configurare studiu) din caseta de dialogGene Study (Studiu
genic)

Pregătirea unui studiu genic
Pentru a pregăti un studiu genic

1. Înainte de a importa datele într-un studiu genic, efectuați următoarele în fereastra Data Analysis
(Analiză date):

n Verificați că probele cu același conținut au același nume. Într-un studiu genic, software-ul
presupune că alveolele cu același nume pentru Target (Țintă) sau Sample (Probă) conțin
aceleași probe.

n Ajustați nivelul inițial și pragul (Cq) în fila Quantification (Cuantificare) pentru a optimiza
datele din fiecare rulare.

n Selectați grupul de alveole pe care doriți să îl includeți în studiul genic.
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Pentru a afișa date de la un grup de alveole în studiul genic, grupul respectiv trebuie să fie
selectat înainte de a importa fișierul de date.

FilaStudy Setup (Configurare studiu) afișează o listă a tuturor rulărilor din studiul genic.

2. În caseta de dialogGene Study (Studiu genic) selectați fila Study Setup (Configurare studiu).

3. Faceți clic pe Add Data Files (Adăugare fișiere de date) pentru a selecta un fișier din fereastra
browser-ului.

Sfat: Pentru a adăuga rapid rulări la un studiu genic, trageți fișierele de date (extensia .pcrd)
în caseta de dialog Study Setup (Configurare studiu).

4. CFX Manager Dx software efectuează automat analiza studiului genic pe măsură ce adăugați
fișiere de date. Selectați fila Study Analysis (Analiză studiu) pentru a vizualiza rezultatele.

Pentru a elimina rulări din studiul genic

u Selectați unul sau mai multe fișiere din listă și faceți clic pe Remove (Eliminare).

Pentru a adăuga observații despre studiul genic

u Introduceți observații despre fișiere și analiză în caseta de dialog Notes (Observații).

Fila Study Analysis (Analiză studiu)
Fila Study Analysis (Analiză studiu) afișează datele de la toate rulările din studiul genic. Opțiunile de
analiză pentru datele de expresie genică sunt aceleași cu cele pentru un fișier de date unic, cu
următoarea excepție:

n Pentru graficele cu bare, valorile de calibrare între rulări (dacă sunt calculate) apar atunci când
faceți clic peInter-run Calibration (Calibrare între rulări).

Observație: Numai următoarele tipuri de probe pot fi utilizate drept calibrator între rulări:

o Unknown (Necunoscută)

o Standard

o Positive Control (Control pozitiv)

Tipurile de probe Negative Control (Control negativ), no template control (control fără ținta de
amplificare) (NTC) și no reverse transcriptase control (control fără transcriptază inversă) (NRT)
nu pot fi utilizate drept calibrator între rulări.
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Crearea unui raport de studiu genic
Pentru a crea un raport de studiu genic

1. Ajustați datele raportului de studiu genic și graficele după caz înainte de a crea un raport.

2. Selectați Tools > Reports (Instrumente > Rapoarte) din meniul Gene Study (Studiu genic) pentru
a deschide caseta de dialog Report (Raport).

3. Alegeți opțiunile pe care doriți să le includeți în raport. Raportul se deschide cu opțiunile implicite
selectate. Bifați sau debifați casetele de selectare pentru a schimba categorii întregi sau opțiuni
individuale dintr-o categorie.

Categoriile raportului de studiu genic de la pagina 245 listează opțiunile disponibile pentru afișare.

4. Schimbați ordinea categoriilor și elementelor dintr-un raport. Trageți opțiunile în poziția necesară.
Elementele pot fi reordonate doar în cadrul categoriilor cărora le aparțin.

5. Faceți clic pe Update Report (Actualizare raport) pentru a actualiza Report Preview
(Previzualizare raport) cu orice modificări.

6. Imprimați sau salvați raportul. Faceți clic pe butonul Print Report (Imprimare raport) de pe bara de
instrumente pentru a imprima raportul curent. Selectați File > Save (Fișier > Salvare) pentru a
salva raportul în format PDF (fișier Adobe Acrobat Reader) și selectați o locație în care să salvați
fișierul. Selectați File > Save As (Fișier > Salvare ca) pentru a salva raportul cu o nouă denumire
sau într-un nou loc.

7. (Opțional) Creați un șablon de raport cu informațiile pe care le doriți. Pentru a salva setările
raportului curent într-un șablon, selectați Template > Save (Șablon > Salvare) sau Save As
(Salvare ca). Apoi încărcați șablonul raportului data viitoare când doriți să creați un raport nou.

Categoriile raportului de studiu genic
Folosiți caseta de dialog Gene Study Report (Raport studiu genic) pentru a aranja datele studiului
genic într-un raport. Tabelul 39 listează toate opțiuni disponibile pentru un raport de studiu genic.

Categorie Opțiune Descriere

Header (Antet)

Titlu, subtitlu și logo pentru raport

Tabelul 39. Categoriile unui raport de studiu genic
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Categorie Opțiune Descriere

Report Information
(Informații raport)

Data, numele utilizatorului, denumirea fișierului
de date, calea fișierului de date și grupul de
alveole selectat

Gene Study File List (Lista
fișierelor studiului genic)

Lista tuturor fișierelor de date din studiul genic

Notes (Observații) Observații despre raportul de date

Study Analysis: Bar Chart (Analiză studiu: Grafic cu bare)

Analysis Settings (Setări
analiză)

Lista parametrilor de analiză selectați

Chart (Grafic) Graficul cu bare al expresiei genice care
afișează datele

Target Names (Denumiri
ținte)

Lista țintelor din studiul genic

Sample Names (Denumiri
probe)

Lista probelor din studiul genic

Data (Date) Foaie de calcul care afișează datele

Target Stability
(Stabilitatea țintei)

Date privind stabilitatea țintei

Inter-run Calibration
(Calibrare între rulări)

Date de calibrare între rulări

Study Analysis (Analiză studiu): clustergramă și corelogramă

Analysis Settings (Setări
analiză)

Setări pentru fiecare tip de grafic

Chart (Grafic) Graficul expresiei genice care afișează datele

Data (Date) Foaie de calcul care listează datele din fiecare
țintă

Tabelul 39. Categoriile unui raport de studiu genic, continuare
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Anexa A Calcule Analiză date
CFXManager Dx software calculează automat formulele și afișează rezultatele în filele Data Analysis
(Analiză date). Această anexă explică în detaliu cum calculează CFX Manager Dx software formulele.

Eficiența reacțiilor
Dovezile sugerează că utilizarea unei modalități exacte de măsură a eficiențelor pentru fiecare primer
și set de sonde va determina rezultate mai exacte la analiza datelor de expresie genică. Valoarea
implicită a eficienței utilizată în calculele de expresie genică este 100 %. Pentru a evalua eficiența
reacțiilor, generați o curbă standard utilizând diluții în serie ale unei probe reprezentative la nivelul unui
interval dinamic relevant și apoi înregistrați eficiența pentru analiza ulterioară a expresiei genice. Dacă
rularea dumneavoastră include o curbă standard, atunci software-ul va calcula automat eficiența și o
va afișa sub Standard Curve (Curbă standard) în fila Quantification (Cuantificare), când Auto
Efficiency (Eficiență automată) este bifată în fila Targets (Ținte) din fereastra Experiment Settings
(Setări experimente).

Eficiența (E) din formulele de eficiență se referă la „eficiențele” descrise de Pfaffl (2001) și
Vandesompele et al. (2002). În aceste publicații, o eficiență de 2 (dublarea perfectă cu fiecare ciclu)
este echivalentă cu o eficiență de 100 % în acest software. Aveți posibilitatea să convertiți calculele
dumneavoastră de eficiență în cele utilizate de software, utilizând următoarele relații matematice:

n E = (% eficiență * 0,01) + 1

n % eficiență = (E – 1) * 100
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Cantitate relativă
Formula pentru cantitatea relativă (ΔCq) pentru orice probă (GOI) este:

Observație: Această formulă este utilizată la calcularea cantității relative atunci când nu s-a
definit o probă de control.

Unde:

n E = Eficiența primerului și a setului de sonde. Această eficiență este calculată cu ajutorul formulei
(% eficiență * 0,01) + 1, unde 100 % eficiență = 2

n C q (min) = Cq medie pentru proba cu cel mai mic Cqmedie pentru GOI

n C q (probă) = Cqmedie pentru probă

n GOI = Genă de interes (o țintă)

Cantitatea relativă când este selectat un control
Atunci când se atribuie o probă de control, cantitatea relativă (RQ) pentru orice probă care include o
genă de interes (GOI) este calculată după următoarea formulă:

Unde:

n E = Eficiența primerului și a setului de sonde. Această eficiență este calculată cu ajutorul formulei
(% eficiență * 0,01) + 1, unde 100% eficiență = 2

n Cq (control) = Cqmedie pentru proba de control

n Cq (probă) = Cqmedie pentru orice probe cu GOI

n GOI = Genă de interes (o țintă)
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Deviația standard a cantității relative
Formula pentru deviația standard a cantității relative este

Unde:

n SD Relative Quantity = Deviația standard a cantității relative

n SD CqGOI sample = Deviația standard a Cq pentru probă (GOI)

n Relative Quantity = Cantitatea relativă a probei

n E = Eficiența primerului și a setului de sonde. Această eficiență este calculată cu ajutorul formulei
(% eficiență * 0,01) + 1, unde 100% eficiență = 2

n GOI = Genă de interes (o țintă)

Cq corectată eficient (CqE)
Formula pentru Cq corectată eficient este

Unde:

n E = Eficiență

Cq corectată eficient medie (MCqE)
Formula pentru Cq corectată eficient medie este

Unde:

n CqE = Cq corectată eficient

n n = Numărul de replicări

Factor de normalizare
Numitorul ecuației expresiei normalizate se numește factor de normalizare. Factorul de
normalizare reprezintă media geometrică a cantităților relative ale tuturor țintelor
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(genelor) de referință pentru o probă dată, conform descrierii din această formulă:

Unde:

n RQ = Cantitate relativă

n n = Numărul de ținte de referință

n GOI = Genă de interes (o țintă)
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Expresie normalizată
Expresia normalizată (ΔΔCq) este cantitatea relativă a țintei (genei) normalizată la cantitățile țintelor
de referință (gene sau secvențe) din sistemul dumneavoastră biologic. Pentru a selecta țintele de
referință, deschideți fereastra Experiment Settings (Setări experimente) și faceți clic pe coloana de
referință pentru fiecare țintă care servește drept genă de referință.

Formula pentru expresia normalizată, care folosește metoda de calcul a Cantității relative (RQ)
calculate, este

Unde:

n RQ = Cantitatea relativă a unei probe

n Ref = Ținta de referință dintr-o rulare, care include una sau mai multe ținte de referință în fiecare
probă

n GOI = Genă de interes (o țintă)

Cu condiția ca țintele de referință să nu își modifice nivelul de expresie din sistemul dvs. biologic,
calcularea expresiei normalizate va lua în considerare diferențele de încărcare sau variațiile numărului
de celule care sunt reprezentate în fiecare dintre probele dvs.

Expresia normalizată când este selectat un control
Când selectați o probă de control din fereastra Experiment Settings (Setări experimente), software-ul
setează nivelul de expresie al probei de control la 1. În această situație, software-ul normalizează
cantitățile relative ale tuturor expresiilor țintelor (genelor) la cantitatea de control (o valoare de 1).
Această expresie normalizată este echivalentă cu analiza expresiei normalizate nescalate atunci când
este selectat un control.

Observație: Aceasta este cunoscută și sub denumirea de expresie normalizată relativă (RNE) și
schimbare de ondulație.
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Deviația standard pentru expresia normalizată
Rescalarea valorii expresiei normalizate este realizată împărțind deviația standard a expresiei
normalizate la valoarea expresiei normalizate pentru cele mai ridicate sau cele mai scăzute niveluri
individuale de expresie, în funcție de opțiunea de scalare aleasă. Formula pentru deviația standard
(SD) a factorului de normalizare este

Unde:

n RQ = Cantitatea relativă a unei probe

n SD = Deviația standard

n NF = Factor de normalizare

n Ref = Țintă de referință

n n = Numărul de ținte de referință

Când se atribuie o probă de control, nu este nevoie să aplicați această funcție de rescalare pentru
deviația standard, după cum se arată în formula de mai jos:

Unde:

n NE = Expresia normalizată

n RQ = Cantitatea relativă a unei probe

n SD = Deviația standard

n GOI = Genă de interes (o țintă)
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Expresia normalizată scalată la cel mai ridicat nivel de
expresie

Când rularea nu include controale, scalați expresia normalizată (NE) pentru fiecare țintă (genă)
împărțind nivelul expresiei fiecărei probe la cel mai ridicat nivel de expresie pentru toate probele.
Software-ul stabilește cel mai ridicat nivel de expresie la o valoare de 1 și rescalează toate niveluri de
expresie ale probelor. Formula celei mai ridicate scalări este

Unde:

n GOI = Gena de interes (țintă)

Expresia normalizată scalată la cel mai redus nivel de
expresie

Când rularea nu include controale, scalați expresia normalizată (NE) pentru fiecare țintă (genă)
împărțind nivelul expresiei fiecărei probe la cel mai redus nivel de expresie pentru toate probele.
Software-ul stabilește cel mai redus nivel de expresie la o valoare de 1 și rescalează toate nivelurile de
expresie ale probelor. Formula celei mai reduse scalări este

Unde:

n GOI = Gena de interes (țintă)

Expresia normalizată scalată la nivelul de expresie mediu
Când rularea nu include controale, scalați expresia normalizată (NE) pentru fiecare țintă (genă),
împărțind nivelul expresiei fiecărei probe la media geometrică a expresiei pentru toate probele.
Software-ul stabilește nivelul mediu de expresie la o valoare de 1 și rescalează toate nivelurile de
expresie ale probelor. Formula scalării medii este

Unde:

n GOI = Gena de interes (țintă)

n GM =Media geometrică a expresiei normalizate pentru toate probele
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Deviația standard pentru expresia normalizată scalată
Rescalarea valorii expresiei normalizate (NE) este realizată împărțind deviația standard (SD) a
expresiei normalizate la valoarea expresiei normalizate pentru cele mai ridicate (MAX) sau cele mai
scăzute (MIN) niveluri de expresie, în funcție de opțiunea de scalare aleasă.

Observație: Când se atribuie o probă de control, nu este nevoie să aplicați această funcție de
rescalare pentru deviația standard.

Calculul pentru această formulă este

Unde:

n NE = Expresia normalizată

n SD = Deviația standard

n GOI = Gena de interes (țintă)

n MAX = Cel mai ridicat nivel de expresie

n MIN = Cel mai scăzut nivel de expresie

Reglarea
Reglarea măsoară mărirea sau micșorarea expresiei unei ținte pentru o probă experimentală față de
o probă de control și se determină astfel:

Dacă Expresie (experimentală) > Expresie (control):

Dacă Expresie (experimentală) < Expresie (control):

Observație: Pentru graficul cu bare, Expresia se bazează fie pe cantitatea relativă, fie pe
expresia normalizată, în funcție de modul selectat (consultați Grafic cu bare de la pagina 226). Cu
toate acestea, pentru corelogramă și clustergramă, reglarea este calculată întotdeauna pe baza
expresiei normalizate.
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Formule valori corectate
O diferență între valorile corectate și valorile necorectate este observată doar dacă este creată o
curbă standard ca parte a rulării PCR în timp real. Software-ul folosește trei ecuații pentru a determina
propagarea erorilor:

n Eroare standard

n Eroare standard pentru expresie normalizată

n Eroare standard pentru gena de interes normalizată (țintă)

Formula pentru eroarea standard este

Unde:

n n = Numărul de ținte (gene) de referință

n SD = Deviația standard

Eroarea standard pentru factorul de normalizare din formula expresiei normalizate este

Unde:

n n = Numărul de ținte de referință

n SE = Eroare standard

n NF = Factor de normalizare

n RQ = Cantitate relativă

Formula erorii standard pentru gena de interes (GOI) normalizată este

Unde:

n SE = Eroare standard

n GOI = Genă de interes (o țintă)

n NF = Factor de normalizare

n n = Numărul de ținte de referință
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Anexa B Gestionarea utilizatorilor și rolurilor CFX
Manager Dx

În CFX Manager Dx software, puteți crea utilizatori și aloca un rol respectivilor utilizatori. Rolurile
limitează accesul la funcțiile CFX Manager Dx. Unui utilizator i se poare aloca un singur rol la un
moment dat. Cu toate acestea, un administrator de CFX Manager Dx software poate schimba rolul
utilizatorului în orice moment.

Sfat: Nu este necesar să creați utilizatori pentru a utiliza CFX Manager Dx. Dacă nu creați
utilizatori, toată activitatea este efectuată de contul de utilizator implicit admin.

Important: Utilizatorul admin este contul Administrator implicit, pe care îl utilizați pentru a vă
autentifica inițial în CFX Manager Dx. Se recomandă să creați un utilizator specific pentru a
administra CFX Manager Dx. Alocați acestui utilizator rolul de Administrator și efectuați toate
sarcinile de administrare cu acest utilizator.

Important: CFXManager Dx software nu are nicio funcție de expirare a sesiunii utilizatorului
pentru inactivitate. Așadar, este recomandat să implementați măsuri de securitate Windows sau
terțe (de exemplu, implementați un economizor de ecran cu autentificare obligatorie).

Gestionarea utilizatorilor
În ediția standard a CFX Manager Dx software, conturile de utilizator pot avea orice nume sau parolă.

Pentru a aloca un rol fiecărui utilizator, selectați din lista de roluri din fereastra User Administration
(Administrare utilizatori). În acest exemplu, utilizatorul Guest (Invitat) primește dreptul adăugat de a
salva fișiere.

Adăugarea și ștergerea utilizatorilor
Observație: Doar administratorul CFX Manager Dx poate adăuga și șterge utilizatori.

Pentru a adăuga conturi de utilizator la CFX Manager Dx

1. Din fereastra Home (Fereastră de pornire), selectați User > User Administration (Utilizator >
Administrare utilizatori).

Va apărea caseta de dialog User Administration (Administrare utilizatori).
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2. În panoul Manage Users (Gestionare utilizatori), introduceți un nume de utilizator pentru utilizator.

3. Selectați un Role (Rol) pentru utilizator.

Rolurile restricționează drepturile utilizatorului. Rolul implicit este Principal.

Sfat: Puteți modifica drepturile pentru fiecare rol în parte. Modificarea dreptului rolului
afectează toți utilizatorii cărora li s-a atribuit rolul respectiv. Pentru mai multe informații,
consultați Gestionarea drepturilor rolurilor de la pagina 259.

4. (Opțional) Introduceți Full Name (Nume complet) și Password (Parolă) pentru utilizator.

5. Faceți clic pe OK pentru a deschide o casetă de dialog și pentru a confirma că doriți să închideți
fereastra.

6. Faceți clic pe Yes (Da) pentru a închide caseta de dialog și fereastra.

Pentru a șterge un utilizator

1. În panoul Manage Users (Gestionare utilizatori), selectați Remove (Ștergere) pentru fiecare
utilizator pe care doriți să-l ștergeți.

2. Faceți clic pe OK pentru a deschide o casetă de dialog și pentru a confirma că doriți să închideți
fereastra.

3. Faceți clic pe Yes (Da) pentru a închide caseta de dialog și fereastra.

Observație: Lista utilizatorilor software-ului trebuie să includă întotdeauna un Administrator.
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Gestionarea drepturilor rolurilor
CFXManager Dx include aceste patru roluri:

n Administrator (obligatoriu) – administratorii au toate drepturile și nu le puteți modifica drepturile.
Administratorii pot, de asemenea, adăuga și șterge utilizatori și modifica drepturile pentru fiecare
rol în parte.

Observație: Doar un administrator poate modifica drepturile pentru fiecare rol în parte.

n Principal – implicit, utilizatorul principal deține toate drepturile

n Operator – implicit, utilizatorul operator deține toate drepturile, mai puțin omiterea ciclurilor

n Invitat – implicit, utilizatorul invitat poate doar citi fișiere

Important: Modificarea drepturilor unui rol afectează toți utilizatorii cărora li s-a atribuit rolul
respectiv. Nu puteți particulariza un rol pentru un anumit utilizator. Procedați cu atenție când
modificați drepturile rolurilor.

Pentru a specifica drepturile pentru fiecare rol în parte

1. Din fereastra Home (Fereastră de pornire), selectați User > User Administration (Utilizator >
Administrare utilizatori).

2. În panoul Manage Rights (Gestionare drepturi), urmați una dintre procedurile următoare:

n Pentru a elimina un drept al unui rol, debifați caseta de selectare aferentă.

n Pentru a adăuga un drept unui rol, bifați caseta de selectare aferentă.

3. Faceți clic pe OK pentru a deschide o casetă de dialog și pentru a confirma că doriți să închideți
fereastra.

4. Faceți clic pe Yes (Da) pentru a închide caseta de dialog și fereastra.

Pentru a reseta toate drepturile pentru toate rolurile

u În caseta de dialog User Administration (Administrare utilizatori), faceți clic pe Restore Default
Rights (Restaurare drepturi implicite).
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Autentificarea în CFX Manager Dx software
CFXManager Dx software gestionează cine se autentifică în software prin caseta de dialog Login
(Autentificare). Când inițializați software-ul, CFX Manager Dx afișează automat caseta de dialog Login
(Autentificare) atunci când doi sau mai mulți utilizatori sunt listați în fereastra User Administration
(Administrare utilizatori).

CFX Manager Dx afișează numele utilizatorului autentificat în partea de sus a ferestrei Home
(Fereastră de pornire).

Pentru autentificarea în CFX Manager Dx

1. În caseta de dialog Login (Autentificare), selectați-vă numele din lista verticală User Name (Nume
utilizator).

2. Introduceți parola dumneavoastră

3. Faceți clic pe OK pentru a închide caseta de dialog Login (Conectare) și a deschide software-ul.

Schimbarea utilizatorilor
Puteți schimba utilizatorii în timp ce software-ul se află în funcțiune.

Pentru a schimba utilizatorii

1. În fereastra Home (Fereastră de pornire), selectați User > Select User (Utilizator > Selectare
utilizator) pentru a deschide caseta de dialog Login (Conectare).

2. Selectați un nume din lista verticală User Name (Nume utilizator).

3. Introduceți parola noului utilizator.

4. Faceți clic pe OK pentru a închide caseta de dialog Login (Conectare) și a deschide software-ul.
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Schimbarea parolelor utilizatorilor
Utilizatorii CFX Manager Dx își pot schimba parolele în orice moment.

Pentru a schimba parola de utilizator

1. Din fereastra Home (Fereastră de pornire), selectați User > Change Password (Utilizator >
Schimbare parolă) pentru a deschide caseta de dialog Change Password (Schimbare parolă).

2. În Old Password (Parolă veche), tastați parola actuală.

3. În New Password (Parolă nouă), tastați o parolă nouă și tastați-o din nou în Confirm New
Password (Confirmați noua parolă).

4. Faceți clic pe OK pentru a confirma modificarea.

Vizualizarea rolului și drepturilor dumneavoastră
Sfat: Utilizatorilor cărora li s-au atribuit roluri de utilizator Principal, Operator sau Invitat își pot
vizualiza doar setările, drepturile și rolurile lor de utilizator.

Pentru a vă vizualiza rolul de utilizator și drepturile curente

u Din fereastra Home (Fereastră de pornire), selectați User > User Administration (Utilizator >
Administrare utilizatori).

Contactați-vă administratorul CFX Manager Dx pentru a modifica setările, drepturile și rolurile de
utilizator listate în fereastra User Administration (Administrare utilizatori).
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Anexa C Integrare LIMS
Puteți configura CFX Manager Dx software pentru utilizare cu un sistem de gestionare a informațiilor
de laborator (LIMS). Pentru integrarea LIMS, CFX Manager Dx necesită informații pentru configurarea
plăcii generate de platforma LIMS (un fișier LIMS, *.plrn), un fișier de protocol creat folosind CFX
Manager Dx software (*.prcl), o locație definită pentru exportarea datelor și un format de exportare
definit.

La finalizarea rulării, CFX Manager Dx generează un fișier de date (.pcrd) și îl salvează în locația
definită a folderului de exportare a datelor. CFX Manager Dx poate, de asemenea, să creeze un fișier
de date compatibil cu LIMS în format .csv și să îl salveze în aceeași locație.

Crearea de fișiere de date compatibile cu LIMS
Această anexă explică modul în care puteți configura CFX Manager Dx software pentru a crea, salva
și exporta fișiere de date compatibile cu LIMS.

Configurarea folderului LIMS și a opțiunilor de exportare a
datelor
Implicit, CFX Manager Dx salvează protocoalele LIMS, fișierele LIMS și fișierele de exportare a
datelor în acest folder:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Puteți configura CFX Manager Dx să salveze fișiere într-un alt folder și puteți schimba opțiunile de
exportare pentru date LIMS.

Pentru a configura un folder LIMS și opțiunile de exportare a datelor

1. Din fereastra Home (Fereastră de pornire), selectați Tools > Options (Instrumente > Opțiuni).

2. În caseta de dialog Options (Opțiuni), selectați Data Export Settings (Setări exportare date).
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3. (Opțional) Selectați Automatically Export LIMS data at end of run (Exportare automată date LIMS
la sfârșitul rulării).

Software-ul va exporta automat date LIMS după fiecare rulare și le va salva în locația specificată.

4. Pentru a schimba opțiunile de exportare implicite pentru date LIMS, faceți clic peLIMS Data
Export Settings (Setări exportare date LIMS).

Important: Numai datele LIMS exportate ca fișier .csv pot fi importate înapoi în CFX
Manager Dx.

5. În caseta de dialog LIMS Data Export Format Settings (Setări format exportare date LIMS),
selectați opțiunile de exportare necesare și faceți clic pe OK.

6. În caseta de dialog Options (Opțiuni), navigați la și selectați un folder implicit în care doriți să
salvați fișierele de date LIMS. Puteți selecta un loc diferit pentru fiecare tip de fișier:

n Protocol

n Fișier LIMS

n Data export (Exportare date)

7. Faceți clic pe OK pentru a salva modificările și a închide caseta de dialog Options (Opțiuni).

Crearea unui protocol LIMS
Pentru a iniția o rulare LIMS, creați CFX Manager Dx un fișier protocol (*.prcl) și salvați-l în folderul de
protocol LIMS desemnat.

Pentru mai multe informații, consultați Capitolul 6, Crearea de protocoale.
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Crearea unui fișier LIMS
Un fișier LIMS (*.plrn) conține detaliile configurării plăcii și denumirea fișierului de protocol. Acest fișier
este generat de unitatea LIMS internă. CFX Manager Dx folosește fișierul LIMS pentru a crea un fișier
placă pe care să-l folosească împreună cu un fișier de protocol.

CFX Manager Dx oferă fișiere șablon de import al plăcii, pe care le puteți edita pentru a crea fișiere
placă LIMS personalizate.

Sfat: Această sarcină trebuie realizată de un specialist LIMS.

Pentru a crea un fișier LIMS

1. În fereastra Home (Fereastră de pornire), selectați View > Show > LIMS File Folder (Vizualizare >
Afișare > Folder fișier LIMS).

2. Deschideți folderul LIMS Templates (Șabloane LIMS) și selectați un fișier .csv pe care să-l
importați în unitatea LIMS internă.

3. Cu ajutorul LIMS, editați fișierul șablon completând câmpurile obligatorii listate în Tabelul 40.

4. Salvați șablonul cu extensia .plrn a numelui de fișier în folderul cu fișiere LIMS.

Important: CFXManager Dx poate deschide doar fișierul .plrn. Trebuie să salvați fișierul
.csv ca .plrn pentru a putea să inițiați rularea LIMS.

Coloană Rând Descriere
Content
(Conținut) Scop

A 1 Antet placă Nu editați Predefinit

A,B,C 2 Câmp/Date/Instrucțiuni Nu editați Predefinit

B 3 Versiunea Nu editați Predefinit

Tabelul 40. Definirea conținutului unui fișier LIMS .csv
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Coloană Rând Descriere
Content
(Conținut) Scop

B 4 Dimensiune placă Nu editați Predefinit

B 5 Tip de placă Introduceți „BR
White” (BR Alb),
„BR Clear” (BR
Transparent) sau
alt tip de plăci
calibrate

Obligatoriu

B 6 Mod de scanare Introduceți
„SYBR/FAMOnly:”
(Doar SYBR/FAM),
„All Channels”
(Toate canalele)
sau „FRET”

Obligatoriu

Tabelul 40. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rând Descriere
Content
(Conținut) Scop

B 7 Unități Introduceți una
dintre următoarele
„copy number”
(număr copii), „fold
dilution” (factor
diluție),
„micromoles”
(micromoli),
„nanomoles”
(nanomoli),
„picomoles”
(picomoli),
„femtomoles”
(femtomoli),
„attomoles”
(atomoli),
„milligrams”
(miligrame),
„micrograms”
(micrograme),
„nanograms”
(nanograme),
„picograms”
(picograme),
„femtograms”
(femtograme),
„attograms”
(atograme) sau
„percent” (procent)

Obligatoriu

Tabelul 40. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rând Descriere
Content
(Conținut) Scop

B 8 ID rulare Introduceți o scurtă
descriere sau un
cod de bare care să
identifice această
rulare (maximum
30 de caractere,
virgulele nu sunt
permise)

Opțional

B 9 Observație rulare Introduceți
descrierea rulării

Opțional

B 10 Protocol rulare Introduceți numele
fișierului de
protocol exact cum
apare în listă.

Obligatoriu

A 11 Fișier de date Introduceți numele
fișierului de date

Opțional

A 12-15 Urmează a fi
determinat/Gol

Nu editați Predefinit

A 16 Date placă Nu editați Predefinit

Tabelul 40. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rând Descriere
Content
(Conținut) Scop

A 17-113 Poziția godeului Nu editați Predefinit

B-G Ch1 Dye, Ch2 Dye, Ch3
Dye, Ch4 Dye, Ch5 Dye,
FRET (Colorant canal1,
Colorant canal2, Colorant
canal3, Colorant canal4,
Colorant canal5, FRET)

Introduceți un
nume de colorant
calibrat (de
exemplu, „FAM”)
pentru fiecare
canal utilizat

Obligatoriu

H Tipul de probă Introduceți unul
dintre următoarele
tipuri de probe:
„Unknown”
(Necunoscută),
„Standard”,
„Positive Control”
(Control pozitiv),
„Negative Control”
(Control negativ),
„NTC” sau „NRT”

Obligatoriu

I Denumire probă Introduceți
denumirea probei

Opțional

Tabelul 40. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rând Descriere
Content
(Conținut) Scop

J-O CH1 Target, CH2 Target,
CH3 Target, CH4 Target,
CH5 Target, FRET Target
(Țintă C1, Țintă C2, Țintă
C3, Țintă C4, Țintă C5,
Țintă FRET)

Introduceți
denumirea țintei
pentru fiecare
canal utilizat

Opțional

P Denumire set biologic Introduceți
denumirea setului
biologic

Opțional

Q Replicare Introduceți un
întreg pozitiv
pentru fiecare set
de replicate.
Valoarea nu poate
fi zero.

Opțional

R-W CH1 Quantity, CH2
Quantity, CH3 Quantity,
CH4 Quantity, CH5
Quantity, FRET Quantity
(Cantitate C1, Cantitate
C2, Cantitate C3, Cantitate
C4, Cantitate C5, Cantitate
FRET)

Introduceți
cantitatea valorilor
pentru oricare
standard.
Introduceți
concentrația sub
formă de număr
zecimal.

Obligatoriu
pentru toate
standardele

X Notă alveolă Introduceți o notă
pentru alveolă
(maximum 20 de
caractere)

Opțional

Tabelul 40. Definirea conținutului unui fișier LIMS .csv, continuare
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Coloană Rând Descriere
Content
(Conținut) Scop

Y-AD Ch1Well Color, Ch2Well
Color, Ch3Well Color, Ch4
Well Color, Ch5Well Color,
FRETWell Color (Culoare
alveolă C1, Culoare
alveolă C2, Culoare
alveolă C3, Culoare
alveolă C4, Culoare
alveolă C5, Culoare
alveolă FRET)

Introduceți orice
culoare de stil de
urmă definită de
utilizator în format
zecimal întreg pe
32 biți (argb)

Opțional

Tabelul 40. Definirea conținutului unui fișier LIMS .csv, continuare
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Inițierea unei rulări LIMS
Pentru a iniția o rulare LIMS

1. Urmați una dintre procedurile următoare pentru a deschide un fișier LIMS .plrn:

n În fereastra Home (Fereastră de pornire), selectați View > Show > LIMS File Folder
(Vizualizare > Afișare > Folder fișier LIMS) și deschideți fișierul .plrn țintă.

n În fereastra Home (Fereastră de pornire), selectați File > Open > LIMS File (Fișier >
Deschidere > Fișier LIMS) și deschideți fișierul .plrn țintă.

Fișierul se deschide în fila Start Run (Începere rulare) din expertul Run Setup (Configurare
rulare). Fila Start Run (Începere rulare) afișează informații despre experimentul care urmează a fi
rulat. Aceasta afișează, de asemenea, blocul sau blocurile instrumentului conectat pe care puteți
rula experimentul.

2. În fila Start Run (Începere rulare), selectați un instrument și faceți clic pe Start Run (Începere
rulare).
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Exportarea datelor către o LIMS
La finalizarea rulării, CFX Manager Dx generează un fișier de date (.pcrd) și îl salvează în locul definit
al folderului de exportare a datelor.

Pentru a exporta fișierul de date către o LIMS

u Deschideți fișierul .pcrd și selectați Export > Export to LIMS Folder (Export > Exportare către
folder LIMS).

Sfat: Dacă selectați Automatically Export Data after Run (Exportare automată date după rulare)
din Opțiuni LIMS, CFX Manager Dx creează un fișier compatibil cu LIMS în format .csv și îl
salvează în același folder.
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Anexa D Depanarea problemelor de conectare a
CFX Manager Dx software

Jurnalul aplicației
Înainte de a iniția o rulare, instrumentele CFX96 și CFX96 DeepWell inițiază un test de auto-
diagnosticare pentru a verifica dacă respectă specificațiile. Software-ul înregistrează rezultatele
acestui test în fișierul Run Log (Jurnalul rulării) și Application Log (Jurnalul aplicației). Dacă observați o
problemă la unul sau mai multe experimente, deschideți jurnalele rulării și aplicației pentru a descoperi
când a început problema.

CFX Manager Dx înregistrează informații despre starea unui instrument în timpul unei rulări în
Application Log (Jurnalul aplicației). Folosiți aceste jurnale pentru a monitoriza evenimentele
instrumentelor și software-ului și pentru a le depana.

Pentru a deschide Jurnalul aplicației

u Din fereastra Home (Fereastră de pornire), selectați View > Application Log (Vizualizare >
Jurnalul aplicației).
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Depanare
De obicei, problemele de comunicare ale software-ului și instrumentului pot fi rezolvate prin repornirea
computerului dumneavoastră și a sistemului. Asigurați-vă că ați salvat lucrul în desfășurare înainte de
repornire.

Observație: Verificați dacă computerul dumneavoastră are suficient RAM și spațiu liber pe disc.
Memoria RAMminimă este de 4 GB, iar spațiul minim pe disc este de 128 GB.

Pană de curent
În caz de pană de curent, instrumentul și computerul se vor închide. Dacă pana de curent este scurtă,
instrumentul va relua rularea unui protocol, dar Application Log (Jurnalul aplicației) va nota pana de
curent. În funcție de setările computerului și durata de timp pentru care este oprită alimentarea
electrică, instrumentul și software-ul încearcă să continue să ruleze în funcție de pasul protocolului:

n Dacă protocolul este într-un pas fără nicio citire de placă, protocolul rulează în continuare de
îndată ce instrumentul este din nou alimentat cu energie.

n Dacă protocolul este într-un pas cu o citire de placă, instrumentul așteaptă ca software-ul să
repornească și să reia comunicarea pentru a colecta datele. În această situație, protocolul
continuă numai dacă software-ul nu este oprit de computer. Atunci când computerul și software-ul
pornesc din nou, protocolul continuă.

Îndepărtarea probelor din modulul de reacție în timpul penelor de curent.

Puteți deschide un capac motorizat blocat de pe un modul de reacție pentru a îndepărta probele în
timpul unei pene de curent.

Pentru a îndepărta placa de blocare

1. Împingeți în jos bara de blocare pentru a îndepărta modulul de reacție din ciclorul termic C1000
Dx.

2. Așezați cu grijă modulul de reacție pe un birou sau pe masa de laborator.
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Depanare

3. Poziționați modulul astfel încât partea frontală a modulului să depășească marginea cu 5 cm.

4. Cu o cheie imbus, înlăturați cele două șuruburi mari de sub marginea frontală a modulului de
reacție (de sub butonul pentru deschiderea capacului).

Ar trebui să auziți eliberarea clichetului de blocare din interiorul modulului.

Important: Nu înlăturați cele două șuruburi mici de pe marginea frontală a modulului.

5. Deschideți prin împingere capacul modulului de reacție. Observați faptul că clichetul (din plastic
negru) nu mai este atașat. Scoateți probele dumneavoastră din bloc.
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6. Puneți la loc clichetul de blocare și fixați-l cu șuruburi mari pentru a reasambla modulul de reacție
cu capacul deschis.

Preluarea fișierelor în computerul cu CFX Manager Dx
Puteți prelua fișierele de date și jurnal localizate în instrument, pe care să le transferați pe unitatea de
disc a unui computer atașat.

Observație: Toate fișierele din folderul cu date în timp real din baza instrumentului sunt preluate
în computer.

Pentru a prelua fișiere din instrument

1. În panoul Detected Instruments (Instrumente detectate) din fereastra Home (Fereastră de
pornire), faceți clic dreapta pe instrumentul țintă și selectați una dintre următoarele:

n Retrieve Log Files (Preluare fișiere jurnal)

n Retrieve Data Files (Preluare fișiere de date)

2. Alegeți locația folderului în care să salvați fișierele preluate.

3. Faceți clic pe Okay (OK).

Instalarea manuală a CFX Manager Dx software
Pentru a instala manual CFX Manager Dx software

1. Dacă este necesar, deconectați orice instrumente conectate de la computer.

Localizați și deconectați cablul USB al instrumentului de la computerul CFX Manager Dx. Capătul
introdus în instrument poate să rămână în poziție.

2. Autentificați-vă pe computerul cu CFX Manager Dx cu drepturi de administrator.

3. Introduceți CD-ul cu software-ul.
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Depanare

4. În Windows Explorer, navigați la CD, faceți clic dreapta pe pictograma CD-ului cu software-ul și
selectați Explore (Explorare) pentru a deschide fereastra CD-ului.

5. Faceți dublu clic pe folderul CFX_Manager pentru a deschide folderul și apoi faceți dublu clic
pesetup.exe pentru a inițializa expertul de instalare a software-ului.

6. Urmați instrucțiunile din expert pentru a instala software-ul, apoi faceți clic pe Finish (Finalizare).

Reinstalarea driverelor
Pentru a reinstala driverele instrumentului

u Din fereastra Home (Fereastră de pornire), selectați Tools > Reinstall Instrument Drivers
(Instrumente > Reinstalare drivere instrument).

Observație: Dacă aveți probleme cu comunicarea dintre software și sistemul în timp real după ce
ați reinstalat driverele și ați verificat conexiunea USB, contactați serviciul de asistență tehnică Bio-
Rad.
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Redistribuirea și utilizarea în forma sursă și binară, cu sau fără modificare, sunt permise cu
îndeplinirea următoarelor condiții:

1. Redistribuirile codului sursă trebuie să păstreze notificarea privind drepturile de utilizator de mai
sus, această listă de condiții și următoarea exonerare de răspundere.

2. Redistribuirile în formă binară trebuie să reproducă notificarea privind drepturile de autor de mai
sus, această listă de condiții și următoarea exonerare de răspundere în documentația și/sau
celelalte materiale furnizate împreună cu distribuirea.

3. Documentația pentru utilizatorul final inclusă cu redistribuirea, dacă există, trebuie să includă
următoarea recunoaștere:

„Acest produs include software dezvoltat de Universitatea din Chicago, ca Operator al Laboratorului
Național Argonne.”
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